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项目 1 Altium Designer 20.1 简介

项目描述

本项目围绕 Altium Designer 20 展开，它是一款功能强大的电子设计自动化（EDA）软件，广泛

应用于印制电路板（PCB）设计领域。在项目中，学习者将从软件的基础认知起步，深入了解 PCB 设

计流程，熟悉 Altium Designer 20 的界面、功能及操作方法。通过实践操作，学会软件的安装、激

活、汉化以及启动后的窗口和面板管理。进而掌握 PCB 工程及相关文件的创建，能够独立完成简单

电路从原理图绘制到 PCB 制作的全过程，包括元件的绘制、封装、布局布线等关键环节。同时，还

会涉及到复杂电路如心形灯电路、交通信号灯电路的设计与制作，全面提升 PCB 设计技能。在学习

过程中融入思政教育，培养学习者的职业素养和价值观，使学习者不仅具备扎实的专业技能，还拥

有良好的职业操守和社会责任感，为未来从事电子设计相关工作奠定坚实基础。

项目学习目标



知识目标：理解印制电路板的定义、层次组成，熟悉常用 EDA 软件，深入掌握 Altium Designer
20 的文件结构、管理系统以及 PCB 设计系统。了解软件新特性，学会软件的安装、激活、汉化操

作，掌握原理图和 PCB 元件的制作方法，包括全新制作和修改集成元件库制作元件，熟悉集成元件

库的建立与检测知识。

能力目标：能够熟练运用 Altium Designer 20 完成 PCB 设计流程中的各项任务，如绘制原理图、

添加元件封装、进行 PCB 布局布线、手动布线以及覆铜等操作。具备独立设计简单电路和复杂电路

（如心形灯电路、交通信号灯电路）的原理图和 PCB 的能力，能够解决设计过程中出现的常见问题，

提高实践动手能力和创新思维能力。

素质目标：培养严谨认真、耐心细致的工作态度，在 PCB 设计过程中，任何一个小的失误都可

能导致整个电路无法正常工作，通过实践操作，让学习者养成对工作高度负责的精神。同时，在项

目实践中，鼓励学习者积极探索、勇于创新，提高团队协作能力和沟通能力，培养职业素养和社会

责任感，树立正确的价值观和职业道德观。

项目分析

Altium Designer 20 作为行业内主流的 EDA 软件，其功能丰富且操作复杂。在学习过程中，

首先需要攻克软件的基础操作，如安装、汉化等，这是后续深入学习的前提。PCB 设计流程涵盖多

个环节，从工程文件创建到元件绘制、布局布线等，每个环节都紧密相连，任何一处出现问题都可

能影响最终设计结果，因此需要学习者具备系统性思维和严谨的操作习惯。

思政案例：科技报国，PCB 设计中的责任与担当

案例标题：科技报国，PCB 设计中的责任与担当

案例背景：在电子科技飞速发展的当下，PCB 作为电子产品的关键组成部分，其设计水平直接

影响着产品的性能和竞争力。在我国电子产业崛起的过程中，面临着国外技术封锁、高端人才短缺

等诸多挑战。许多电子设计工作者怀揣着科技报国的理想，默默投身于 PCB 设计研发工作，为打破

国外技术垄断、推动我国电子产业发展贡献力量。

案例内容：某电子科技公司承接了一项为我国航天工程配套的 PCB 设计任务。该任务时间紧、

要求高，涉及大量先进技术和复杂工艺。项目团队成员深知任务的重要性，他们放弃了节假日休息

时间，日夜奋战。在设计过程中，遇到了信号干扰、布线空间不足等诸多难题。但团队成员没有退

缩，他们通过查阅大量资料、请教行业专家，不断尝试新的设计方案。在元件选择上，他们优先选

用国产元件，积极推动国产元件的应用和发展。经过数月的努力，最终成功完成了 PCB 设计任务，

产品性能达到国际先进水平，为我国航天工程的顺利推进提供了有力保障。

教育启示：这个案例启示，作为电子设计领域的学习者，要有科技报国的远大理想和责任担当。

在学习和工作中，面对困难要勇于挑战，坚持不懈，培养坚韧不拔的意志品质。同时，要树立民族

自豪感和自信心，积极推动国产技术和产品的发展，为我国从制造大国向制造强国转变贡献自己的

力量。在团队合作中，要发扬协作精神，共同攻克难题，实现目标。

项目规划

1.基础认知与软件操作。学习印制电路板的基本概念、层次组成以及常用 EDA 软件。安装、激

活并汉化 Altium Designer 20，熟悉软件界面和基本操作，掌握文件结构和管理系统。



2.PCB 设计基础实践。学习 PCB 设计流程，进行简单电路的原理图绘制、元件封装添加以及 PCB
布局布线操作。通过实践掌握原理图和 PCB 设计系统的基本使用方法，学会元件绘制和集成元件库

的制作。

3.复杂电路设计与制作。进行心形灯电路和交通信号灯电路等复杂电路的设计与制作，综合运

用所学知识，提升设计能力和创新思维。在设计过程中融入思政教育，培养职业素养和社会责任感。

4.总结与提升。对整个项目进行总结回顾，整理学习过程中的经验和问题，进行项目自测和练

习实践。针对薄弱环节进行强化学习，进一步提升 PCB 设计技能，为未来的学习和工作做好准备。

任务 1 认识印制电路板设计流程

任务描述

印制电路板（PCB）是电子产品的重要组成部分，其设计流程涵盖多个关键环节。本任务旨在让

学习者全面了解 PCB 设计从最初的需求分析到最终产品制作完成的整个过程。首先，学习者需要明

确 PCB 的定义和层次组成，这是理解其功能和设计原理的基础。接着，熟悉常用的 EDA 软件，了

解不同软件的特点和适用场景，进而深入学习 PCB 设计流程，包括原理图设计、元件选择与封装、

PCB 布局布线、设计规则检查以及制造文件生成等环节。通过学习，学习者应能清晰阐述每个环节

的主要任务和相互关系，为后续使用 Altium Designer 20 进行实际设计工作做好知识储备。

任务分析

要完成对 PCB 设计流程的认识，需要从多个方面进行深入学习。首先，理解 PCB 的定义和层

次组成需要学习者具备一定的电子基础知识，能够从物理结构和电气功能的角度去分析。对于常用

EDA 软件的了解，不仅要知道软件名称，还需对比它们的功能差异，这需要查阅大量资料并结合实

际应用案例。PCB 设计流程是一个复杂的系统工程，各个环节紧密相连，任何一个环节出现问题都

可能影响最终的设计结果。例如，原理图设计错误可能导致元件选择和布线错误，因此学习者需要

建立系统性思维，理解每个环节在整个流程中的作用和地位，才能更好地掌握 PCB 设计流程。

相关知识

任务导入

在现代电子设备中，从手机、电脑到各种智能家电，都需要 PCB 板。一部手机内部密密麻麻的

线路和各种电子元件有序地连接在一起，实现各种复杂的功能，离不开精心设计的 PCB。如果 PCB 设



计不合理，可能会导致手机信号不稳定、发热严重甚至无法正常工作。那么，如何才能设计出高质

量的 PCB 呢？这就需要深入了解 PCB 设计流程。通过本任务的学习，大家将揭开 PCB 设计的神

秘面纱，掌握这一电子设计领域的关键技能，为今后设计出优秀的电子产品打下坚实基础。

任务规划

1. 通过查阅教材、网络资料以及观看相关视频，学习 PCB 的定义、层次组成和常用 EDA 软

件知识。

2. 深入学习 PCB 设计流程，对照实际案例，分析每个环节的操作要点和注意事项。

3. 整理学习笔记，总结 PCB 设计流程的关键内容，制作思维导图，以便更好地理解和记忆。

任务实施

任务验证

完成学习后，通过以下方式进行验证。

一是进行知识问答，随机抽取关于 PCB 设计流程的问题，如 “简述原理图设计的主要步骤”“PCB
布局布线需要考虑哪些因素” 等，检验对知识点的掌握程度。

二是分析实际的 PCB 设计案例，让学习者指出案例中设计流程的各个环节，判断其是否正确理

解和掌握。

三是进行小型测试，给出一个简单的电路需求，要求学习者简述对应的 PCB 设计流程，根据回

答的完整性和准确性来评估学习效果。如果发现存在知识漏洞，及时回顾学习资料，进行针对性学

习。

任务小结

通过本任务的学习，对印制电路板设计流程有了全面的认识。了解了 PCB 的定义和层次组成，

知道了常用 EDA 软件的特点，重点掌握了 PCB 设计从需求分析到制造文件生成的各个环节。在学

习过程中，发现系统性思维对于理解复杂的设计流程非常重要，每个环节都相互关联，需要整体把

握。同时，学习资料的多样化有助于更全面地理解知识，如结合实际案例学习能加深对设计流程的

印象。在今后的学习和实践中，要继续巩固这些基础知识，为使用 Altium Designer 20 进行实际电

路设计做好充分准备。



任务 2 初识 Altium Designer 20

任务描述

Altium Designer 20 是一款功能强大的电子设计自动化软件，广泛应用于印制电路板（PCB）设

计等领域。本任务要求学习者全面了解 Altium Designer 20 的基本情况，包括软件的整体架构、主

要功能模块以及操作界面布局。深入学习软件的新特性，如改进的设计规则检查功能、增强的 3D 设

计体验等，这些新特性不仅提升了设计效率，还为设计师带来了更便捷、更精确的设计环境。学习

者需熟悉软件的启动方式、工作面板管理以及窗口管理操作，能够快速找到所需功能模块，灵活切

换工作面板和窗口，为后续使用软件进行 PCB 设计项目奠定坚实的操作基础。

任务分析

要完成对 Altium Designer 20 的初步认识，需要从多个维度进行探索。了解软件架构和功能模

块，需要学习者仔细研读软件官方文档，同时结合实际打开软件进行观察和操作。新特性的学习则

需要对比以往版本，关注官方发布的更新说明，并通过实际操作感受新特性带来的变化。对于启动

方式、工作面板管理和窗口管理，需要学习者亲自实践不同的操作方法，理解每种操作的适用场景，

如不同启动方式在不同使用场景下的便捷性，工作面板的布局调整如何提高设计效率等。

相关知识

任务导入

在当今电子设计行业，高效、精准的设计工具至关重要。Altium Designer 系列软件凭借其强大

功能在行业内占据重要地位，而 Altium Designer 20 更是在前代基础上进行了诸多优化和创新。想

象一下，当你开始一个新的 PCB 设计项目时，对设计软件却知之甚少，找不到功能入口，无法充分

利用软件优势，这将极大地影响设计进度和质量。所以，掌握 Altium Designer 20 的基础操作和新

特性，就如同拿到了打开高效设计大门的钥匙。通过本任务学习，你将快速熟悉这款软件，为后续

的设计工作做好充分准备。

任务规划：

1.查阅 Altium Designer 20 官方文档，了解软件概述、功能模块和新特性相关知识，初步建立对

软件的整体认知。

2.打开软件，实际操作不同的启动方式，熟悉启动流程和初始界面。同时，探索软件的工作面

板和窗口，尝试进行简单的面板布局调整和窗口切换操作。



3.深入研究软件的新特性，通过简单的设计案例进行实践，如利用新的设计规则检查功能查找

并修正设计错误，感受新特性带来的优势。

4.总结学习过程中的重点内容，整理操作技巧和遇到的问题及解决方法，形成学习笔记。

任务实施

任务验证

完成学习和实践后，可通过多种方式进行任务验证。

一是进行软件操作演示，要求学习者按照给定的任务场景，如快速打开特定工作面板、切换不

同设计窗口等，观察其操作的熟练程度和准确性。

二是进行知识问答，随机提问关于软件功能模块、新特性等方面的问题，检验对知识的掌握情

况。

三是布置简单的软件操作任务，如利用新特性完成一个小的设计检查工作，根据完成的质量和

效率来评估学习效果。若发现存在不足，针对性地回顾学习资料和进行强化练习。

任务小结

通过本任务的学习与实践，对 Altium Designer 20 有了较为全面的初步认识。了解了软件的整

体架构、主要功能模块和新特性，熟练掌握了软件的启动方式、工作面板管理以及窗口管理操作。

在学习过程中，发现实际操作与理论学习相结合能更好地理解和掌握软件知识。同时，软件的新特

性为设计工作带来了诸多便利，在今后的学习和项目实践中，要充分利用这些新功能，不断提高设

计效率和质量。后续将基于这些基础知识，进一步深入学习使用 Altium Designer 20 进行 PCB 设计

的具体流程和技巧。

任务 3 Altium Designer 20 的安装、激活、汉化

任务描述

成功安装、激活并汉化 Altium Designer 20 是使用该软件进行电子设计的前提条件。本任

务要求学习者掌握 Altium Designer 20 在不同操作系统下的安装步骤，包括下载安装文件、运行安

装程序、设置安装路径、选择安装组件等细节操作。同时，学习者需要了解软件激活的合法途径和

具体方法，确保软件的正常使用和版权合规。此外，对于非英语母语的学习者，将软件界面汉化为

中文可以提高操作的便捷性和理解度，因此还需掌握软件英文转为中文的详细设置步骤。通过完成

本任务，学习者能够顺利搭建起 Altium Designer 20 的使用环境，为后续深入学习和应用软件功能

奠定基础。



任务分析

Altium Designer 20 的安装、激活和汉化涉及多个步骤和不同的操作细节，每个环节都可能

因操作系统版本、电脑配置等因素出现问题。安装过程中，需要注意安装文件的来源可靠性，避免

下载到恶意软件。不同操作系统的安装步骤可能略有差异，需要学习者仔细辨别和操作。激活环节，

要严格按照软件官方规定的合法流程进行，防止因非法激活导致法律风险。汉化操作虽然相对简单，

但如果设置不当，可能会出现界面显示异常等问题。因此，学习者需要耐心、细致地按照正确步骤

进行每一项操作，并学会解决可能出现的常见问题。

相关知识

任务导入

当准备使用 Altium Designer 20 开启电子设计之旅时，首先要做的就是在自己的电脑上安装

并配置好这款软件。想象一下，如果因为安装步骤错误，软件无法正常启动；或者激活失败，只能

使用有限功能的试用版；又或者软件界面是全英文的，难以理解各项功能的含义，这将给的学习和

设计工作带来多大的阻碍。所以，掌握 Altium Designer 20 的安装、激活和汉化方法是至关重要的。

通过本任务的学习，你将能够轻松解决这些问题，顺利开启 Altium Designer 20 的高效设计之旅。

任务规划：

1.在 Altium 官方网站或其他正规渠道下载 Altium Designer 20 的安装文件，同时了解不同操作

系统下的安装注意事项。

2.运行安装程序，按照安装向导的提示，逐步完成安装路径设置、组件选择等操作，安装过程

中仔细观察每一步的设置选项。安装完成后，查找并记录安装过程中可能出现的问题及解决方法。

3.根据软件官方提供的激活指南，选择合法的激活方式，如购买正版授权码进行激活，严格按

照激活步骤完成操作。若激活过程中遇到问题，及时查阅官方帮助文档或寻求技术支持。

4.进行软件汉化设置，找到软件中的语言设置选项，将界面语言从英文切换为中文，并检查汉

化后的界面显示是否正常。最后一天，对整个安装、激活和汉化过程进行总结，整理操作步骤和遇

到的问题及解决方案，形成详细的操作手册，方便日后查阅。

任务实施

任务验证：任务完成后，通过以下方式进行验证。

首先，检查软件是否能够正常启动，启动过程中是否出现错误提示。若软件无法启动，根据错

误提示查找原因，如安装文件损坏、系统不兼容等。



其次，查看软件的激活状态，确认软件已成功激活，所有功能均可正常使用。若激活状态异常，

重新检查激活步骤或联系软件供应商解决。

最后，检查软件界面是否已成功汉化，各项菜单、按钮等的中文显示是否准确、完整。若存在

汉化不完整或显示异常的情况，重新进行汉化设置或查找相关解决方法。若在验证过程中发现问题，

及时进行修复和调整，确保软件安装、激活和汉化成功。

任务小结

本任务聚焦于 Altium Designer 20 的安装、激活和汉化，经过一系列的学习与实践，成功

掌握了在不同操作系统下搭建该软件使用环境的方法。在安装过程中，细致的操作和对细节的关注

至关重要，如安装路径的选择、组件的勾选等都可能影响软件后续的使用。激活环节让认识到遵守

软件版权规定的重要性，只有通过合法途径激活软件，才能稳定、安全地使用其全部功能。汉化操

作则大大提高了操作软件的便捷性，降低了学习成本。同时，在整个过程中，积累了解决问题的经

验，学会了如何查找和利用资源解决安装、激活和汉化过程中遇到的各种问题。这为后续深入学习

和运用 Altium Designer 20 进行复杂的电子设计项目提供了坚实的基础保障。

任务 4 启动 Altium Designer 20

任务描述

顺利启动 Altium Designer 20 并熟练掌握其启动后的工作面板管理和窗口管理操作，对于

高效开展电子设计工作意义重大。本任务要求学习者熟悉多种启动 Altium Designer 20 的方法，包

括从桌面快捷方式、开始菜单、安装目录等途径启动软件，并了解不同启动方式的适用场景。在启

动软件后，深入学习工作面板管理，如如何打开、关闭、隐藏特定工作面板，以及如何根据设计需

求自定义工作面板布局，以提高工作效率。同时，掌握窗口管理操作，如新建窗口、切换窗口、排

列窗口等，方便在进行多项目设计或同时查看不同设计文档时，能够快速定位和操作所需内容。通

过完成本任务，学习者能够在软件启动后迅速进入工作状态，灵活运用工作面板和窗口管理功能，

优化设计环境。

任务分析

启动 Altium Designer 20 看似简单，但不同启动方式在不同场景下各有优劣，需要学习者

结合自身使用习惯和实际需求进行选择。工作面板管理和窗口管理涉及多个操作选项和功能设置，

其复杂性在于不同的设计任务可能需要不同的面板和窗口布局。例如，在进行原理图设计时，可能

需要打开元件库面板和原理图编辑窗口；而在进行 PCB 布局布线时，则需要切换到相应的 PCB 编

辑窗口和布线规则面板。学习者需要理解这些操作之间的逻辑关系，根据实际工作流程灵活调整工

作面板和窗口，避免因操作不当导致工作效率低下或设计错误。

相关知识



任务导入

当成功安装并激活 Altium Designer 20 后，接下来就是如何高效地启动并使用软件。想象

一下，每次启动软件都要花费很长时间寻找启动入口，进入软件后面对杂乱无章的工作面板和窗口，

找不到自己需要的功能和文件，这将极大地影响的设计进度。而熟练掌握启动方式、工作面板管理

和窗口管理技巧，就能够快速打开软件并根据设计需求定制工作环境，让设计工作更加顺畅。通过

本任务的学习，你将学会如何轻松驾驭 Altium Designer 20 的启动和初始操作环节，为后续的设计

工作节省时间和精力。

任务规划

1.分别从桌面快捷方式、开始菜单、安装目录等途径启动 Altium Designer 20，记录每种启动方

式的操作步骤和启动速度，对比不同启动方式的优缺点，选择适合自己的常用启动方式。

2.打开软件后，探索工作面板管理功能，了解软件默认的工作面板布局，学习如何打开、关闭

和隐藏常见的工作面板，如项目面板、库面板等。

3.深入学习自定义工作面板布局，根据简单的设计任务需求，尝试调整工作面板的位置、大小，

将常用面板放置在便于操作的位置。

4.学习窗口管理操作，新建多个窗口并打开不同的设计文档，练习切换窗口和排列窗口的操作，

掌握不同排列方式（如层叠、平铺等）在不同场景下的应用。最后一天，结合实际设计案例，综合

运用启动方式、工作面板管理和窗口管理技巧，优化设计环境，并总结操作过程中的经验和注意事

项，形成操作指南。

任务实施

任务验证

完成学习和实践后，通过实际操作来验证学习效果。首先，在规定时间内，按照要求使用

不同启动方式启动软件，检查操作的熟练程度和启动是否成功。其次，给定一系列工作面板和窗口

管理任务，如快速打开特定工作面板、将多个窗口按照指定方式排列等，观察操作的准确性和速度。

最后，模拟实际设计场景，要求学习者根据设计任务需求，快速调整工作面板和窗口布局，查看是

否能够高效完成任务。如果在验证过程中发现操作不熟练或存在错误，重新回顾学习资料，针对薄

弱环节进行强化练习。

任务小结



通过本任务对 Altium Designer 20 启动及相关管理操作的学习，读者掌握了多种启动软件

的方法，明确了不同启动方式的适用场景，能够根据实际情况快速启动软件。在工作面板管理和窗

口管理方面，学会了打开、关闭、隐藏面板，自定义面板布局，以及新建、切换和排列窗口等操作。

这些技能使在软件启动后能够迅速搭建适合自己的工作环境，提高了设计工作的效率。在学习过程

中，发现实际操作的练习至关重要，只有通过不断实践，才能熟练掌握这些操作技巧。同时，总结

经验和制定操作指南有助于读者更好地回顾和应用所学知识。在后续的学习和设计项目中，将继续

运用这些技能，不断优化设计流程，提升电子设计能力。

项目总结

通过本项目对 Altium Designer 20 的学习与实践，学习者系统掌握了 PCB 设计的全流程知识和

技能。从最初对印制电路板和 EDA 软件的陌生，到能够熟练运用 Altium Designer 20 进行复杂电路

的原理图和 PCB 设计，实现了质的飞跃。在学习过程中，不仅提高了专业能力，还通过思政案例的

学习，培养了良好的职业素养和价值观。

在软件操作方面，熟练掌握了 Altium Designer 20 的安装、汉化、激活以及文件管理、窗口和面

板管理等基础操作，为后续设计工作奠定了坚实基础。在 PCB 设计流程上，学会了从工程文件创建、

元件绘制与封装，到布局布线、覆铜等一系列关键环节的操作技巧，能够独立完成高质量的 PCB 设

计。

项目练习

题目 1：简述 Altium Designer 20 中建立一个新的 PCB 工程文件的步骤。

题目 2：在 Altium Designer 20 中，如何给原理图元件添加封装？

项目 2 PCB 工程及相关文件的创建

项目描述

本项目聚焦 Altium Designer 20 软件，旨在全面培养学习者在印制电路板（PCB）设计领域的综

合能力。Altium Designer 20 作为一款功能强大的电子设计自动化（EDA）软件，广泛应用于电子行



业的各个领域。项目从软件的基础认知开始，引导学习者熟悉 PCB 设计流程，掌握软件的安装、激

活、汉化以及启动后的基本操作，如窗口和面板管理。

随着学习的深入，学习者将逐步接触到 PCB 工程及相关文件的创建，学会建立和管理工程文件、

自由文档与工程文件的转换，以及在工程中新建各类文件，包括原理图文件、原理图元件库文件、

PCB 文件和 PCB 封装库文件等。通过实际案例，如比较原理图不同连接方式对 PCB 的影响、555 定

时电路的设计制作等，让学习者亲身体验从原理图绘制到 PCB 制作的完整过程，熟练掌握元件的绘

制、封装、布局布线等核心技能。

此外，项目还涵盖了原理图元件和 PCB 元件的制作，包括全新制作和通过修改集成元件库来制

作元件，并学会创建自己的集成元件库。

项目学习目标

知识目标：深入理解印制电路板的定义、层次组成及常用 EDA 软件的特点，熟练掌握 Altium
Designer 20 的文件结构、管理系统和 PCB 设计系统。全面了解软件的新特性，学会软件的安装、

激活、汉化及启动后的基本操作。掌握原理图和 PCB 元件的制作方法，包括全新制作、修改集成元

件库制作元件以及创建集成元件库的知识。

能力目标：能够熟练运用 Altium Designer 20 独立完成 PCB 设计的全流程工作，从工程文件创

建、原理图绘制、元件封装添加，到 PCB 布局布线、手动布线、覆铜等操作。具备根据不同电路需

求设计原理图和制作 PCB 的能力，能够灵活运用软件功能解决设计过程中出现的问题，提高实践动

手能力和创新思维能力。

素质目标：培养严谨认真、耐心细致的工作作风，在 PCB 设计中注重细节，确保设计的准确性

和可靠性。通过团队协作项目，提升团队合作精神和沟通能力，学会在团队中发挥自己的优势，共

同完成设计任务。同时，激发创新意识，鼓励学习者在设计中尝试新方法、新思路，推动电子设计

技术的发展。

项目分析

Altium Designer 20 功能丰富但操作复杂，项目学习过程中面临多方面挑战。软件基础操作方面，

安装、激活、汉化及启动后的管理操作虽然是入门内容，但涉及多个步骤和细节，任何一处失误都

可能影响后续学习。例如，安装过程中路径选择不当可能导致软件运行异常，激活步骤错误可能无

法正常使用软件功能。

PCB 设计流程涵盖多个紧密相连的环节，从原理图设计到 PCB 制作，每个环节都需要精准把

握。原理图绘制时，元件的选择、连接方式以及网络标号的使用都直接影响后续 PCB 的布局布线。

在元件制作方面，无论是全新制作还是修改集成元件库制作元件，都需要对元件的电气特性和物理

结构有深入理解，绘制过程中对图形的精度和引脚设置要求严格。

思政教育在项目中的融入，旨在培养学习者的职业素养和价值观。在电子设计领域，诚信、创

新、团队合作等品质至关重要。通过思政案例的学习，引导学习者树立正确的职业观念，在未来的

工作中坚守职业道德，为行业发展贡献积极力量。

思政案例：坚守匠心，打造优质 PCB 设计

案例标题：坚守匠心，打造优质 PCB 设计



案例背景：在电子行业竞争日益激烈的当下，PCB 设计作为电子产品的核心环节，其质量直接

影响产品的性能和市场竞争力。许多企业为了追求短期利益，在 PCB 设计过程中偷工减料、忽视设

计细节，导致产品质量参差不齐。然而，也有一些企业和工程师始终坚守匠心，以打造高品质 PCB 设

计为目标，为行业树立了榜样。

案例内容：某电子科技公司承接了一款高端医疗设备的 PCB 设计项目。该项目对 PCB 的稳定

性、可靠性要求极高，任何微小的设计缺陷都可能危及患者的生命安全。项目团队负责人李工深知

责任重大，带领团队成员全身心投入到设计工作中。在原理图设计阶段，他们对每一个元件的参数

进行反复核对，确保电路功能的准确性。在 PCB 布局布线过程中，充分考虑信号干扰、散热等因素，

经过多次优化调整，才确定最终方案。在元件制作环节，对于一些特殊元件，团队成员亲自绘制原

理图和封装，严格把控元件质量。在整个设计过程中，团队成员加班加点，不放过任何一个细节。

最终，他们成功完成了 PCB 设计任务，该医疗设备投入使用后，性能稳定，得到了用户的高度认可，

为公司赢得了良好的声誉。

教育启示：这个案例启示，在学习和从事 PCB 设计工作中，要始终坚守匠心精神。对待每一个

设计项目，都要像对待生命一样认真负责，注重细节，追求卓越。要树立正确的价值观，不被短期

利益所诱惑，以打造优质产品为目标。同时，在团队合作中，要充分发挥每个人的专业优势，相互

协作，共同攻克难题。只有这样，才能在电子设计领域取得优异成绩，为社会创造价值。

项目规划

1.基础入门：学习印制电路板的基本概念、层次组成和常用 EDA 软件知识。安装、激活并汉化

Altium Designer 20，熟悉软件界面和基本操作，包括文件结构、管理系统以及启动后的窗口和面板

管理。通过阅读教材、观看教学视频和实际操作进行学习。

2.PCB 设计基础实践：深入学习 PCB 设计流程，进行简单电路的原理图绘制、元件封装添加以

及 PCB 布局布线操作。通过比较原理图不同连接方式对 PCB 的影响、555 定时电路设计等案例，

掌握 PCB 设计的基本技能。在实践过程中，注重总结经验，及时解决遇到的问题。

3.元件制作与复杂电路设计：学习原理图元件和 PCB 元件的制作方法，包括全新制作、修改集

成元件库制作元件以及创建集成元件库。进行心形灯电路和交通信号灯电路等复杂项目的设计与制

作，综合运用所学知识，提升创新设计能力和解决实际问题的能力。

4.总结提升：对整个项目进行总结回顾，整理学习过程中的经验和问题，进行项目自测和练习

实践。针对薄弱环节进行强化学习，进一步提升 PCB 设计技能。同时，结合思政案例，反思自己在

项目学习中的职业素养和价值观，为未来的学习和工作做好充分准备。

任务 1 认识 Altium Designer 20.1 文件结构和文件管理

系统

任务描述

Altium Designer 20 的文件结构和文件管理系统是有效开展 PCB 设计工作的重要基础。本任务旨

在让学习者深入理解 Altium Designer 20 中各类文件的组织形式及其相互关系，熟练掌握文件管理系



统的操作方法。学习者需要清楚不同类型文件（如工程文件、原理图文件、PCB 文件等）在项目中

的作用和存储位置，学会创建、保存和管理这些文件，能够实现自由文档和工程文件之间的灵活转

换，确保设计项目的文件管理规范、有序，便于后续的设计、修改和维护工作。这不仅有助于提高

设计效率，还能避免因文件管理混乱导致的设计错误和数据丢失问题。

任务分析

要完成对 Altium Designer 20 文件结构和文件管理系统的学习，需从多方面深入探究。首先，理

解文件结构需要剖析不同类型文件的特点和功能，以及它们在整个项目中的层级关系，这需要学习

者认真研读软件文档并结合实际操作来体会。掌握文件管理系统操作，包括文件的创建、保存、打

开、删除等基本操作，以及文件在不同项目环境下的管理策略，如在多用户协作项目中如何共享和

管理文件，这要求学习者熟悉软件的各种菜单选项和对话框设置。而自由文档和工程文件的转换涉

及到对文件属性和项目关联性的理解，需要学习者准确把握转换的条件和步骤，避免因误操作导致

文件丢失或项目出错。

相关知识

任务导入

在使用 Altium Designer 20 进行 PCB 设计时，就如同搭建一座复杂的建筑，每个文件都是这座建

筑的重要组成部分。如果对这些“建筑材料”的存放和管理毫无头绪，就会像在杂乱无章的仓库中寻

找工具一样，不仅浪费时间，还可能因为找不到正确的文件或使用了错误版本的文件而导致设计失

败。想象一下，在设计一个大型电路项目时，众多的原理图文件、PCB 文件以及各种元件库文件混

在一起，没有清晰的结构和有效的管理，要找到需要修改的文件或者确保所有文件协同工作几乎是

不可能的。所以，掌握 Altium Designer 20 的文件结构和文件管理系统，就像是为你的设计项目打造

了一个井然有序的仓库，让你能够轻松找到所需文件，高效推进设计工作。通过本任务的学习，你

将学会如何构建和管理这个“仓库”，为后续的设计工作提供坚实保障。

任务规划

1.文件结构理论学习

（1）阅读 Altium Designer 20 官方文档中关于文件结构的章节，了解工程文件、原理图文件、

PCB 文件、元件库文件等的基本概念和作用。同时，在纸上绘制简单的文件结构思维导图，梳理不

同文件之间的关系。

（2）观看相关教学视频，进一步加深对文件结构的理解。观看过程中，暂停视频并结合自己绘

制的思维导图进行思考，标记出不理解的地方，待视频结束后查阅资料或向老师同学请教。

2.文件管理系统基础操作实践

（1）打开 Altium Designer 20 软件，在软件界面中找到文件管理相关的菜单选项和工具按钮。



尝试创建新的工程文件、原理图文件和 PCB 文件，熟悉文件创建的操作流程，注意观察文件创建后

在项目面板中的显示方式。

（2）练习文件的保存、打开和关闭操作。创建多个不同类型的文件后，分别进行保存操作，尝

试不同的保存路径和文件名，理解保存设置的作用。然后关闭软件，重新打开并尝试打开之前保存

的文件，检查文件是否能够正常打开，确保保存和打开操作的正确性。

3.文件管理系统高级操作与自由文档转换实践

（1）学习文件管理系统的高级操作，如文件的复制、移动、删除和重命名。在项目中创建一些

测试文件，对这些文件进行复制、移动操作，观察项目面板和文件存储位置的变化。同时，练习删

除和重命名文件，注意操作时的提示信息，避免误删重要文件。

（2）重点学习自由文档和工程文件的转换。创建一个自由文档，尝试将其添加到工程文件中，

观察文件在工程中的位置和状态变化。然后，将工程文件中的某个文件转换为自由文档，了解转换

过程中的注意事项。反复进行转换操作，直到熟练掌握转换技巧。

4.总结与巩固

（1）对前三天的学习内容进行全面总结，整理文件结构的思维导图，补充实践过程中对文件结

构的新认识。同时，将文件管理系统的操作步骤和注意事项整理成文档，方便日后查阅。

（2）进行一次综合性的文件管理练习，根据给定的设计场景，创建、管理和转换文件，检查自

己对知识和技能的掌握程度。对于练习过程中出现的问题，及时进行分析和解决，确保能够熟练掌

握文件结构和文件管理系统的相关知识和操作。

任务实施

任务验证

完成学习和实践后，通过以下方式进行任务验证：

文件结构知识问答：准备一系列关于 Altium Designer 20 文件结构的问题，如“工程文件和原理图

文件的关系是什么？”“PCB 文件主要存储哪些信息？”等，通过问答形式检验对文件结构的理解程度。

回答正确得满分，回答错误或不完整根据情况扣分。

文件管理操作演示：在规定时间内，要求学习者按照给定的任务场景进行文件管理操作演示，

如创建一个包含原理图文件、PCB 文件和元件库文件的工程，将一个自由文档添加到工程中，然后

对工程中的文件进行复制、移动、重命名等操作。根据操作的准确性、熟练程度和完成时间进行评

分。操作完全正确且熟练、在规定时间内完成得满分；出现操作错误或不熟练、超过规定时间完成

则根据具体情况扣分。

项目文件整理检查：提供一个文件管理混乱的 PCB 设计项目案例，要求学习者对其进行整理，

包括梳理文件结构、将自由文档转换为工程文件的一部分、删除无用文件等操作。检查整理后的项

目文件结构是否合理，文件是否能够正常打开和使用。根据整理结果的合理性和文件的完整性进行

评分，整理结果合理、文件完整无问题得满分，存在问题则根据问题严重程度扣分。

根据验证结果，如果发现存在知识漏洞或操作不熟练的情况，针对性地进行复习和强化练习，

直到完全掌握为止。



任务小结

通过本任务的学习与实践，读者系统地掌握了 Altium Designer 20 的文件结构和文件管理系统。

明白了不同类型文件在 PCB 设计项目中的角色和相互关系，学会了如何创建、保存、管理文件以及

实现自由文档和工程文件的转换。在学习过程中，发现理论学习与实际操作相结合非常重要，通过

实际动手操作，能够更深刻地理解文件结构和文件管理系统的原理和应用。同时，在文件管理过程

中，严谨细致的态度至关重要，任何一个小的失误都可能导致文件丢失或项目出错。在今后的 PCB
设计学习和实践中，读者要始终保持这种严谨的态度，合理管理文件，为设计工作的顺利开展提供

有力保障。后续读者将基于良好的文件管理基础，进一步深入学习 PCB 设计的其他关键环节。

任务 2 认识 Altium Designer 20.1 的原理图和 PCB 设

计系统

任务描述

Altium Designer 20 的原理图和 PCB 设计系统是进行电子电路设计的核心模块。本任务要求学习

者全面认识这两个设计系统，深入理解其功能、特点和工作流程。学习者需要学会在 Altium Designer
20 中新建工程文件，并在工程文件的框架下，依次新建原理图文件、原理图元件库文件、PCB 文件

和 PCB 封装库文件。在新建文件的过程中，熟悉每个文件的基本设置和初始状态，掌握不同文件之

间的关联和交互方式，为后续在原理图设计系统中绘制精确的电路原理图，以及在 PCB 设计系统中

进行合理的布局布线、制作出符合要求的印制电路板奠定坚实的基础。

任务分析

认识 Altium Designer 20 的原理图和 PCB 设计系统是一个较为复杂的过程，涉及多个方面的知识

和技能。首先，理解两个设计系统的功能和特点需要学习者深入研究软件的各项菜单命令、工具选

项以及设计规则。例如，原理图设计系统侧重于电路原理的表达，需要掌握元件的放置、连接和电

气规则检查等功能；而 PCB 设计系统则关注实际电路板的物理布局和布线，涉及到元件布局优化、

布线规则设置等内容。新建各种文件时，不同文件的设置参数众多，如原理图文件的图纸大小、网

格设置，PCB 文件的板层选择、尺寸定义等，需要学习者准确理解每个参数的含义和作用，根据设

计需求进行合理设置。此外，掌握文件之间的关联也很关键，原理图中的元件信息需要准确传递到

PCB 文件中，才能保证后续 PCB 设计的准确性，这要求学习者熟悉数据传输的流程和方法，避免出

现信息丢失或错误的情况。

相关知识



任务导入

在电子电路设计领域，原理图和 PCB 就像是建筑设计中的蓝图和实际建筑。原理图描绘了电路

的工作原理，如同蓝图规划了建筑的结构和功能；而 PCB 则是将原理图转化为实际可制造的电路板，

类似于按照蓝图建造出真实的建筑。如果不了解这两者之间的关系以及如何在 Altium Designer 20 软

件中创建和使用它们，就好比建筑工人看不懂蓝图，也不知道如何建造房屋，根本无法开展有效的

设计工作。想象一下，在设计一款智能电子产品时，由于不熟悉原理图和 PCB 设计系统，无法正确

创建相关文件，或者创建的文件之间无法协同工作，导致电路设计错误百出，PCB 制作失败，不仅

浪费了大量的时间和资源，还可能错过产品的最佳上市时机。所以，掌握 Altium Designer 20 的原理

图和 PCB 设计系统是电子电路设计的关键一步。通过本任务的学习，你将学会如何搭建电子电路设

计的“蓝图”和“建筑框架”，为实现自己的设计创意打下坚实基础。

任务规划

1.原理图和 PCB 设计系统理论学习

（1）查阅 Altium Designer 20 的官方文档、相关教材以及网络教程，了解原理图和 PCB 设计系

统的基本概念、功能特点和工作流程。在笔记本上记录重点内容，如原理图设计系统的主要工具和

功能区域，PCB 设计系统的板层结构和设计规则等。

（2）观看专业的教学视频，跟随视频讲解进一步深入理解两个设计系统。观看过程中，结合上

午记录的笔记进行思考，对于视频中演示的操作步骤和功能应用，在纸上简单绘制操作流程示意图，

帮助记忆。

2.新建工程文件实践

（1）打开 Altium Designer 20 软件，找到新建工程文件的操作入口。尝试创建一个新的工程文

件，在创建过程中，仔细阅读每个对话框的提示信息，了解工程文件的基本设置选项，如工程文件

的保存路径、名称等。创建完成后，观察工程文件在项目面板中的显示方式和初始状态。

（2）对新建的工程文件进行一些基本操作，如重命名工程文件、查看工程文件的属性等。同时，

学习如何在工程文件中添加和管理子文件，为后续新建原理图文件、PCB 文件等做准备。

3.新建原理图相关文件实践

（1）在已创建的工程文件中，新建原理图文件和原理图元件库文件。新建原理图文件时，设置

合适的图纸大小、网格参数等。打开新建的原理图文件，熟悉其工作界面，了解各种绘图工具和菜

单命令的位置和功能。新建原理图元件库文件后，进入元件库编辑界面，查看默认的元件库结构，

为后续绘制元件做准备。

（2）在原理图文件中进行简单的元件放置操作，从软件自带的元件库中选择一些常见元件，如

电阻、电容等，放置到原理图中。同时，尝试在原理图元件库文件中创建一个简单的自定义元件，

如一个简单的晶体管元件，熟悉元件绘制的基本流程和方法。

4.新建 PCB 相关文件实践

（1）在工程文件中新建 PCB 文件和 PCB 封装库文件。新建 PCB 文件时，详细设置板层参数、

尺寸大小、禁止布线区域等关键参数。打开新建的 PCB 文件，了解其工作界面和主要工具。进入 PCB
封装库文件编辑界面，查看默认的封装样式，学习封装的基本结构和绘制方法。

（2）将之前在原理图文件中放置的元件添加封装信息，并尝试将原理图中的元件信息同步到

PCB 文件中。观察同步过程中出现的问题，如元件封装不匹配、网络连接错误等，查阅资料或请教

老师同学，解决这些问题，确保原理图和 PCB 文件之间的信息准确传递。

5.总结与巩固



（1）对前四天的学习内容进行全面总结，整理新建工程文件以及各类子文件的操作步骤和注意

事项，形成详细的操作手册。同时，回顾原理图和 PCB 设计系统的功能特点和工作流程，强化记忆。

（2）进行一次综合性的练习，根据给定的简单电路设计需求，重新创建工程文件，并在工程文

件中依次新建原理图文件、原理图元件库文件、PCB 文件和 PCB 封装库文件，完成从原理图设计到

PCB 文件初步设置的整个流程。在练习过程中，检查自己对知识和技能的掌握程度，对于出现的问

题及时进行分析和解决，确保能够熟练掌握相关知识和操作。

任务实施

任务验证

完成学习和实践后，通过以下方式进行任务验证：

理论知识考核：设计一份关于 Altium Designer 20 原理图和 PCB 设计系统的理论知识试卷，包括

选择题、填空题和简答题。选择题主要考查对基本概念和功能的理解，如“原理图设计系统中用于连

接元件引脚的工具是（ ）”；填空题考查关键知识点的记忆，如“PCB 设计系统中常用的板层有（ ）

层、（ ）层等”；简答题要求阐述设计系统的工作流程或文件之间的关联等内容，如“简述原理图文

件中的元件信息如何传递到 PCB 文件中”。根据答题情况进行评分，检验对理论知识的掌握程度。

实际操作考核：给定一个具体的电路设计任务，要求学习者在规定时间内使用 Altium Designer 20
完成工程文件以及各类相关文件的创建，并将原理图设计完成且同步到 PCB 文件中。考核过程中，

观察学习者的操作步骤是否正确、熟练，文件设置是否合理，原理图和 PCB 文件之间的信息传递是

否准确。根据操作的准确性、完整性和完成时间进行评分。操作完全正确、文件设置合理、在规定

时间内完成得满分；出现操作错误、文件设置不合理或超过规定时间完成则根据具体情况扣分。

项目文件检查：检查学习者完成的项目文件，查看工程文件的结构是否合理，各类文件是否齐

全且命名规范。打开原理图文件和 PCB 文件，检查元件的放置、连接是否正确，封装信息是否准确，

原理图和 PCB 文件之间的关联是否正常。根据项目文件的质量进行评分，文件质量高、无明显错误

得满分；存在问题则根据问题严重程度扣分。

根据验证结果，如果发现存在知识漏洞或操作不熟练的情况，针对性地进行复习和强化练习，

重点学习薄弱环节，直到完全掌握为止。

任务小结

通过本任务的学习，读者全面认识了 Altium Designer 20 的原理图和 PCB 设计系统，并掌握了在

该软件中新建工程文件及相关文件的方法。了解了原理图设计系统侧重于电路原理的表达，而 PCB
设计系统则负责将原理图转化为实际的电路板，两者紧密配合才能完成电子电路的设计工作。在学

习过程中，读者发现每个文件的新建和设置都有其特定的目的和要求，需要认真对待每一个参数和

选项，否则可能会影响后续的设计。同时，实际操作中的练习至关重要，通过不断地实践，读者才



能更加熟练地掌握这些技能。在今后的学习和实践中，读者将继续深入学习原理图绘制和 PCB 布局

布线的具体技巧，进一步完善读者的电子电路设计能力。

项目总结

通过本项目对 Altium Designer 20 的学习与实践，学习者在 PCB 设计领域取得了显著进

步。在知识层面，全面掌握了印制电路板的相关知识、Altium Designer 20 的软件操作和元件制作方

法，构建了完整的知识体系。在能力方面，具备了独立完成 PCB 设计全流程工作的能力，能够根据

不同电路需求进行创新设计，并有效解决设计过程中出现的问题。

在素质培养上，通过思政案例的学习和实践过程中的锻炼，养成了严谨认真、耐心细致的工作

作风，提升了团队协作精神和创新意识。在项目实践中，遇到了如原理图连接错误导致 PCB 布线困

难、元件封装不匹配等问题，但通过查阅资料、请教老师和同学，最终都得到了解决，这不仅提高

了问题解决能力，还培养了坚韧不拔的毅力。

项目练习

题目 1：在 Altium Designer 20 中，如何将一个自由文档转换为工程文件中的一部分？

题目 2：简述在 Altium Designer 20 中为原理图元件添加封装的步骤。

项目 3 PCB 电路设计快速入门

项目描述

本项目围绕 Altium Designer 20 展开，旨在全面提升学习者在印制电路板（PCB）设计方面的综

合能力。Altium Designer 20 作为一款功能强大的电子设计自动化软件，在电子行业应用广泛。通过

本项目，学习者将从认识 PCB 设计流程起步，深入学习软件的操作技巧，涵盖文件管理、原理图绘

制、元件制作、PCB 布局布线等多个关键环节。

项目以实际案例为导向，如比较原理图不同连接方式的效果、设计 555 定时电路、制作心形灯

和交通信号灯电路等，让学习者在实践中掌握 PCB 设计的核心技能。同时，项目融入思政教育，培

养学习者严谨认真、勇于创新、团结协作的职业素养，引导学习者树立正确的职业道德观和价值观，



使学习者不仅具备扎实的专业知识，还能在未来的工作中坚守职业操守，为电子设计领域的发展贡

献力量。

项目学习目标

知识目标：理解 PCB 的定义、层次组成及常用 EDA软件的特点，掌握 Altium Designer 20 的文件

结构、管理系统和 PCB 设计系统。熟悉软件的安装、激活、汉化流程，以及原理图和 PCB 元件的制

作方法，包括新建、修改和集成元件库的相关知识。深入了解 PCB 设计流程中各环节的原理和操作

要点，如原理图绘制规则、元件封装原理、布局布线原则等。

能力目标：能够熟练运用 Altium Designer 20 完成从工程文件创建到 PCB 制作的全流程工作，包

括绘制复杂原理图、制作精确的元件封装、进行合理的布局布线（含手动和自动布线）以及完成 PCB
的后期处理（如添加泪滴、覆铜等）。具备根据不同电路需求设计并优化 PCB 的能力，能够独立解

决设计过程中出现的常见问题，提高实践动手能力和创新思维能力。

素质目标：培养严谨细致、精益求精的工作态度，在 PCB 设计中注重细节，确保设计的准确性

和可靠性。通过团队协作项目（若有），提升团队合作精神和沟通能力，学会在团队中发挥自己的

优势，共同完成设计任务。激发创新意识，鼓励学习者在设计中尝试新方法、新思路，推动电子设

计技术的发展。同时，树立知识产权保护意识和职业道德观念，尊重他人的设计成果，合法使用设

计软件和元件库。

项目分析

Altium Designer 20 功能丰富但操作复杂，项目学习过程面临诸多挑战。从软件基础操作来看，

安装、激活、汉化以及文件管理系统的学习，虽为入门内容，但涉及众多细节，任何一处失误都可

能影响后续学习。例如，安装路径选择不当可能导致软件运行异常，文件管理混乱可能造成文件丢

失或无法调用。

在 PCB 设计流程方面，原理图绘制需要准确把握电路原理，合理选择元件并正确连接，同时要

考虑到后续 PCB 制作的便利性。元件制作要求学习者理解元件的电气特性和物理结构，绘制过程对

图形精度和引脚设置要求严格，一旦出现错误，可能导致元件在原理图或 PCB 中无法正常使用。

布局布线是 PCB 设计的关键环节，需要综合考虑信号流向、电磁兼容性、散热等多方面因素。

自动布线虽提高了效率，但对于复杂电路，仍需手动调整优化。手动布线则更考验学习者的技术水

平和耐心，要精确控制布线的长度、宽度、间距等参数，确保符合设计规则。

思政教育在项目中的融入至关重要。在电子设计领域，诚信、创新、团队合作等品质是从业者

必备的素养。通过思政案例学习，引导学习者树立正确的价值观，在未来工作中避免抄袭、侵权等

不良行为，以创新精神推动行业进步，在团队中积极协作，共同攻克技术难题。

思政案例：传承匠心，打造卓越 PCB 设计

案例标题：传承匠心，打造卓越 PCB 设计

案例背景：在电子行业蓬勃发展的当下，PCB 作为电子产品的核心部件，其设计质量直接影响



产品性能。随着市场竞争加剧，部分企业为追求短期利益，忽视设计质量，导致产品可靠性下降。

然而，仍有许多企业和工程师坚守匠心，致力于打造高品质的 PCB 设计，为行业树立标杆。

案例内容：某知名电子企业承接了一项高端通信设备的 PCB 设计项目。该项目对 PCB 的性能要

求极高，不仅要满足高速信号传输的需求，还要具备良好的散热性能和稳定性。项目负责人张工带

领团队深入研究项目需求，对每一个电路细节进行反复推敲。在原理图设计阶段，团队成员花费大

量时间查阅资料，优化电路结构，确保信号完整性。在元件选择和封装制作方面，严格把控质量，

对特殊元件进行定制化设计。

在 PCB 布局布线过程中，为解决散热难题，团队经过多次试验，创新采用了一种新型的散热布

局方式，合理分布发热元件，并优化散热路径。同时，为保证高速信号传输质量，对关键信号线路

进行精确的长度匹配和阻抗控制。整个项目周期内，团队成员加班加点，不放过任何一个细节，历

经数月的努力，最终成功完成设计任务。该 PCB 应用到通信设备后，性能卓越，得到客户高度赞誉，

为企业赢得了良好的市场声誉。

教育启示：这个案例启示，在学习和从事 PCB 设计工作中，要传承匠心精神。对待每一个设计项目，

都要像对待艺术品一样，精益求精，注重细节。要有创新意识，敢于突破传统思维，探索新的设计

方法和技术，以提升设计质量。同时，要明白团队合作的重要性，在团队中充分发挥个人优势，相

互协作，共同攻克难题。此外，要坚守职业道德，以客户需求为导向，打造高质量的设计成果，为

行业发展贡献自己的力量。

项目规划

第一阶段：基础入门：学习 PCB 的基本概念、层次组成和常用 EDA 软件知识。安装、激活并汉

化 Altium Designer 20，熟悉软件界面和基本操作，包括文件结构、管理系统以及启动后的窗口和面

板管理。通过阅读教材、观看教学视频和实际操作进行学习。

第二阶段：PCB 设计基础实践：深入学习 PCB 设计流程，进行简单电路的原理图绘制、元件封

装添加以及 PCB 布局布线操作。通过比较原理图不同连接方式对 PCB 的影响、555 定时电路设计等

案例，掌握 PCB 设计的基本技能。在实践过程中，注重总结经验，及时解决遇到的问题。

第三阶段：元件制作与复杂电路设计：学习原理图元件和 PCB 元件的制作方法，包括全新制作、

修改集成元件库制作元件以及创建集成元件库。进行心形灯电路和交通信号灯电路等复杂项目的设

计与制作，综合运用所学知识，提升创新设计能力和解决实际问题的能力。

第四阶段：总结提升：对整个项目进行总结回顾，整理学习过程中的经验和问题，进行项目自

测和练习实践。针对薄弱环节进行强化学习，进一步提升 PCB 设计技能。同时，结合思政案例，反

思自己在项目学习中的职业素养和价值观，为未来的学习和工作做好充分准备。

任务 1 比较原理图用导线连接和用网络标号连接 PCB 效

果

任务描述



在 PCB 电路设计中，原理图的连接方式对后续 PCB 制作有着重要影响。本任务要求学习者分

别使用导线连接和网络标号连接的方式完成原理图的绘制，并将其转换为 PCB，深入观察和比较两

种连接方式在生成 PCB 后的布线效果、电气性能以及设计效率等方面的差异。通过实际操作和对比

分析，学习者能够理解两种连接方式的原理、适用场景和优缺点，从而在未来的设计工作中，根据

具体电路需求选择最合适的连接方式，提高 PCB 设计的质量和效率。

任务分析

要完成本任务，学习者需要熟练掌握 Altium Designer 20 中原理图绘制、元件封装添加、PCB 制

作等一系列操作。在绘制原理图时，需准确运用导线连接和网络标号连接两种方式，确保电路逻辑

正确。在转换为 PCB 的过程中，要注意设置正确的参数，保证转换顺利进行。对比两种连接方式生

成的 PCB 效果，需要从多个维度进行分析，如布线的复杂度、是否存在交叉线、信号完整性以及设

计过程的便捷性等。这要求学习者不仅具备扎实的软件操作技能，还需要有一定的电路原理知识和

分析问题的能力。

相关知识

任务导入

在 PCB 电路设计的世界里，就像搭建一座城市的交通网络，原理图的连接方式决定了 “道
路” 的布局。导线连接如同直接铺设的道路，清晰直观；而网络标号连接则像是给各个地点设定的

特殊 “门牌号码”，通过号码来确定连接关系。想象一下，如果在设计一个复杂的电路时，选择了不

恰当的连接方式，可能会导致 “交通堵塞”，也就是电路信号传输出现问题。那么，究竟哪种连接方

式更适合不同的电路呢？通过本任务的学习，你将亲自体验并找到答案，为未来设计出更高效、稳

定的 PCB 电路打下坚实基础。

任务规划

1.复习 Altium Designer 20 中原理图绘制和 PCB 制作的基础知识，包括元件放置、布线等操作。

2.使用导线连接方式绘制一个简单的电路原理图，如由几个电阻、电容和芯片组成的电路。绘

制完成后，检查原理图的正确性，添加元件封装，然后将其转换为 PCB，记录转换过程中的参数设

置和遇到的问题。

3.用网络标号连接的方式重新绘制相同功能的电路原理图，同样添加元件封装并转换为 PCB，
对比与导线连接方式生成的 PCB 在布线、元件布局等方面的初步差异。

4.对两种连接方式生成的 PCB 进行详细分析，从电气性能、布线复杂度、设计效率等方面进行

对比，整理对比结果，形成文档。第五天，总结两种连接方式的优缺点和适用场景，完成任务报告。

任务实施



任务验证

完成任务后，从以下几个方面进行验证。首先，检查绘制的原理图是否正确，元件连接关系是

否符合电路逻辑，可通过电气规则检查功能进行验证。其次，查看生成的 PCB 文件，检查布线是否

合理，有无短路、断路等问题。对比两种连接方式生成的 PCB，确认在布线效果、电气性能等方面

的差异是否符合预期。还可以找其他同学或老师对任务成果进行评估，听取他们的意见和建议。如

果发现问题，及时回顾操作过程，检查是否存在错误操作或理解偏差，针对性地进行修改和完善。

任务小结

通过本任务的学习和实践，读者深入比较了原理图用导线连接和用网络标号连接在 PCB 制作中

的效果。了解到导线连接直观明了，适合简单电路；网络标号连接在复杂电路中能简化原理图，提

高设计效率，但对使用者的逻辑思维要求较高。在实际操作中，熟练掌握了两种连接方式的操作方

法以及原理图到 PCB 的转换流程。同时，也认识到根据电路特点选择合适连接方式的重要性。在今

后的设计工作中，将根据具体需求灵活运用这两种连接方式，不断提升 PCB 设计能力。

任务 2 555 定时电路原理图的基本操作

任务描述

555 定时电路是一种应用广泛的集成电路，在电子设计中有着重要地位。本任务聚焦于 555 定

时电路原理图的绘制与基本操作，要求学习者掌握在 Altium Designer 20 环境下，从创建工程文件

开始，到搜索并放置 555 芯片及其他相关元件，完成原理图的绘制、检查和修改等一系列操作。通

过完成本任务，学习者能够熟悉复杂电路原理图的设计流程，提高对 Altium Designer 20 软件的操

作熟练度，同时加深对 555 定时电路工作原理的理解，为后续进行更复杂的电路设计和 PCB 制作

奠定基础。

任务分析

完成 555 定时电路原理图的基本操作，需要学习者综合运用多方面的知识和技能。首先，要熟

悉 Altium Designer 20 的文件管理系统，正确创建和管理工程文件。其次，需要掌握元件的搜索和

放置方法，能够在众多元件库中快速找到 555 芯片及其他相关元件，并准确放置在原理图中。在绘

制原理图时，要理解 555 定时电路的工作原理，确保元件连接正确，符合电气规则。此外，还需要

掌握原理图的检查和修改技巧，及时发现并解决可能出现的错误，保证原理图的准确性。

相关知识



任务导入

555 定时电路就像是电子设备中的 “定时器”，广泛应用于各种电子产品中，如定时器、报警器、

脉冲发生器等。想象一下，你手中的电子闹钟，它能够精准地定时提醒，背后就离不开 555 定时电

路的功劳。现在，你将有机会亲手设计这个神奇电路的原理图。通过本任务的学习，你不仅能学会

使用 Altium Designer 20 软件绘制复杂电路原理图，还能深入了解 555 定时电路的工作奥秘，为未

来开发各种有趣的电子产品打开大门。

任务规划

1.复习 Altium Designer 20 中工程文件创建的方法，创建一个用于 555 定时电路设计的工程文

件，并设置好相关参数。

2.学习在软件中搜索元件的技巧，找到 555 芯片所在的元件库并将其添加到工程中。同时，搜

索并添加其他相关元件，如电阻、电容等。

3.根据 555 定时电路的原理，在原理图中放置元件并进行连接，绘制出初步的原理图。绘制过

程中，注意元件的布局和连线的合理性。

4.对绘制好的原理图进行电气规则检查，查找并修改可能存在的错误，如引脚未连接、短路等

问题。对原理图进行优化，调整元件布局和连线，使其更加清晰美观。

5.整理设计过程中的思路和遇到的问题及解决方法，撰写任务报告，总结经验教训。

任务实施

任务验证

完成任务后，通过多种方式进行验证。首先，再次进行电气规则检查，确保原理图没有错误。

然后，使用软件的仿真功能（如果有）对 555 定时电路进行简单的仿真，观察电路是否能按照预期

的功能工作，如是否能产生稳定的脉冲信号等。还可以将原理图打印出来，与标准的 555 定时电路

原理图进行对比，检查是否存在遗漏或错误的地方。若发现问题，仔细分析原因，可能是元件连接

错误、参数设置不当等，针对性地进行修改和完善，直到原理图完全正确。

任务小结

通过本次对 555 定时电路原理图的基本操作实践，成功绘制出了 555 定时电路的原理图，掌



握了从工程文件创建到原理图绘制、检查和修改的整个流程。在这个过程中，读者对 Altium Designer
20 软件的操作更加熟练，对 555 定时电路的工作原理也有了更深入的理解。同时，读者学会了如

何查找和解决原理图设计中出现的问题，培养了严谨的设计态度。在今后的学习和实践中，读者将

继续运用这些技能，探索更多复杂电路的设计，不断提升自己的电子设计能力。

任务 3 元件的绘制

任务描述

在 PCB 电路设计中，有时需要绘制一些特殊的元件，以满足特定电路的设计需求。本任务要求

学习者在 Altium Designer 20 中掌握元件绘制的方法，包括建立原理图元件库、绘制元件的外形方

框、放置元件引脚并进行准确设置等操作。通过绘制如 555 元件等实际例子，学习者能够熟练掌握

元件绘制的流程和技巧，学会根据元件的电气特性和物理结构进行精确绘制，为后续在原理图设计

中使用自定义元件打下坚实基础，同时也提高了对电路设计的自主创新能力。

任务分析

元件绘制是一项细致且需要一定专业知识的工作。首先，建立原理图元件库需要学习者熟悉软

件的文件管理和库操作功能，正确设置库的名称、存储位置等参数。绘制元件外形方框时，要根据

元件的实际外观或行业标准进行绘制，保证图形的准确性和规范性。放置元件引脚并设置参数是关

键步骤，需要准确理解元件的电气连接关系，确定引脚的数量、位置和电气属性，如输入、输出、

电源等。这不仅要求学习者掌握软件的绘图工具，还需要对元件的工作原理有深入了解，确保绘制

的元件在原理图中能够正确使用。

相关知识

任务导入

在电子电路的世界里，各种元件就像是不同功能的 “小零件”，共同构建起复杂的电路系统。但

有时候，软件自带的元件库中没有需要的特殊元件，这就好比在搭建积木时，缺少了关键的一块。

此时，就需要自己动手绘制元件。想象一下，你正在设计一款独一无二的电子产品，其中某个特殊

元件是实现独特功能的关键，通过自己绘制这个元件，你就能让设计顺利进行，实现心中的创意。

通过本任务的学习，你将掌握元件绘制的 “魔法技能”，为自己的电路设计之路增添强大的工具。

任务规划



1.学习 Altium Designer 20 中建立原理图元件库的方法，创建一个新的元件库，并熟悉元件库的

管理界面和基本操作。

2.以 555 元件为例，学习绘制元件外形方框的技巧，使用软件的绘图工具绘制出符合 555 元

件外形特征的方框，注意尺寸和比例的准确性。

3.放置 555 元件的引脚，根据其电气特性确定引脚的数量、位置和方向。学习引脚参数设置，

如引脚名称、编号、电气类型等，确保引脚设置正确。第四天，对绘制好的 555 元件进行检查和修

改，检查引脚连接是否正确、外形是否美观等。可以参考标准的 555 元件资料进行对比，不断优化

绘制的元件。第五天，总结元件绘制的流程和技巧，整理绘制过程中遇到的问题及解决方法，完成

任务报告，并尝试绘制其他简单元件，巩固所学知识。

任务实施

任务验证

完成元件绘制后，通过以下方式进行验证。首先，在元件库中检查绘制的元件，查看外形是否

正确，引脚数量和位置是否准确。然后，将绘制的元件放置到一个简单的原理图中，连接其他元件，

进行电气规则检查，查看是否存在引脚连接错误等问题。还可以使用软件的 3D 预览功能（如果有），

从三维角度查看元件的外观和引脚布局，检查是否符合预期。若发现问题，仔细分析原因，如引脚

设置错误、绘图尺寸不准确等，及时进行修改，直到绘制的元件完全符合要求。

任务小结

通过本任务的学习和实践，读者成功掌握了在 Altium Designer 20 中绘制元件的方法。学会了

建立原理图元件库、绘制元件外形和设置引脚参数等关键操作。在绘制 555 元件的过程中，读者对

元件的电气特性和物理结构有了更深入的理解，同时也提高了软件操作技能和绘图精度。绘制元件

是一项需要耐心和细心的工作，任何一个小的失误都可能导致元件在使用中出现问题。在今后的电

路设计中，可以根据实际需求灵活绘制各种自定义元件，为设计更加个性化、多样化的电路提供支

持。

任务 4 元件库的安装、原理图的封装检查及连接线路操作

任务描述

在 PCB 电路设计过程中，元件库的安装、原理图元件封装的检查以及连接线路操作是确保设计

准确性和顺利进行 PCB 制作的关键环节。本任务要求学习者掌握在 Altium Designer 20 中安装元件

库的方法，学会使用封装管理器对原理图元件的封装进行检查和管理，能够准确为元件添加合适的

封装，并合理进行原理图元件的布局和连线操作。通过完成这些任务，学习者可以保证原理图与 PCB



之间的信息传递准确无误，提高原理图设计的质量，为后续的 PCB 制作提供可靠的基础。

任务分析

完成本任务需要学习者熟悉 Altium Designer 20 的多个功能模块。安装元件库时，要了解不同

元件库的来源和安装方式，确保正确安装所需的元件库，避免因元件库缺失导致元件无法使用。封

装检查和管理要求学习者理解封装的概念和作用，能够使用封装管理器查找和解决封装相关的问题，

如封装不匹配、缺失等。为元件添加封装需要根据元件的实际尺寸和电气连接要求选择合适的封装

形式，这需要对封装库有一定的了解。原理图元件的布局和连线则需要考虑电路的信号流向、布线

规则以及美观性等因素，合理安排元件位置，使连线简洁、清晰，避免交叉和短路。

相关知识

任务导入

在 PCB 电路设计的 “拼图游戏” 中，元件库就像是装满各种拼图块的盒子，封装是拼图块与实

际电路板连接的 “接口”，而连接线路则是将这些拼图块拼接在一起的 “胶水”。如果元件库不完整，

就会缺少关键的拼图块；封装出现问题，拼图块就无法正确拼接；连接线路不合理，整个拼图就会

混乱不堪。想象一下，在设计一个复杂的电路板时，因为元件库安装错误、封装有问题或者连线混

乱，导致 PCB 制作失败，这将浪费大量的时间和资源。所以，掌握元件库的安装、原理图的封装检

查及连接线路操作至关重要。通过本任务的学习，你将学会如何整理好这个 “拼图游戏” 的所有要

素，确保设计顺利进行。

任务规划

1.学习 Altium Designer 20 中元件库的安装方法，了解软件自带元件库和外部下载元件库的安装

路径和操作步骤。安装常用的元件库，如集成芯片库、电阻电容库等，并熟悉元件库在软件中的管

理界面。

2.学习使用封装管理器，打开一个已绘制好的原理图，使用封装管理器检查元件的封装情况，

查找是否存在封装错误或缺失的元件。对于存在问题的元件，记录下来并分析原因。

3.根据元件的实际情况，为缺少封装的元件添加合适的封装。在添加封装过程中，学习如何从

封装库中选择正确的封装形式，以及如何自定义封装（如果需要）。添加完成后，再次使用封装管

理器进行检查，确保封装正确。

4.进行原理图元件的布局和连线操作。根据电路的功能和信号流向，合理安排元件的位置，使

布局更加紧凑、美观。在连线过程中，遵循布线规则，尽量避免交叉线，保证连线的正确性和清晰

性。

5.对整个任务进行总结，整理安装元件库、封装检查及连接线路操作的流程和注意事项，完成



任务报告。对原理图进行最后的检查和优化，确保设计无误。

任务实施

任务验证

完成任务后，通过多种方式进行验证。首先，再次使用封装管理器检查原理图元件的封装，确

保所有元件都有正确的封装，且封装信息准确无误。然后，进行电气规则检查，查看原理图连线是

否存在短路、断路、未连接引脚等问题。还可以将原理图导入到 PCB 设计模块中，查看元件的布局

和连线是否符合预期，是否能够顺利进行 PCB 的初步布局。如果在验证过程中发现问题，仔细分析

问题产生的原因，如封装选择错误、连线失误等，及时进行修改和调整，直到原理图完全符合要求。

任务小结

通过本任务的学习和实践，读者掌握了元件库的安装、原理图的封装检查及连接线路操作的方

法和技巧。了解到元件库和封装在 PCB 电路设计中的重要性，以及合理布局和连线对原理图质量的

影响。在实际操作中，读者学会了使用封装管理器解决封装相关的问题，能够准确为元件添加封装，

并进行合理的布局和连线。这些技能的掌握为读者后续进行 PCB 制作提供了有力保障。在今后的设

计工作中，读者要养成良好的设计习惯，在设计初期就重视元件库和封装的管理，精心进行布局和

连线，提高设计效率和质量。

任务 5 建立 PCB 文件，并绘制板子形状

任务描述

在 PCB 设计流程中，建立 PCB 文件并绘制合适的板子形状是至关重要的一步，它直接关系到

电路板的物理结构和后续的元件布局与布线。本任务要求学习者在 Altium Designer 20 中掌握建立

PCB 文件的详细步骤，包括设置文件参数，如板层、尺寸、网格等。同时，学习者需要学会在禁止

布线层绘制走线来定义板子的外形轮廓，了解不同形状板子的绘制方法和技巧，以及如何添加安装

孔以固定电路板。通过完成本任务，学习者能够创建出符合设计需求的 PCB 文件，并为后续的 PCB
布局和布线工作做好准备。

任务分析

建立 PCB 文件和绘制板子形状涉及多个操作步骤和参数设置，需要学习者仔细对待每一个环节。

在建立 PCB 文件时，不同的板层设置适用于不同复杂程度的电路，如双层板、多层板等，需要根据



实际电路需求进行选择。尺寸和网格的设置影响着元件布局的精度和布线的合理性。在禁止布线层

绘制走线定义板子形状时，要考虑到电路板的实际使用场景，确保形状满足安装和功能要求。添加

安装孔时，要确定安装孔的位置、大小和数量，保证电路板能够稳固地安装在设备中。这一系列操

作要求学习者熟悉 Altium Designer 20 的 PCB 设计模块，理解 PCB 设计的基本原理。

相关知识

任务导入

想象一下，PCB 就像是电子设备的 “骨架”，支撑着各种电子元件，而板子的形状则决定了这个

“骨架” 的外形。如果板子形状设计不合理，

如果板子形状设计不合理，没有写完

如果板子形状设计不合理，就如同为电子元件搭建了一个不合适的“家”，不仅会导致元件布局

困难，还可能影响整个电路的性能和设备的整体结构。比如，在设计一款小型手持设备的 PCB 时，

若板子形状没有充分考虑设备的外壳尺寸和内部空间，可能会出现元件无法安装或者安装后散热不

佳等问题。所以，学会建立合适的 PCB 文件并绘制精准的板子形状，是制作高质量 PCB 的重要基础。

通过本任务的学习，你将掌握这一关键技能，为后续的 PCB 设计工作奠定坚实的基础。

任务规划

1.深入学习 Altium Designer 20 中建立 PCB 文件的理论知识，了解板层、尺寸、网格等参数的含

义和作用。查阅相关资料，对比不同类型电路适用的 PCB 板层设置，如简单电路适合双层板，复杂

的高速电路可能需要多层板。观看教学视频，记录建立 PCB 文件的操作步骤和要点。

2.打开 Altium Designer 20 软件，按照学习的步骤创建 PCB 文件。在设置板层时，根据一个简单

电路实例（如之前设计的 555 定时电路）的需求，选择双层板。设置合适的尺寸，参考电路元件的

大小和布局规划，确定电路板的长和宽。合理设置网格参数，以便后续精确布局元件。创建完成后，

熟悉 PCB 文件的工作界面和基本工具。

3.学习在禁止布线层绘制走线来定义板子形状。了解禁止布线层的作用和特点，使用软件的绘

图工具，如线、圆弧等，根据设计需求绘制简单的矩形板子形状。在绘制过程中，注意线条的精度

和连接的准确性。绘制完成后，检查板子形状是否符合设计预期，如有问题及时修改。

4.学习绘制特殊形状的板子，如带有异形边缘或缺口的板子。掌握使用软件的高级绘图功能，

如多边形绘制、曲线绘制等，实现特殊形状的设计。同时，学习如何添加安装孔，确定安装孔的位

置、大小和数量。根据电路板的安装方式和受力情况，合理分布安装孔，使用软件的过孔工具添加

安装孔，并设置相关参数。

5.对建立 PCB 文件和绘制板子形状的整个过程进行总结，整理操作步骤和注意事项，形成操作

手册。对之前绘制的 PCB 文件进行复查，确保板层设置、板子形状和安装孔添加都准确无误。尝试

根据不同的电路设计需求，重新创建 PCB 文件并绘制不同形状的板子，巩固所学知识和技能。



任务实施

任务验证

文件参数检查：检查创建的 PCB 文件的参数设置，包括板层、尺寸、网格等。确认板层选择是

否符合电路复杂程度的要求，尺寸是否满足元件布局和设备安装的需求，网格设置是否有利于元件

的精确放置和布线。若参数设置不合理，分析原因并进行调整。

板子形状验证：查看绘制的板子形状，检查外形轮廓是否符合设计要求，线条是否光滑、连接

是否准确。对于特殊形状的板子，检查异形部分的设计是否合理，是否会影响元件布局和布线。可

以使用软件的测量工具，检查关键尺寸是否准确。如果板子形状存在问题，及时修改。

安装孔检查：检查安装孔的位置、大小和数量。确认安装孔的位置是否便于电路板的安装和固

定，大小是否与实际使用的螺丝或其他固定件匹配，数量是否足够保证电路板的稳固安装。若安装

孔存在问题，重新调整安装孔的参数。

综合评估：将 PCB 文件导入到后续的元件布局和布线环节（可以进行简单的模拟操作），检查

板子形状和安装孔的设置是否会对这些后续操作产生影响。如是否存在元件无法放置在合适位置、

布线困难等问题。根据综合评估结果，对 PCB 文件进行最后的优化和完善。

任务小结

通过本任务的学习与实践，读者成功掌握了在 Altium Designer 20 中建立 PCB 文件并绘制板子形

状的技能。明确了板层、尺寸、网格等参数的重要性，学会了根据电路需求进行合理设置。熟练掌

握了在禁止布线层绘制走线定义板子形状的方法，包括绘制简单形状和特殊形状的技巧。同时，也

学会了根据实际情况添加合适的安装孔。在学习过程中，认识到每个操作步骤都需要严谨细致，一

个小的失误可能会对后续的 PCB 设计产生较大影响。在今后的 PCB 设计工作中，要继续巩固这些技

能，根据不同的设计需求，灵活创建 PCB 文件并绘制出精准合适的板子形状，为高质量的 PCB 设计

奠定基础。

任务 6 PCB 的布局和自动布线

任务描述

PCB 布局和自动布线是将原理图转化为实际可制造电路板的关键步骤。本任务要求学习者在

Altium Designer 20 环境下，对已建立的 PCB 文件进行合理布局和自动布线操作。在布局环节，学习

者需要依据电路原理、信号流向、电磁兼容性（EMC）等原则，将各个元件在 PCB 板上进行科学分

布，使元件之间的连接路径最短、干扰最小，同时还要考虑到后续的生产加工和维护便利性。完成

布局后，利用软件的自动布线功能，按照设定的布线规则，如线宽、间距、过孔大小等，对 PCB 进

行自动布线，生成初步的布线结果。通过本任务，学习者能够掌握 PCB 布局和自动布线的基本流程、



方法和技巧，理解布线规则对电路板性能的影响，为制作出高质量的 PCB 板奠定基础。

任务分析

完成 PCB 布局和自动布线任务，需要综合运用多方面的知识和技能。在布局方面，要理解电路

的功能和工作原理，明确关键元件和信号传输路径，以便合理安排元件位置。例如，对于高速信号

元件，应尽量缩短其连线长度，减少信号衰减和干扰；对于发热元件，要考虑散热空间和通风路径。

同时，还需掌握 Altium Designer 20 中元件布局的操作方法，如手动拖动元件、对齐元件、分布元件

等。在自动布线环节，需要深入了解布线规则的各项参数含义，根据电路的电流大小、信号频率等

特性，合理设置线宽、间距等规则。此外，还需学会解读自动布线结果，对于出现的布线错误或不

合理之处，能够分析原因并进行调整。

相关知识

任务导入

想象一下，PCB 就像是一座城市，各个元件是城市中的建筑，而布线则是连接这些建筑的道路。

如果城市规划不合理，建筑分布混乱，道路狭窄且拥堵，那么城市的运转效率将会很低。同样，在

PCB 设计中，如果元件布局不合理，布线混乱，电路板就无法高效稳定地工作。例如，在设计一块

电脑主板时，若 CPU、内存等关键元件布局不当，信号传输就会受到干扰，导致电脑运行速度变慢

甚至出现故障。现在，你将成为 PCB 这座“城市”的规划师，通过合理布局元件和规划布线，让电

路板发挥出最佳性能。通过本任务的学习，你将掌握 PCB 布局和自动布线的核心技能，开启制作高

质量 PCB 的大门。

任务规划

1.复习电路原理知识，重点理解信号流向、电磁兼容性等概念与 PCB 布局的关系。同时，学习

Altium Designer 20 中元件布局的基本操作方法，如如何选中、移动、旋转元件等。

2.根据给定的 PCB 文件（如之前完成的 555 定时电路 PCB 文件），依据电路原理和布局原则，

手动对元件进行初步布局。先确定关键元件的位置，再逐步安排其他元件，注意元件之间的间距和

排列方式。

3.深入学习 Altium Designer 20 中的布线规则设置，包括线宽、间距、过孔大小、布线层数等参

数的含义和设置方法。根据电路特性，为当前 PCB 文件设置合理的布线规则。

4.使用软件的自动布线功能对 PCB 进行布线操作。在布线过程中，观察布线进度和结果，记录

出现的问题。布线完成后，分析自动布线结果，检查是否存在未布线区域、短路、线宽不符合要求

等问题。

5.针对自动布线出现的问题，进行手动调整和优化。学习使用软件的手动布线工具，对不合理



的布线进行修改，对未布线区域进行补线。最后，对整个 PCB 布局和自动布线过程进行总结，整理

操作步骤和遇到的问题及解决方法，形成报告。

任务实施

任务验证

完成 PCB 布局和自动布线后，通过以下多种方式进行验证：一是进行电气规则检查（ERC），利

用 Altium Designer 20 自带的 ERC 功能，检查布线是否存在短路、断路、未连接引脚等电气错误。若

出现错误，根据提示信息定位问题所在，并进行修改。二是检查布线规则是否符合设定要求，如线

宽、间距、过孔大小等是否满足之前设置的参数。使用软件的测量工具和规则检查功能，对关键区

域的布线进行检查。三是从电路功能实现的角度进行验证，结合原理图和电路原理知识，分析布线

是否能够保证信号正常传输，各个元件是否能够正确连接并协同工作。例如，对于 555 定时电路，

检查输出信号引脚是否正确连接到后续电路，电源和地的布线是否合理等。四是从生产加工和维护

的角度进行评估，检查元件布局是否便于焊接、调试和维修，是否预留了足够的空间用于安装其他

部件或进行测试。如果在验证过程中发现问题，及时返回相应步骤进行修改，直到 PCB 布局和布线

完全符合要求。

任务小结

通过本任务的学习与实践，系统地掌握了 PCB 布局和自动布线的流程和技巧。在布局过程中，

学会了依据电路原理和相关原则对元件进行合理安排，提高了对电路整体结构的理解和把握能力。

在自动布线环节，深入了解了布线规则的重要性，并能够根据电路特性进行合理设置。同时，也学

会了分析和解决自动布线过程中出现的问题，掌握了手动调整布线的方法。在实践过程中，认识到

PCB 布局和布线是一个需要耐心和细心的工作，每一个细节都可能影响到电路板的性能和可靠性。

在今后的 PCB 设计工作中，将继续运用所学知识，不断优化布局和布线方案，提高 PCB 设计的质量

和效率。

任务 7 PCB 手动布线

任务描述

尽管 Altium Designer 20 具备强大的自动布线功能，但在某些情况下，手动布线对于优化 PCB 设

计、满足特殊布线要求至关重要。本任务要求学习者在已完成自动布线的 PCB 基础上，或者针对一

些对布线有特殊要求的电路，掌握手动布线的方法和技巧。学习者需要熟练运用软件的手动布线工

具，如交互式布线工具、过孔放置工具等，对 PCB 进行局部或整体的手动布线调整。在手动布线过

程中，要严格遵循布线规则，确保布线的合理性和正确性，同时注重布线的美观性和整洁性。通过



完成本任务，学习者能够进一步提升 PCB 布线的技能，学会在自动布线的基础上进行优化，以及独

立完成复杂或特殊要求的 PCB 手动布线工作。

任务分析

PCB 手动布线需要学习者具备扎实的 PCB 设计基础知识和熟练的软件操作技能。首先，要深入

理解布线规则，如不同网络的线宽要求、安全间距、信号完整性规则等，确保手动布线符合设计要

求。其次，需要熟练掌握 Altium Designer 20 中手动布线工具的使用方法，包括如何启动布线命令、

选择布线层、切换布线模式等。在手动布线过程中，要根据电路的功能和信号流向，合理规划布线

路径，避免出现信号干扰、布线过长等问题。对于一些特殊的布线要求，如高速差分线对的布线、

电源平面的分割等，需要运用特定的布线技巧和方法来实现。此外，手动布线还考验学习者的耐心

和细心，需要仔细处理每一条布线，确保布线的质量。

相关知识

任务导入：在 PCB 设计的舞台上，自动布线就像是一位高效的“工匠”，能够快速搭建起布线的

基本框架。但有时候，这个框架可能无法满足一些特殊的需求，就如同建造一座艺术建筑，机器只

能完成基础结构，而精致的细节需要工匠手工雕琢。手动布线就是这样的“雕琢”过程，它可以对自

动布线的结果进行优化，让 PCB 更加完美。例如，在设计高速通信电路板时，为了保证信号的完整

性，一些关键的信号线路需要精确控制长度和间距，这就需要手动布线来实现。现在，你将拿起“雕
琢”的工具，学习如何用手动布线为 PCB 设计增添亮点。通过本任务的学习，你将掌握手动布线这一

重要技能，提升在 PCB 设计领域的竞争力。

任务规划：

1.复习 PCB 布线规则，包括线宽、间距、过孔等参数的设定原则，以及信号完整性、电磁兼容

性等相关知识。同时，熟悉 Altium Designer 20 中手动布线工具的位置和基本功能，如交互式布线工

具、过孔放置工具、推挤工具等。

2.打开一个已完成自动布线的 PCB 文件（如之前完成的项目文件），分析自动布线的结果，找

出需要手动调整的区域，如存在布线不合理、线宽不符合要求或未满足特殊布线要求的地方。

3.针对找出的问题区域，使用手动布线工具进行局部调整。例如，对于线宽不符合要求的线路，

使用交互式布线工具重新绘制符合要求的线宽；对于存在信号干扰风险的区域，调整布线路径，增

加布线间距。在调整过程中，注意遵循布线规则，确保新的布线不会引入新的问题。

4.学习特殊布线技巧，如高速差分线对的布线方法、电源平面的分割技巧等。针对一些对布线

有特殊要求的电路模块，进行手动布线练习，运用所学技巧完成特殊布线要求的实现。

5.对整个手动布线过程进行总结，整理手动布线的操作步骤、技巧和注意事项，形成操作指南。

对完成手动布线的 PCB 文件进行全面检查，包括电气规则检查、布线规则检查等，确保手动布线后

的 PCB 符合设计要求。同时，对比手动布线前后的 PCB 效果，总结手动布线对 PCB 性能和美观性的

提升作用。



任务实施

任务验证

完成 PCB 手动布线后，通过以下多种方式进行验证：首先，进行全面的电气规则检查，利用 Altium
Designer 20 的电气规则检查功能，检查手动布线后的 PCB 是否存在短路、断路、未连接引脚等电气

错误。如果出现错误，根据错误提示信息，仔细检查手动布线的线路连接情况，找出问题所在并进

行修改。其次，检查布线规则是否符合设定要求。使用软件的测量工具和规则检查功能，对 PCB 上

的线宽、间距、过孔大小等参数进行检查，确保手动布线部分的参数满足之前设定的布线规则。对

于关键的布线区域，如高速信号线路、电源线路等，要重点检查。再次，从信号完整性和电磁兼容

性的角度进行验证。结合电路原理知识和相关设计规范，分析手动布线后的 PCB 是否能够保证信号

正常传输，减少信号干扰和电磁辐射。例如，对于高速差分线对，检查其长度匹配情况、间距是否

符合要求等。最后，从 PCB 的整体美观性和整洁性方面进行评估。观察手动布线后的 PCB，检查布

线是否整齐有序，是否存在交叉混乱的情况。如果在验证过程中发现问题，及时返回手动布线环节

进行修改和优化，直到手动布线后的 PCB 完全符合设计要求。

任务小结

通过本任务的学习和实践，深入掌握了 PCB 手动布线的方法和技巧。学会了在自动布线的基础上，

根据实际需求对 PCB 进行局部或整体的手动布线调整，以满足特殊布线要求和优化布线效果。在手

动布线过程中，更加深刻地理解了布线规则的重要性，并且能够熟练运用软件的手动布线工具来实

现各种布线需求。同时，通过处理特殊布线要求，如高速差分线对布线等，提升了应对复杂布线场

景的能力。手动布线是一项需要耐心和细心的工作，它不仅考验的技术水平，还培养了严谨的工作

态度。在今后的 PCB 设计工作中，将根据不同的设计需求，灵活运用自动布线和手动布线两种方式，

打造出更加优质的 PCB 设计方案。

项目总结

通过本项目对 Altium Designer 20 的学习与实践，学习者在 PCB 设计领域取得了显著进步。在知

识层面，全面掌握了 PCB 设计的相关知识体系，包括 PCB 的基础知识、Altium Designer 20 的软件操

作以及元件制作和电路设计的原理。在能力方面，具备了独立完成复杂 PCB 设计项目的能力，从工

程文件创建到最终 PCB 制作完成，能够熟练运用各种技能解决实际问题。

在素质培养上，通过思政案例的学习和实践过程中的锻炼，养成了严谨认真、耐心细致的工作

作风，提升了团队协作精神和创新意识。在项目实践中，遇到了如原理图连接错误、元件封装不匹

配、布局布线不合理等问题，但通过查阅资料、请教老师和同学，最终都得到了解决，这不仅提高

了问题解决能力，还培养了坚韧不拔的毅力。



项目练习

题目 1：在 Altium Designer 20 中，如何设置 PCB 布线的线宽规则？

题目 2：简述在 Altium Designer 20 中创建一个新的原理图元件库的步骤。

项目 4：原理图元件和 PCB 元件的制作

项目描述

本项目围绕 Altium Designer 20 展开，专注于原理图元件和 PCB 元件的制作学习。在电子电路

设计领域，元件的准确制作是保障电路功能实现和 PCB 设计成功的关键环节。通过本项目实践，学

习者将深入掌握在 Altium Designer 20 环境下创建各类元件的技能，包括全新制作原理图元件与

PCB 封装元件、借助修改集成元件库来定制元件，以及自主构建集成元件库。

在全新制作元件过程中，学习者需从建立专属的原理图元件库和 PCB 封装库起步，运用软件的

绘图工具，精确绘制如三极管、电感等常见元件的原理图符号，并依据元件实际物理尺寸制作匹配

的 PCB 封装，如 RAD0.3、CAP0.2 等。对于修改集成元件库制作元件，学习者将学会在已有资源基

础上，通过调整元件外形、引脚设置以及封装细节，满足特定设计需求，例如定制发光二极管元件。

而在自制集成元件库任务中，学习者将系统学习集成库的搭建流程，从绘制原理图元件、设计封装，

到关联元件与封装，再到检测集成库的完整性与可用性，全面掌握集成元件库的制作要点。

整个项目以实际操作为主，通过一系列任务驱动，让学习者在实践中熟悉元件制作的全流程，

深刻理解元件电气特性、物理结构与软件操作之间的紧密联系，提升电子电路设计的实操能力与创

新思维，为后续独立完成复杂电路设计项目筑牢基础。同时，项目注重培养学习者严谨细致的工作

态度，在元件制作过程中，任何细微的尺寸偏差或属性设置错误都可能导致电路设计失败，以此强

化学习者对工作质量的重视，树立正确的职业素养。

项目学习目标

知识目标

全面理解原理图元件和 PCB 封装元件的结构、功能以及两者之间的关联，掌握不同类型元件的

电气特性和物理参数表示方法。

深入学习 Altium Designer 20 软件中元件库的管理机制，包括新建、编辑、删除元件库，以及

元件在库中的分类与存储方式。

熟悉集成元件库的概念、组成结构和优势，明确集成库在复杂电路设计中的重要作用。

了解行业内关于元件制作的标准和规范，如元件符号绘制标准、封装尺寸标准等，确保制作的

元件符合通用要求。

能力目标

熟练运用 Altium Designer 20 软件，独立完成各类原理图元件的全新制作，能够准确绘制元件

外形、合理设置引脚属性，满足不同电路设计对元件功能的需求。

精准制作与原理图元件对应的 PCB 封装，根据元件实际尺寸和安装要求，设计出精确的焊盘布



局、外形轮廓和封装尺寸，保证元件在 PCB 上的正确安装和电气连接。

学会通过修改集成元件库中的现有元件，快速定制满足特定设计要求的元件，提高元件制作效

率，灵活应对多样化的设计需求。

掌握自主创建集成元件库的技能，能够将多个原理图元件及其对应的封装整合到一个集成库中，

并进行有效的管理和调用，提升复杂电路设计中元件管理的便利性和规范性。

在元件制作过程中，能够运用所学知识分析和解决出现的问题，如元件绘制错误、封装不匹配、

集成库调用异常等，提高问题解决能力和实践操作能力。

素质目标

培养严谨认真、注重细节的工作作风。元件制作对精度要求极高，一个小的失误就可能导致整

个电路出现故障，通过项目实践，让学习者养成对工作高度负责、精益求精的态度。

增强创新意识和探索精神。鼓励学习者在元件制作过程中尝试新的设计思路和方法，突破传统

元件的限制，培养创新思维，提升在电子电路设计领域的创新能力。

提升团队协作能力和沟通能力。若项目以小组形式开展，学习者在交流元件制作经验、分享技

巧和解决问题的过程中，学会与团队成员密切配合，提高团队协作效率和沟通效果。

树立知识产权意识和职业道德观念。在使用和制作元件过程中，尊重他人的知识产权，遵守行

业规范，不抄袭、不盗用他人的元件设计成果，培养良好的职业道德和职业操守。

项目分析

本项目聚焦于原理图元件和 PCB 元件的制作，涉及多个复杂且关键的技术环节，旨在培养

学习者在电子电路设计领域的核心技能，对学习者的知识储备、实践操作能力和问题解决能力都提

出了较高要求。

从技术角度来看，全新制作原理图元件和 PCB 封装元件需要学习者熟练掌握 Altium
Designer 20 软件的绘图工具和功能。在绘制原理图元件时，不仅要精确描绘元件的外形，更要准确

设置引脚的属性，包括编号、名称、电气类型等，这些参数直接关系到元件在原理图中的电气连接

和功能实现。制作 PCB 封装元件时，需依据元件的实际物理尺寸进行设计，精确绘制焊盘和外形轮

廓，确定合适的孔径、间距等参数，任何尺寸偏差都可能导致元件在 PCB 上无法正确安装或电气性

能不佳。例如，在制作 RAD0.3 元件封装时，若焊盘间距设置不准确，将导致插件式元件无法顺利

插入焊盘。

通过修改集成元件库来制作元件，要求学习者深入理解集成元件库的结构和原理。在选

择基础元件进行修改时，需要准确判断元件的适用性，既要考虑元件的外形和功能相似性，又要兼

顾修改的可行性和效率。修改过程中，对元件外形和引脚设置的调整需要谨慎操作，避免破坏元件

原有的电气特性。同时，修改封装时要确保新封装与修改后的元件完美匹配，这需要学习者熟悉封

装的结构和参数设置，以及元件与封装之间的关联机制。

自己制作集成元件库是对前面知识和技能的综合运用，也是更高层次的挑战。建立集成

库框架时，要规划好原理图元件库和 PCB 封装库的结构，以便后续管理和使用。绘制原理图元件和

封装时，需遵循统一的标准和规范，保证元件的一致性和通用性。为原理图元件增加封装并建立正

确关联，涉及到软件中多个功能模块的协同操作，任何一个环节出现错误都可能导致集成库无法正

常使用。检测集成库是否制作成功，需要学习者掌握有效的检测方法和工具，能够准确识别并解决

集成库中存在的问题。



思政案例：“芯”系家国，逐梦前行

案例标题

“芯”系家国，逐梦前行

案例背景

在当今科技飞速发展的时代，集成电路作为现代电子信息产业的核心，是国家战略性、基

础性和先导性产业。然而，我国在集成电路领域长期面临着国外技术封锁和垄断的困境，高端芯片

严重依赖进口，这不仅制约了我国电子信息产业的发展，也对国家的信息安全构成了威胁。为了实

现我国集成电路产业的自主可控和跨越式发展，无数科研工作者和工程师们不畏艰难，投身于芯片

研发和设计的征程中。

案例内容

在某高校的电子设计实验室里，有一支由年轻教师和学生组成的科研团队，他们立志攻克

集成电路设计的关键技术难题，为我国的芯片产业贡献自己的力量。团队负责人张教授是一位在电

子设计领域有着丰富经验和深厚造诣的专家，他带领团队成员深入研究集成电路设计的理论和方法，

积极探索新的设计思路和技术路线。

在项目研究过程中，团队遇到了诸多困难和挑战。例如，在芯片设计的关键环节——布局

布线方面，由于芯片规模庞大、复杂度高，传统的设计方法无法满足设计要求，导致布线效率低下、

信号干扰严重等问题。面对这些困难，团队成员们没有退缩，他们查阅大量的文献资料，与国内外

同行进行交流合作，不断尝试新的算法和技术。经过无数个日夜的努力，他们终于成功开发出一种

新的布局布线算法，有效提高了布线效率和芯片性能。

在项目推进过程中，团队成员们还面临着巨大的工作压力和生活挑战。为了赶项目进度，

他们经常加班加点，放弃了许多休息和娱乐的时间。然而，他们始终保持着坚定的信念和饱满的热

情，因为他们深知自己肩负着国家和民族的重任。最终，经过多年的努力，团队成功设计出一款具

有自主知识产权的高端芯片，打破了国外在该领域的技术垄断，为我国集成电路产业的发展做出了

重要贡献。

教育启示

这个案例给带来了深刻的教育启示。首先，它体现了科研工作者们的爱国情怀和责任担当。

他们将个人的发展与国家的需求紧密结合起来，为了实现国家的科技自立自强，不惜付出艰辛的努

力。这种爱国精神和责任意识是每一位学习者都应该学习和传承的。

其次，案例展示了科研工作者们勇于创新、敢于挑战的精神。在面对技术难题时，他们不

满足于现状，积极探索新的方法和技术，不断突破自我。这种创新精神是推动科技进步和社会发展

的重要动力，在学习和工作中也应该培养自己的创新意识和创新能力。

最后，案例强调了团队协作的重要性。在科研项目中，一个人的力量是有限的，只有通过

团队成员之间的密切配合和协作，才能充分发挥每个人的优势，实现共同的目标。在学习和生活中

也应该学会与他人合作，培养团队协作精神和沟通能力。

项目规划

1.基础认知与软件熟悉



深入学习原理图元件和 PCB 元件的基本概念、作用以及它们在电子电路中的相互关系。

通过查阅教材、观看专业视频等方式，了解不同类型元件的特点和应用场景。

打开 Altium Designer 20 软件，熟悉元件库管理界面、绘图工具、属性设置等基本操作。尝试

创建简单的原理图元件和 PCB 封装，初步掌握软件的操作流程，为后续的深入学习打下基础。

2.全新元件制作实践

新建原理图元件库和 PCB 封装库。在原理图元件库中，以三极管、电感等元件为例，开

始全新制作元件。使用软件的绘图工具，精确绘制元件的外形，根据元件的电气特性合理放置引脚，

并设置引脚的属性，如名称、编号、电气类型等。

在 PCB 封装库中，制作与原理图元件对应的封装。根据元件的实际尺寸，绘制准确的焊盘和外

形轮廓，设置合适的封装参数，如焊盘大小、间距、孔径等。在制作过程中，要严格按照元件的数

据手册进行操作，确保封装尺寸的准确性。

完成元件制作后，进行自查和互查。通过电气规则检查（ERC）和设计规则检查（DRC），检查

元件是否存在错误。同时，与同学或老师交流，听取他们的意见和建议，对元件进行优化和完善。

3.修改集成元件库制作元件

学习集成元件库的结构和使用方法，了解如何在已有集成元件库的基础上进行元件修改。

在 Altium Designer 20 中打开集成元件库，选择与目标元件相似的元件作为基础进行修改。

以绘制发光二极管为例，对选中的基础元件进行外形调整、引脚设置变更等操作。同时，根据

实际需求修改元件的封装，确保封装与修改后的元件相匹配。在修改过程中，要注意保留元件的关

键电气特性，避免因修改不当导致元件无法正常使用。

修改完成后，对元件进行测试。将修改后的元件放置在简单的原理图和 PCB 设计中，检查元件

的功能是否正常，封装是否合适。如果发现问题，及时返回修改，直到元件能够满足设计要求。

4.自制集成元件库构建

新建集成库，在集成库中创建原理图元件库和 PCB 封装库。在原理图元件库中绘制所需的

元件，如常用的集成电路、特殊功能元件等。在绘制过程中，要注重元件的规范性和通用性，为后

续的集成库使用提供便利。

在 PCB 封装库中制作与原理图元件对应的封装。对于一些标准封装元件，可以直接使用软

件自带的封装库；对于特殊封装元件，则需要根据元件的实际尺寸和安装要求进行定制制作。

将原理图元件与对应的 PCB 封装进行关联，完成集成库的初步制作。在关联过程中，要确保元

件与封装的对应关系准确无误，避免出现关联错误导致元件无法在 PCB 设计中正常使用。

对自制的集成库进行检测，使用软件提供的检测工具检查集成库是否存在错误。可以通过在新

的 PCB 项目中调用集成库中的元件，检查元件的调用是否正常，封装是否匹配等。如果发现问题，

及时对集成库进行修复和优化。

5.项目总结与拓展

对整个项目进行全面总结，回顾项目过程中遇到的问题和解决方法，整理项目经验和教训。

撰写项目报告，详细记录项目的设计思路、实现过程、遇到的问题及解决措施等内容。

与同学或团队成员进行交流分享，展示自己制作的元件和集成库，听取他人的意见和建议。通

过交流，学习他人的优点，发现自己的不足之处，进一步提升自己的元件制作能力。

根据项目总结和交流反馈，对自己制作的元件和集成库进行最后的优化和完善。同时，思

考在实际电路设计中如何更好地运用所学的元件制作技能，为未来的电路设计项目做好准备。

任务 1 全新制作原理图元件和 PCB 封装元件



任务描述

在 PCB 设计过程中，有时软件自带的元件库无法满足设计需求，这就需要学习者掌握全新制作

原理图元件和 PCB 封装元件的技能。本任务要求学习者运用 Altium Designer 20 软件，创建原理图

元件库和 PCB 封装库。在原理图元件库中，以三极管、电感等元件为例，从绘制元件外形、放置引

脚到设置引脚属性，完成全新原理图元件的制作。在 PCB 封装库中，制作如 RAD0.3、CAP0.2 等常

见封装元件，包括确定封装尺寸、绘制焊盘和轮廓等操作。通过本任务，学习者将能够根据实际电

路设计需求，独立创建精确的原理图元件和 PCB 封装元件，为后续的原理图绘制和 PCB 设计提供

支持。

任务分析

完成全新制作原理图元件和 PCB 封装元件的任务，需要学习者熟悉 Altium Designer 20 中元件

库的管理和编辑功能，同时具备一定的电子元件知识和绘图技能。在制作原理图元件时，要准确绘

制元件外形，使其符合元件的实际外观或行业标准符号，同时根据元件的电气特性合理放置引脚并

设置引脚属性，确保在原理图中能够正确连接和使用。制作 PCB 封装元件时，需要精确测量或获取

元件的物理尺寸信息，根据这些信息绘制焊盘和轮廓，保证封装尺寸与实际元件匹配，以便在 PCB 设

计中元件能够准确安装和焊接。这要求学习者仔细处理每个细节，避免因元件或封装制作错误导致

后续设计出现问题。

相关知识

任务导入

在电子电路设计的世界里，每个元件都像是一个独特的 “零件”，而原理图元件和 PCB 封装元

件则是这个 “零件” 在设计和制造过程中的两种不同表现形式。当进行复杂电路设计时，就如同搭

建一座精密的机器，可能会遇到现有的 “零件”（软件自带元件库中的元件）无法满足需求的情况。

这时候，就需要自己动手制作特殊的 “零件”。例如，在设计一款新型的电子产品时，可能会用到一

些特殊规格的三极管或电感，软件自带的元件库中没有对应的元件和封装。如果不能自己制作这些

元件和封装，设计工作将无法顺利进行。通过本任务的学习，你将掌握制作这些特殊 “零件” 的技

能，为你的电路设计工作增添强大的工具，让你能够更加自由地实现自己的设计创意。

任务规划

1. 学习 Altium Designer 20 中创建原理图元件库和 PCB 封装库的方法，熟悉元件库的管理界

面和基本操作。创建一个新的原理图元件库和 PCB 封装库，并命名保存。

2. 以三极管为例，学习绘制原理图元件。在原理图元件库编辑器中，使用绘图工具绘制三极



管的外形，注意线条的精度和图形的规范性。然后放置引脚，根据三极管的电气特性设置引脚的名

称、编号和电气类型等属性。完成绘制后，对三极管元件进行检查和修改，确保元件的准确性。

3. 绘制电感元件的原理图。按照绘制三极管的流程，先绘制电感的外形，再放置引脚并设置

属性。绘制过程中，参考电感的相关资料，确保元件的电气特性在原理图中得到准确体现。

4. 制作 RAD0.3 元件封装。在 PCB 封装库编辑器中，根据 RAD0.3 的尺寸规格，绘制焊盘和

轮廓。设置焊盘的大小、形状和间距，以及轮廓的尺寸和形状，保证封装尺寸与实际元件相符。制

作完成后，进行封装检查，查看是否存在尺寸错误或其他问题。

5. 制作 CAP0.2 圆形封装。同样在 PCB 封装库编辑器中，按照 CAP0.2 的尺寸要求绘制圆形

焊盘和封装轮廓，设置好相关参数。完成后，对所有制作的元件和封装进行整理和检查，将制作过

程中的经验和问题记录下来，形成文档。

任务实施

任务验证

完成元件和封装制作后，通过多种方式进行验证。首先，在元件库中检查绘制的原理图元件，

查看外形是否正确，引脚数量、位置和属性是否准确。将制作的原理图元件放置到一个简单的原理

图中，连接其他元件，进行电气规则检查，查看是否存在引脚连接错误等问题。对于 PCB 封装元件，

使用软件的 3D 预览功能（如果有），从三维角度查看封装的外形和焊盘布局，检查是否符合实际

元件的尺寸和形状。将封装元件与对应的原理图元件关联起来，导入到 PCB 设计文件中，检查元件

在 PCB 上的放置和布线是否正常，是否存在封装不匹配的问题。如果在验证过程中发现问题，仔细

分析原因，如绘图尺寸不准确、引脚属性设置错误等，及时进行修改，直到元件和封装完全符合要

求。

任务小结

通过本任务的学习和实践，成功掌握了在 Altium Designer 20 中全新制作原理图元件和 PCB 封

装元件的技能。学会了创建元件库、绘制元件外形、放置引脚和设置引脚属性，以及制作精确的 PCB
封装。在制作过程中，对电子元件的电气特性和物理结构有了更深入的理解，同时也提高了软件操

作技能和绘图精度。制作元件和封装是一项需要耐心和细心的工作，任何一个小的失误都可能导致

元件在使用中出现问题。在今后的电路设计中，可以根据实际需求灵活制作各种自定义元件和封装，

为设计更加个性化、多样化的电路提供有力支持。

任务 2 通过修改集成元件库来制作元件

任务描述



在实际 PCB 设计中，利用 Altium Designer 20 的集成元件库进行元件制作是一种高效的方法。

本任务要求学习者学会通过修改集成元件库中的现有元件来满足特定设计需求。以发光二极管为例，

学习者需要在集成元件库中找到与之相似的元件模型，然后对其进行修改，包括外形调整、引脚设

置变更等操作，使其符合设计要求的发光二极管元件。同时，对于修改后的元件，要确保其封装与

实际元件匹配，若不匹配则需对封装进行相应修改。通过本任务，学习者将掌握利用集成元件库进

行元件制作的技巧，提高元件制作的效率，同时理解元件与封装之间的关联关系，为后续的电路设

计工作提供便利。

任务分析

通过修改集成元件库来制作元件，需要学习者熟悉 Altium Designer 20 的集成元件库结构和编

辑方法，同时对目标元件的特性有清晰的认识。在选择集成元件库中的基础元件时，要找到与目标

元件（如发光二极管）在功能和外形上最为接近的元件，这样可以减少修改的工作量。修改元件外

形时，要注意保持图形的规范性和准确性，使其能够清晰地表示元件的功能。调整引脚设置时，要

根据发光二极管的电气特性，正确设置引脚的名称、编号、电气类型以及与其他元件的连接关系。

在修改封装时，要确保封装尺寸与修改后的元件实际尺寸相符，同时考虑到 PCB 布局布线的要求，

保证封装的合理性。这一系列操作需要学习者具备一定的逻辑思维能力和耐心，仔细处理每个修改

步骤，避免因修改不当导致元件无法正常使用。

相关知识

任务导入

在电子电路设计的过程中，就像一群工匠，总是在寻找最适合的 “材料”（元件）来构建的电路

“作品”。集成元件库就像是一个装满各种半成品 “材料” 的仓库，里面有许多相似的元件模型可供选

择和加工。比如，当需要一个特殊规格的发光二极管用于电路设计时，也许集成元件库中没有完全

符合要求的元件，但可能存在与之相近的元件模型。这时候，就可以像工匠一样，对这些已有的 “材
料” 进行加工改造，使其变成需要的元件。通过本任务的学习，你将学会如何在这个 “仓库” 中挑

选合适的 “材料”，并运用工具（Altium Designer 20 软件功能）对其进行修改，快速制作出满足设计

需求的元件，提高的设计效率。

任务规划

1.打开 Altium Designer 20 软件，熟悉集成元件库的管理界面，了解如何浏览和查找元件。在集

成元件库中搜索与发光二极管相似的元件，记录下元件所在的库名和元件名称。

2.将找到的相似元件复制到一个新的原理图元件库中，以便进行修改操作，避免直接修改原始

集成元件库。在新的原理图元件库编辑器中，打开复制的元件进行编辑。根据发光二极管的实际外



形，调整元件的图形，如修改引脚的长度、角度，调整元件主体的形状等。

3.根据发光二极管的电气特性，修改元件的引脚设置。设置引脚的名称为 “阳极” 和 “阴极”，
编号与实际相符，电气类型设置为正确的输入 / 输出类型。同时，检查引脚与元件图形的连接关系

是否正确。

4.检查修改后的元件封装是否与实际发光二极管匹配。如果不匹配，打开对应的 PCB 封装库，

对封装进行修改。根据发光二极管的实际尺寸，调整焊盘的大小、间距和形状，以及封装轮廓的尺

寸和形状。

5.对修改后的发光二极管元件和封装进行全面检查，确保元件外形、引脚设置和封装都符合设

计要求。将修改后的元件和封装应用到一个简单的原理图和 PCB 设计中，进行实际测试，检查是否

能够正常使用。整理修改过程中的经验和问题，形成文档记录。

任务实施

任务验证

完成元件和封装的修改后，通过以下方式进行验证。首先，在原理图中放置修改后的发光二极

管元件，连接其他相关元件，进行电气规则检查，确保元件的引脚连接正确，没有电气错误。然后，

将原理图更新到 PCB 文件中，检查元件在 PCB 上的封装是否正确，焊盘与引脚的对应关系是否准

确。使用软件的 3D 预览功能查看 PCB 上元件的封装效果，检查封装尺寸是否与实际发光二极管

相符。在 PCB 布局布线过程中，观察元件的放置和布线是否顺利，是否存在因元件或封装修改不当

导致的问题。如果在验证过程中发现问题，仔细分析问题产生的原因，可能是元件外形修改不当、

引脚设置错误或封装尺寸不准确等，针对性地进行修改，直到元件和封装能够正常使用。

任务小结

通过本任务的学习与实践，掌握了通过修改集成元件库来制作元件的方法。学会了在集成元件

库中寻找相似元件作为基础进行修改，以及如何根据实际需求调整元件的外形、引脚设置和封装。

在这个过程中，不仅提高了元件制作的效率，还加深了对元件与封装之间关系的理解。同时，也认

识到在修改元件和封装时，要严谨细致，确保每个修改都符合实际需求。在今后的电路设计中，可

以充分利用集成元件库的资源，灵活修改元件，快速满足不同的设计要求，提升的设计能力和工作

效率。

任务 3 自己制作集成元件库

任务描述

在复杂的 PCB 设计项目中，创建自己的集成元件库可以方便管理和使用自定义的原理图元件和



PCB 封装元件，提高设计效率。本任务要求学习者运用 Altium Designer 20 软件，完成创建集成元

件库的全过程。首先，学习者需要建立一个新的集成库框架，然后在其中创建原理图元件库和 PCB 封

装库。在原理图元件库中绘制所需的元件，如一些常用的集成电路或特殊功能元件，并为其设置正

确的属性。在 PCB 封装库中制作与原理图元件对应的封装，确保封装尺寸准确无误。接着，将原理

图元件与相应的封装进行关联，完成集成库的初步制作。最后，通过检测集成库是否制作成功，确

保库中的元件和封装能够在 PCB 设计中正常使用。通过本任务，学习者将掌握创建集成元件库的技

能，学会整合原理图元件和 PCB 封装元件，为复杂电路设计提供有力的支持。

任务分析

制作自己的集成元件库需要学习者综合运用多种知识和技能。首先，要熟悉 Altium Designer 20
中集成库的创建流程和管理方法，包括如何建立集成库框架、添加原理图元件库和 PCB 封装库等操

作。绘制原理图元件时，要准确把握元件的电气特性和功能，绘制出符合标准的元件图形，并正确

设置引脚属性。制作 PCB 封装元件时，要根据元件的实际尺寸和安装要求，精确绘制焊盘和轮廓，

确保封装与元件匹配。将原理图元件与封装关联起来需要理解两者之间的对应关系，准确设置关联

参数。检测集成库的制作是否成功，需要学习者掌握相关的检测方法和工具，能够及时发现并解决

可能存在的问题，如元件与封装不匹配、库文件损坏等。这一系列操作要求学习者具备严谨的工作

态度和较强的逻辑思维能力，每个环节都紧密相连，任何一个环节出现问题都可能导致集成库无法

正常使用。

相关知识

任务导入

在电子电路设计的大型项目中，就像是一个指挥众多 “零件士兵” 的将军，而集成元件库就是

的 “兵器库”。当项目越来越复杂，需要用到大量自定义的原理图元件和 PCB 封装元件时，如果没

有一个统一的、便于管理的 “兵器库”，这些 “零件士兵” 就会变得混乱无序，难以调度。想象一下，

在设计一款多功能的智能设备时，有各种各样的特殊元件和封装，如果它们散落在不同的地方，每

次使用都要花费大量时间去寻找和匹配，这将极大地影响设计效率。而创建自己的集成元件库，就

像是打造了一个专属的、井然有序的 “兵器库”，所有的元件和封装都整齐地排列其中，随时可以调

用。通过本任务的学习，你将学会如何打造这个强大的 “兵器库”，让你的电路设计工作更加高效、

便捷。

任务规划

1. 学习 Altium Designer 20 中创建集成库的基础知识，包括集成库的结构、组成部分以及创

建流程。打开软件，按照操作步骤建立一个新的集成库框架，命名并保存。

2. 在新建的集成库中添加原理图元件库。在原理图元件库编辑器中，开始绘制第一个原理图

元件，例如一个简单的微控制器元件。绘制元件的外形，注意图形的规范性和可读性，使其能够清



晰地表示元件的功能。放置引脚并设置引脚属性，包括引脚名称、编号、电气类型等，确保引脚设

置符合微控制器的电气特性。

3. 继续在原理图元件库中绘制其他所需的元件，如电阻、电容等常用元件。绘制过程中，注

意元件之间的一致性和规范性，为每个元件设置合理的默认参数。

4. 集成库中添加 PCB 封装库。根据之前绘制的原理图元件，制作对应的 PCB 封装。以微控

制器元件为例，根据其芯片的实际尺寸和引脚布局，绘制焊盘和封装轮廓。设置焊盘的大小、形状、

间距，以及封装轮廓的尺寸和形状，确保封装与元件匹配。制作其他元件的封装时，同样要保证尺

寸准确无误。

5. 将原理图元件与对应的 PCB 封装进行关联。在原理图元件库中，为每个元件指定相应的封

装。完成关联后，对集成库进行初步检查，查看是否存在关联错误或其他问题。使用软件提供的检

测工具，检测集成库是否制作成功。如果发现问题，仔细分析原因并进行修改。最后，整理创建集

成库的过程和经验，记录下遇到的问题及解决方法，形成文档。

任务实施

任务验证

完成集成库制作后，通过多种方式进行验证。首先，在一个新的 PCB 项目中，尝试使用创建的

集成库中的元件。在原理图中放置元件，检查元件的图形、引脚属性是否正确显示，能否正常连接

其他元件。进行电气规则检查，查看是否存在引脚连接错误等问题。然后，将原理图更新到 PCB 文

件中，检查元件的封装是否正确导入，封装的焊盘与引脚对应关系是否准确。在 PCB 布局布线过程

中，观察元件的放置和布线是否顺利，是否存在因集成库问题导致的布线错误或元件无法放置的情

况。使用软件的 3D 预览功能查看 PCB 上元件的封装效果，检查封装尺寸是否与实际元件相符。

如果在验证过程中发现问题，仔细分析问题产生的原因，可能是元件绘制错误、封装制作不准确、

关联设置错误或集成库文件损坏等，针对性地进行修改，直到集成库中的元件和封装能够在 PCB 设

计中正常使用。

任务小结

通过本任务的学习和实践，成功掌握了制作自己的集成元件库的技能。学会了建立集成库框架、

绘制原理图元件、制作 PCB 封装以及将两者关联起来的全过程。在这个过程中，提高了对元件和封

装的管理能力，理解了集成库在复杂电路设计中的重要性。同时，也认识到制作集成库需要严谨细

致，每个环节都要严格把控，确保元件和封装的准确性和一致性。在今后的电路设计中，可以根据

项目需求不断完善和扩充自己的集成库，提高设计效率，为实现更复杂、更创新的电路设计奠定坚

实基础。



任务 4：集成元件库的管理与优化 新增的一个任务

任务描述

在电子电路设计中，随着项目的增多和设计的复杂化，集成元件库的管理与优化变得至关重要。

本任务要求学习者运用 Altium Designer 20 软件，对已创建的集成元件库进行有效的管理和优化。学

习者需要学会对集成元件库中的元件进行分类整理，添加详细的元件描述和注释，以方便后续的查

找和使用。同时，要对元件库进行定期的更新和维护，确保元件库中的元件信息准确无误，封装与

实际元件匹配。此外，还需要对集成元件库进行优化，包括减少库文件的大小、提高元件的调用速

度等，以提高设计效率。通过本任务，学习者将掌握集成元件库管理与优化的方法和技巧，为高效

的电子电路设计提供有力支持。

任务分析

集成元件库的管理与优化涉及到多个方面的知识和技能。首先，学习者需要熟悉 Altium Designer
20 软件中集成元件库的管理界面和操作方法，能够对元件库进行创建、打开、关闭、保存等基本操

作。其次，要具备良好的分类和整理能力，能够根据元件的类型、功能、封装等因素对元件进行合

理分类，为每个元件添加准确的描述和注释，以便于快速查找和使用。

在更新和维护元件库方面，学习者需要关注元件的最新信息和变化，及时更新元件的参数、封

装等内容，确保元件库的准确性和实用性。同时，要建立有效的备份机制，防止元件库文件丢失或

损坏。

优化集成元件库需要学习者了解软件的性能特点和优化策略，通过合理的设置和操作，减少库

文件的大小，提高元件的调用速度。例如，可以对元件库进行压缩、清理无用的元件和数据等操作。

这要求学习者具备一定的计算机知识和软件操作技能，能够根据实际情况选择合适的优化方法。

相关知识

1.集成元件库的基本概念

定义：集成元件库是将原理图元件库和对应的 PCB 封装库进行整合，形成一个包含元件完整信

息（包括电气符号、物理封装、参数等）的数据库。它是电子设计自动化（EDA）软件中用于存储和

管理各种电子元件信息的重要工具，方便设计师在电路设计过程中快速调用所需元件。

组成结构：一般由元件库文件、元件模型、元件属性等部分组成。元件库文件是存储元件信息

的载体，元件模型描述了元件的电气特性和物理形状，元件属性则包含了元件的各种参数，如阻值、

容值、耐压等。

2.元件分类原则

按元件类型分类：这是最常见的分类方式，将元件分为电阻、电容、电感、二极管、三极管、

集成电路等。这种分类方式便于快速定位到所需的元件类型。

按功能分类：根据元件在电路中所起的作用进行分类，如电源元件、信号处理元件、控制元件

等。这种分类方式有助于设计师从功能的角度去组织和管理元件库。

按封装形式分类：可分为贴片元件和插件元件，每种封装形式又可进一步细分，如贴片电阻有



0402、0603 等不同尺寸规格。按封装分类可以方便在 PCB 设计时选择合适封装的元件。

3.元件注释与描述规范

描述内容：元件描述应包含元件的基本信息，如名称、型号、规格等。例如，对于一个电阻，

描述可以是“10kΩ 0805 贴片电阻”。
注释要求：注释应提供更详细的元件特性和使用说明，如电阻的精度、电容的耐压值、集成电

路的功能特点等。注释内容应简洁明了，避免使用模糊或歧义的语言。

4.元件库更新与维护知识

更新原因：元件的参数可能会随着技术发展而更新，新的封装形式可能会出现，或者元件供应

商可能会提供更准确的元件信息。因此，定期更新元件库可以保证设计的准确性和可靠性。

维护方法：建立元件信息跟踪机制，关注元件供应商的官方网站、技术论坛等渠道，及时获取

元件的最新信息。同时，要对元件库进行定期备份，防止数据丢失。

5.元件库优化技术

文件压缩技术：使用常见的压缩算法（如 ZIP、RAR 等）对元件库文件进行压缩，可以减少文

件占用的存储空间。在压缩时，要注意选择合适的压缩级别，以平衡压缩比和压缩速度。

数据清理与整理：删除元件库中无用的元件、重复的数据和过期的信息，优化元件的存储结构，

提高元件的调用速度。

任务导入

在电子电路设计的世界里，集成元件库就像是一个庞大的“知识宝库”，里面存储着各种电子元

件的信息和封装。随着设计项目的不断积累，这个“宝库”会变得越来越庞大和复杂，如果不进行有

效的管理和优化，就会像一个杂乱无章的仓库，难以找到所需的元件，甚至可能导致设计错误。想

象一下，当你在进行一个紧急的设计项目时，却因为无法快速找到合适的元件而耽误了时间，或者

因为使用了过时的元件信息而导致设计失败，那将是多么令人沮丧的事情。因此，学会对集成元件

库进行管理和优化是非常必要的。通过本任务的学习，你将掌握打开这个“宝库”的钥匙，让你的设

计工作更加高效、便捷。

任务规划

1.学习集成元件库管理基础知识

复习 Altium Designer 20 中集成元件库的基本概念和结构。

学习软件中集成元件库的管理界面和操作方法，包括创建、打开、关闭、保存等基本操作。

了解元件分类和整理的原则和方法，为后续的元件库整理做好准备。

2.元件库分类整理与注释添加

打开已创建的集成元件库，根据元件的类型、功能、封装等因素对元件进行分类。可以创建不

同的文件夹或分组来存放不同类型的元件。

为每个元件添加详细的描述和注释，包括元件的名称、型号、参数、封装等信息。确保描述和

注释准确、清晰，便于后续查找和使用。

检查元件库中元件的编号和名称是否规范，对不规范的地方进行修改。

3.元件库更新与维护

关注元件的最新信息和变化，通过查阅元件供应商的网站、技术手册等渠道，获取元件的最新



参数和封装信息。

对元件库中过时的元件信息进行更新，包括元件的参数、封装等内容。确保元件库中的元件信

息准确无误，封装与实际元件匹配。

建立元件库的备份机制，定期对元件库进行备份，防止文件丢失或损坏。可以将备份文件存储

在外部硬盘或云存储中。

4.元件库优化

分析集成元件库的性能瓶颈，确定需要优化的方面，如库文件大小、元件调用速度等。

根据分析结果，选择合适的优化方法。例如，可以对元件库进行压缩，清理无用的元件和数据，

优化元件的存储结构等。

对优化后的元件库进行测试，检查元件的调用速度和库文件大小是否得到改善。如果效果不理

想，继续调整优化方法。

5.总结与评估

对整个集成元件库管理与优化过程进行总结，整理操作步骤和遇到的问题及解决方法。

评估集成元件库管理与优化的效果，包括元件查找的便捷性、设计效率的提高等方面。

根据评估结果，制定后续的元件库管理与优化计划，持续改进元件库的质量和性能。

任务实施

一、学习集成元件库管理基础知识

1.复习集成元件库基本概念和结构

（1）打开 Altium Designer 20 软件，回顾之前创建的集成元件库，了解集成元件库的组成部分，

包括原理图元件库、PCB 封装库以及它们之间的关联关系。

（2）查阅相关资料，进一步理解集成元件库在电子电路设计中的重要作用，以及它如何提高设

计效率和保证设计的准确性。

（3）学习软件中集成元件库的管理界面和操作方法

（4）打开软件的“Library”面板，熟悉面板中的各个功能按钮和选项。了解如何打开、关闭、新

建和保存集成元件库文件。

（5）尝试创建一个新的临时集成元件库，进行打开、关闭和保存操作，熟悉操作流程。

二、了解元件分类和整理的原则和方法

1.学习常见的元件分类方法，如按元件类型（电阻、电容、电感、二极管、三极管等）、功能

（电源元件、信号处理元件、控制元件等）、封装形式（贴片、插件等）进行分类。

思考如何根据自己的设计需求和习惯，制定适合自己的元件分类方案。

2.元件库分类整理与注释添加

（1）元件分类

打开已创建的集成元件库，在“Library”面板中，右键点击元件库名称，选择“New Folder”创建不

同的文件夹或分组。例如，创建“电阻”、“电容”、“集成电路”等文件夹。

逐个选中元件，将其拖动到相应的文件夹中进行分类。对于一些多功能或特殊元件，可以根据

其主要功能进行分类，或者创建一个“其他”文件夹进行存放。

（2）添加描述和注释

选中一个元件，在“Library”面板的元件信息区域中，找到“Description”（描述）和“Comment”（注

释）字段。

在“Description”字段中，输入元件的详细名称和型号，如“10kΩ 贴片电阻”、“LM358 双运算放大

器”等。

在“Comment”字段中，输入元件的主要参数和特点，如电阻的精度、电容的耐压值、集成电路



的功能等。例如，对于一个电容，可以输入“10μF 耐压 50V 陶瓷电容”。
（3）规范元件编号和名称

检查元件库中元件的编号和名称是否规范。对于编号不连续或不规范的元件，进行重新编号。

统一元件名称的命名规则，例如使用英文名称或缩写，避免使用中文或不规范的名称。对于一

些具有相似功能的元件，可以使用相同的前缀或后缀进行区分。

3.元件库更新与维护

（1）获取元件最新信息

打开元件供应商的官方网站，如 TI（德州仪器）、ST（意法半导体）等，搜索元件的型号，获

取元件的最新数据手册和参数信息。

关注元件的技术论坛和社区，了解元件的最新应用和技术动态，以及是否有元件的更新版本或

替代方案。

（2）更新元件信息

打开集成元件库，选中需要更新的元件，在“Library”面板的元件信息区域中，修改元件的参数和

封装信息。

如果元件的封装有更新，需要重新制作或下载新的封装文件，并将其关联到相应的元件上。

（3）建立备份机制

选择一个外部硬盘或云存储服务，如百度网盘、Google Drive 等，作为元件库的备份存储位置。

定期（如每周或每月）对集成元件库进行备份，将元件库文件复制到备份存储位置。可以使用

脚本或自动化工具来实现定期备份的功能。

4.元件库优化

（1）分析性能瓶颈

打开集成元件库，观察元件的调用速度。如果调用速度较慢，可能是由于库文件过大或存储结

构不合理导致的。

使用软件的性能分析工具（如果有），分析元件库的占用空间和资源使用情况，找出占用空间

较大的元件或数据。

（2）选择优化方法

压缩元件库文件：使用压缩软件（如 WinRAR、7-Zip 等）对集成元件库文件进行压缩，减少文

件的大小。在压缩时，可以选择合适的压缩格式和压缩级别，以平衡压缩比和压缩速度。

清理无用元件和数据：在“Library”面板中，检查元件库中是否存在无用的元件或数据。对于不再

使用的元件，可以将其删除；对于重复的元件或数据，可以进行合并或清理。

优化元件存储结构：调整元件在文件夹或分组中的存储方式，使元件的存储结构更加合理。例

如，可以将常用的元件放在更靠前的位置，方便快速查找和调用。

（3）测试优化效果

打开优化后的集成元件库，进行元件的查找和调用操作，观察调用速度是否得到改善。

检查优化后的库文件大小是否明显减小。如果效果不理想，重新分析性能瓶颈，调整优化方法，

再次进行优化和测试。

5.总结与评估

（1）总结操作步骤和问题解决方法

回顾整个集成元件库管理与优化过程，整理操作步骤和遇到的问题及解决方法。可以将这些内

容记录在文档中，以便后续参考。

对操作步骤进行详细描述，包括每个步骤的具体操作方法和注意事项。对于遇到的问题，分析

问题产生的原因，并记录解决问题的方法和思路。

（2）评估优化效果

从元件查找的便捷性、设计效率的提高等方面评估集成元件库管理与优化的效果。可以通过比



较优化前后的设计时间、查找元件的时间等指标来进行评估。

收集团队成员或其他使用者的反馈意见，了解他们对优化后元件库的使用体验和满意度。

（3）制定后续管理与优化计划

根据评估结果，制定后续的集成元件库管理与优化计划。例如，确定定期更新元件库的时间间

隔，制定进一步优化元件库性能的方案等。

将后续管理与优化计划纳入日常工作流程，确保集成元件库的质量和性能得到持续提升。

任务验证

完成集成元件库的管理与优化后，通过以下方式进行验证：

1.元件查找验证：在“Library”面板中，使用搜索功能查找不同类型的元件，检查是否能够快速准

确地找到所需元件。验证元件的描述和注释是否清晰、准确，是否能够帮助快速了解元件的信息。

2.元件调用验证：在原理图设计中，尝试调用优化后的集成元件库中的元件，观察元件的调用

速度是否明显提高。检查元件的参数和封装是否正确显示，是否能够正常使用。

库文件大小验证：查看优化后的集成元件库文件大小，与优化前进行比较，检查库文件大小是

否明显减小。如果库文件大小没有明显变化，需要重新分析优化方法，找出问题所在。

3.设计效率验证：选择一个实际的电子电路设计项目，使用优化后的集成元件库进行设计，记

录设计过程中查找元件和调用元件的时间，与之前使用未优化元件库的设计项目进行比较，评估设

计效率是否得到提高。

4.兼容性验证：将优化后的集成元件库应用到不同的项目中，检查是否与其他设计文件和软件

版本兼容。确保在不同的环境下，元件库都能够正常使用，不会出现元件丢失、封装不匹配等问题。

如果在验证过程中发现问题，仔细分析问题产生的原因，可能是元件分类不合理、注释信息不

准确、优化方法不当等，针对性地进行修改和调整，直到集成元件库的管理与优化效果达到预期目

标。

任务小结

通过本任务的学习和实践，学习者掌握了集成元件库管理与优化的方法和技巧。学会了对

集成元件库中的元件进行分类整理、添加详细注释，以及对元件库进行更新、维护和优化。在这个

过程中，学习者提高了对集成元件库的管理能力，理解了良好的元件库管理对电子电路设计效率和

质量的重要性。

同时，学习者也认识到集成元件库管理与优化是一个持续的过程，需要不断关注元件的最

新信息和技术发展，定期对元件库进行更新和维护。在今后的电子电路设计工作中，学习者可以运

用所学知识和技能，建立和管理高效、准确的集成元件库，为设计工作提供有力支持。此外，通过

团队协作和交流，学习者还可以分享元件库管理与优化的经验和成果，促进整个团队的设计水平提

升。

项目总结



本项目围绕 Altium Designer 20 环境下原理图元件和 PCB 元件的制作展开，通过一系列实

践任务，让学习者在知识、技能和职业素养方面都取得了显著的成长。

在知识层面，学习者全面掌握了原理图元件和 PCB 元件的相关知识体系。深入理解了不同

类型元件的电气特性、物理结构以及它们在电路中的功能与相互关系，学会依据元件数据手册解读

关键参数，为元件制作和电路设计提供理论支撑。同时，熟悉了 Altium Designer 20 软件中元件库

管理、绘图工具使用、属性设置等功能，了解了行业内元件制作的标准和规范，构建了系统的电子

电路元件制作知识框架。

技能上，学习者实现了从基础操作到复杂制作的跨越。能够熟练运用软件独立完成全新原理

图元件和 PCB 封装元件的制作，精确绘制元件外形、合理设置引脚属性、精准设计封装尺寸。掌握

了通过修改集成元件库定制元件的技巧，提高了元件制作效率，满足多样化设计需求。还成功掌握

了自制集成元件库的技能，包括集成库搭建、元件与封装关联及检测，有效提升了复杂电路设计中

元件管理的规范性和便利性。在实践过程中，学习者遇到了如元件绘制错误、封装不匹配、集成库

调用异常等问题，通过分析问题、查阅资料、尝试不同解决方案，解决问题的能力得到了极大锻炼，

实践操作技能愈发娴熟。

职业素养方面，项目实践培养了学习者严谨认真、注重细节的工作作风。元件制作对精度

要求极高，任何细微失误都可能导致电路故障，在反复制作和检查元件的过程中，学习者养成了对

工作高度负责、精益求精的态度。同时，鼓励创新的项目氛围激发了学习者的创新意识和探索精神，

在元件制作过程中积极尝试新的设计思路和方法，提升了创新能力。若以小组形式开展项目，团队

成员间的协作与沟通让学习者学会了相互学习、支持，团队协作能力和沟通能力得到了有效提升。

此外，项目强调知识产权保护和遵守行业规范，帮助学习者树立了正确的职业道德观念。

项目实施过程中也暴露出一些不足之处。部分学习者在软件高级功能的运用上还不够熟练，例

如在处理复杂元件的 3D 模型设计、精确的电气规则设置等方面存在困难。在面对一些复杂的元件

制作需求时，创新思维和综合运用知识的能力还有待提高。针对这些问题，在后续学习中，应加强

对软件高级功能的学习和实践，深入研究复杂元件制作案例，拓宽设计思路，提升综合能力。

通过本项目，学习者在原理图元件和 PCB 元件制作领域迈出了坚实的步伐，为未来从事电

子电路设计工作奠定了坚实基础。在未来的学习和实践中，应不断巩固和拓展所学知识与技能，持

续提升自身能力，以适应电子行业不断发展的需求。

项目练习

题目 1：简述在 Altium Designer 20 中新建一个原理图元件库并绘制一个简单电阻元件的步骤

题目 2：在 Altium Designer 20 中，制作一个与原理图元件对应的 PCB 封装时，如何确定焊盘

的大小和间距？

题目 3：在修改集成元件库中的元件时，发现修改后的元件在原理图中无法正常使用，可能有

哪些原因？应如何排查和解决？

项目 5：心形灯电路制作



项目描述

本项目聚焦于使用 Altium Designer 20 软件进行心形灯电路的设计与制作，旨在通过实践项目全

面提升学习者在电子电路设计与 PCB 制作方面的综合能力。在项目中，学习者将经历从电路原理设

计、元件与封装制作，到 PCB 设计与制作的完整流程。首先，学习者需深入理解心形灯电路的工作

原理，依据此设计出合理的电路原理图，并制作或挑选适配的元件与封装。随后，运用 Altium Designer
20 软件，将原理图转化为 PCB 设计，完成从板子形状绘制、布局布线，到泪滴添加与覆铜等一系列

操作。最后，通过实际制作与调试，让心形灯电路实现预期功能。

在学习过程中，学习者不仅能熟练掌握 Altium Designer 20 软件的操作技巧，还能深入理解电子

电路设计与 PCB 制作的知识体系。同时，通过对项目中细节的把控与问题的解决，培养学习者严谨

认真、耐心细致的工作态度，以及勇于创新、善于思考的职业素养，为其未来在电子设计领域的发

展奠定坚实基础。

项目学习目标

知识目标

深入理解心形灯电路的工作原理，包括各元件的作用及相互之间的电气连接关系。

熟练掌握 Altium Designer 20 软件中元件制作、原理图绘制、PCB 设计等功能模块的操作方法与

技巧。

掌握电子元件的基本特性，如电阻、电容、发光二极管等，以及如何根据电路需求选择合适的

元件参数。

了解 PCB 制作的工艺流程，包括板材选择、加工工艺等方面的知识。

能力目标

能够独立完成心形灯电路的原理图设计，准确绘制电路连接图，合理选择和布局元件。

熟练运用 Altium Designer 20 软件制作或修改元件及封装，确保元件与电路设计相匹配。

具备使用 Altium Designer 20 进行 PCB 设计的能力，包括绘制板子形状、布局布线、添加泪滴和

覆铜等操作，能够解决设计过程中出现的常见问题。

掌握心形灯电路的实际制作与调试技能，能够根据调试结果分析和解决电路故障，使电路达到

预期的功能效果。

素质目标

培养严谨认真、注重细节的工作态度。在电路设计与制作过程中，任何一个小的失误都可能导

致电路无法正常工作，通过项目实践，让学习者养成对工作高度负责的精神。

提升创新思维与解决问题的能力。在设计心形灯电路时，鼓励学习者尝试不同的设计思路和方

法，遇到问题时积极思考、主动探索解决方案，培养其创新能力和应变能力。

增强团队协作精神。若项目以小组形式开展，学习者需学会与团队成员沟通协作，共同完成项

目任务，提高团队协作能力和沟通能力。

树立正确的职业道德观和价值观。在项目实践中，强调知识产权保护、遵守行业规范等重要性，

培养学习者的职业道德和社会责任感。

项目分析



1.技术层面分析

电路原理设计：心形灯电路虽不算复杂，但需要学习者准确理解电路的工作逻辑，合理选择元

件参数。例如，要根据发光二极管的额定电压、电流来选择合适的电阻进行限流，确保发光二极管

正常工作且不被烧毁。

元件与封装制作：在 Altium Designer 20 软件中制作元件与封装，要求学习者熟悉软件的绘图工

具和操作流程。元件的绘制需要精确把握外形和引脚定义，封装的制作则要根据元件的实际尺寸和

安装方式进行设计，任何尺寸偏差都可能导致元件在 PCB 上无法正确安装。

PCB 设计：使用 Altium Designer 20 进行 PCB 设计时，从绘制心形板子形状到布局布线，都需要

考虑诸多因素。布局时要考虑元件之间的电气连接关系、散热需求以及美观性；布线过程中要遵循

电气规则，合理设置线宽、间距等参数，避免出现短路、断路等问题。泪滴添加和覆铜操作也需要

掌握正确的方法，以增强 PCB 的稳定性和可靠性。

电路制作与调试：将设计好的 PCB 制作成实物后，调试过程需要学习者具备一定的电路故障排

查能力。能够根据心形灯的点亮情况，运用所学知识分析可能出现的问题，如元件损坏、焊接不良、

电路连接错误等，并进行针对性的修复。

2.学习过程分析

知识储备要求：学习者需要具备一定的电子电路基础知识，如欧姆定律、基尔霍夫定律等，同

时要对 Altium Designer 20 软件有初步的了解。对于基础薄弱的学习者，可能需要花费更多时间学习

相关知识，才能更好地完成项目。

实践操作难度：项目中的各个环节都需要学习者进行实际操作，从软件操作到电路焊接调试，

都需要一定的技巧和经验。特别是在 PCB 设计和电路调试阶段，初学者可能会遇到较多问题，需要

不断尝试和摸索，这对学习者的耐心和毅力是一个考验。

创新与拓展：项目鼓励学习者在完成基本功能的基础上进行创新，如改变心形灯的点亮模式、

添加其他功能模块等。这需要学习者具备一定的创新思维和拓展能力，能够在掌握基础知识和技能

的基础上，进行灵活运用和创新设计。

思政案例：精益求精，打造完美电路

案例标题

精益求精，打造完美电路

案例背景

在电子制造行业竞争日益激烈的当下，产品质量成为企业立足市场的关键。对于电子电路

设计与制作而言，每一个细节都关乎产品的性能和可靠性。然而，部分从业者为追求速度和降低成

本，忽视电路设计的细节，导致产品质量参差不齐，影响了整个行业的声誉。在这样的背景下，一

些企业和工程师始终坚守精益求精的工匠精神，为提升产品质量不懈努力。

案例内容

某电子科技公司承接了一款高端智能灯具的电路设计与制作项目，其中心形灯模块是产品

的核心亮点之一。项目团队负责人李工深知该项目的重要性，带领团队成员全身心投入到设计工作

中。在电路原理设计阶段，团队成员对每一个元件的参数进行反复核算，确保电路性能最优。例如，

为了使心形灯的亮度均匀且稳定，他们对发光二极管的选型和驱动电路进行了多次试验和优化。

在元件制作与 PCB 设计环节，团队成员严格把控每一个细节。制作元件封装时，精确测量

元件尺寸，确保封装与实际元件完美匹配。在 PCB 设计过程中，对布局布线进行了多次调整，不仅

考虑了电气性能，还注重了美观性和可制造性。在制作过程中，团队成员认真对待每一个焊接点，

严格按照工艺标准进行操作。



在项目接近尾声时，团队成员在测试过程中发现心形灯在特定环境下会出现微弱的闪烁现

象。虽然这一问题不影响产品的基本功能，但李工带领团队成员没有丝毫懈怠，对电路进行了全面

检查。经过数天的排查和分析，最终发现是一个电容的参数在极端环境下略有偏差。团队成员立即

对电容参数进行了调整，并重新制作和测试，确保心形灯在各种环境下都能稳定工作。最终，该高

端智能灯具凭借其卓越的性能和精美的设计，在市场上获得了巨大成功，为公司赢得了良好的声誉。

教育启示

培养严谨细致的工作态度：从案例中可以看出，团队成员对电路设计的每一个环节都精益

求精，不放过任何一个细节。在学习和实践中，也应该养成严谨细致的工作习惯，对待每一个任务

都要认真负责，确保工作质量。

树立精益求精的工匠精神：李工团队在面对问题时，没有选择敷衍了事，而是深入研究、不断

优化，这种工匠精神值得学习。在电子电路设计领域，只有不断追求卓越，才能提升自己的专业水

平，打造出高质量的产品。

增强团队协作与沟通能力：项目的成功离不开团队成员之间的协作与沟通。在团队中，每

个人都发挥着重要作用，只有相互配合、共同努力，才能攻克难题，实现项目目标。在学习和工作

中，也应该积极与团队成员沟通协作，共同进步。

强化责任意识：团队成员深知项目的重要性，对产品质量高度负责。在学习和未来的工作

中，也应该树立强烈的责任意识，对自己的工作成果负责，为社会提供优质的产品和服务。

项目规划

1.知识学习与准备

学习心形灯电路的工作原理，了解各元件的作用和相互关系，查阅相关资料，掌握电路设计的

基本要求。

复习 Altium Designer 20 软件的基本操作，包括文件创建、元件库管理、原理图绘制和 PCB 设计

的基本流程。

准备好项目所需的电子元件清单，如发光二极管、电阻、电容、单片机（若涉及控制功能）等，

并确保元件的参数符合设计要求。

2.元件与封装制作

根据心形灯电路的需求，在 Altium Designer 20 软件中制作或挑选合适的元件。若需要自定义元

件，按照元件绘制的规范和流程，绘制原理图元件，并设置好引脚属性。

制作元件的 PCB 封装，精确测量元件的实际尺寸，根据尺寸设计封装的焊盘大小、间距和外形

轮廓。对于标准封装元件，可以从软件自带的元件库中查找并使用，但要确保封装与实际元件一致。

将制作好的元件和封装添加到自定义的元件库中，进行分类管理，方便后续使用。

3.原理图设计

在 Altium Designer 20 软件中创建新的原理图文件，根据心形灯电路原理，放置所需的元件，并

进行合理布局。

使用连线工具和网络标号，按照电路连接关系连接元件，绘制完整的原理图。在绘制过程中，

注意电气规则，避免出现短路、断路等错误。

对绘制好的原理图进行电气规则检查（ERC），根据检查结果修改原理图中的错误和警告信息，

确保原理图的正确性。

4.PCB 设计

将原理图导入到 Altium Designer 20的 PCB设计环境中，根据设计需求绘制心形的 PCB板子形状。



在禁止布线层绘制走线，确定板子的边界和外形尺寸。

对导入的元件进行布局，考虑元件之间的电气连接关系、散热需求、美观性等因素，合理调整

元件的位置。对于发热元件和敏感元件，要进行特殊布局处理。

设置布线规则，包括线宽、间距、过孔大小等参数。根据电路的电流大小和信号特性，合理设

置不同网络的布线规则。

进行自动布线或手动布线操作，完成 PCB 的布线工作。布线过程中，要确保布线的合理性和正

确性，避免出现布线冲突和信号干扰。

对布线后的 PCB 进行检查和优化，添加泪滴以增强焊盘与走线的连接强度，进行覆铜操作以提

高 PCB 的电气性能和抗干扰能力。

5.对整个心形灯电路制作项目进行总结，整理项目过程中的经验和教训，包括遇到的问题、解

决方法以及对电子电路设计和 PCB 制作的新认识。

撰写项目报告，详细记录项目的设计思路、实现过程、测试结果等内容，展示项目成果。

与同学或团队成员分享项目经验，互相学习和交流，共同提高电子电路设计和制作的能力。

任务 1：心形灯的元件和封装制作

任务描述

本任务聚焦于心形灯电路中特殊元件的设计与制作，要求学习者运用 Altium Designer 20 软件，

为心形灯电路创建专属的原理图元件和 PCB 封装。学习者需依据心形灯电路的功能需求，设计独特

的心形灯元件，精确绘制其原理图符号，明确引脚定义与功能。同时，根据实际选用的发光二极管

等元件的物理尺寸和安装方式，制作与之匹配的 PCB 封装，确保元件在 PCB 上的准确安装与电气连

接。这不仅考验学习者对 Altium Designer 20 软件绘图功能的熟练掌握程度，更要求学习者深入理解

元件的电气特性与物理结构之间的关系，为后续的心形灯电路原理图绘制和 PCB 设计奠定坚实基础。

任务分析

完成心形灯元件和封装制作任务，需要学习者综合运用多方面知识与技能。在软件操作方面，

要熟练掌握 Altium Designer 20 中原理图元件库和 PCB 封装库的创建与编辑功能，如使用绘图工具绘

制元件外形、设置引脚属性、定义封装尺寸等。从元件设计角度，需深入了解心形灯电路的工作原

理，确定元件的功能和引脚连接方式，保证原理图元件能准确反映电路逻辑。制作 PCB 封装时，要

精确测量实际元件的尺寸，考虑元件的安装精度、散热需求以及与其他元件的间距等因素，确保封

装的准确性和可靠性。此外，在制作过程中可能会遇到软件操作不熟练、元件尺寸测量误差、封装

设计不合理导致的安装问题等，需要学习者具备一定的问题解决能力。

相关知识



任务导入

在电子电路的创意世界里，心形灯电路就像是一颗闪耀的星星，为各种电子设备增添独特魅力。

想象一下，在节日庆典的舞台上，精美的心形灯牌散发着柔和的光芒，营造出浪漫温馨的氛围；或

者在个性化的电子产品中，心形灯作为独特的装饰元素，吸引着众多消费者的目光。而这一切的基

础，就是要为心形灯电路打造合适的“零件”——原理图元件和 PCB 封装。现在，你就有机会成为这

些“零件”的创造者，通过自己的双手，赋予心形灯电路生命。掌握心形灯元件和封装制作技能，不

仅能让你在这个项目中大放异彩，更是你在电子电路设计领域迈出的关键一步，为未来设计更多创

意电路积累宝贵经验。

任务规划

1.收集心形灯电路所需元件的资料，包括发光二极管、电阻等元件的规格参数和尺寸信息。同

时，复习 Altium Designer 20 中创建原理图元件库和 PCB 封装库的基本操作流程。

2.在 Altium Designer 20 中创建原理图元件库，开始设计心形灯的原理图元件。绘制元件外形，

根据电路功能设置引脚属性和编号。完成后进行初步检查，确保元件的准确性。

3.依据收集到的元件尺寸信息，在 PCB 封装库中制作相应的封装。绘制焊盘，确定封装的外形

轮廓和尺寸，保证封装与实际元件匹配。制作过程中，不断对照元件实际尺寸进行调整。

4.对制作好的原理图元件和 PCB 封装进行全面检查。将元件放置在原理图中进行简单连接测试，

检查引脚连接是否正确；使用软件的 3D 预览功能查看 PCB 封装，检查尺寸和布局是否合理。根据

检查结果进行修改完善。

5.整理制作过程中的经验和问题，撰写制作报告，记录元件和封装的设计思路、制作步骤以及

遇到的问题和解决方法。

任务实施

任务验证

完成元件和封装制作后，通过多种方式进行验证。首先，进行电气规则检查（ERC），在原理图

中连接多个心形灯元件及相关电阻等，检查是否存在引脚未连接、电气冲突等问题。若出现错误，

根据提示信息定位并修改。其次，使用软件的 3D 预览功能，查看 PCB 封装的三维效果，检查焊盘

位置、大小以及封装外形是否与实际元件相符。将制作好的元件和封装导入到一个简单的 PCB 设计

中，检查元件在 PCB 上的放置和布线是否顺畅，有无封装不匹配导致的布局问题。还可以制作一个

简易的测试电路板，将实际元件焊接到按照制作的封装设计的 PCB 上，接通电源测试心形灯是否能

正常点亮，以此验证封装与元件的匹配性和电路连接的正确性。如果在验证过程中发现问题，仔细

分析原因，如尺寸测量误差、软件操作失误等，针对性地进行修改，直到元件和封装完全符合设计



要求。

任务小结

通过本任务的学习与实践，成功掌握了心形灯电路元件和封装的制作方法。学会了根据电路需

求在 Altium Designer 20 中创建原理图元件库和 PCB 封装库，绘制独特的心形灯原理图元件并制作匹

配的封装。在制作过程中，对电子元件的电气特性和物理结构有了更深入的理解，软件操作技能也

得到了显著提升。同时，认识到精确测量元件尺寸、合理设计封装以及仔细检查验证的重要性。任

何一个小的疏忽都可能导致元件在后续电路设计和制作中出现问题。在今后的电路设计工作中，可

以运用这些技能，为各种创意电路制作定制化的元件和封装，不断提升自己的设计能力。

任务 2：心形灯原理图和 PCB 的制作

任务描述

本任务旨在让学习者运用 Altium Designer 20 软件，完成心形灯电路从原理图设计到 PCB 制作的

全过程。在原理图设计环节，学习者需根据心形灯电路的功能需求，合理选择并布局元件，准确绘

制电路连接关系，确保电路逻辑正确。完成原理图绘制后，将其导入到 PCB 设计环境中，根据心形

灯的外观形状要求，绘制独特的心形 PCB 板子。接着进行布局布线工作，综合考虑信号传输、电源

分配、元件散热以及美观性等因素，合理安排元件位置，规划布线路径，确保 PCB 的电气性能和可

靠性。最后，对 PCB 进行放置泪滴和覆铜操作，进一步优化 PCB 的性能，完成整个心形灯电路的设

计与制作。

任务分析

完成心形灯原理图和 PCB 的制作任务，涉及多个复杂且相互关联的环节。在原理图设计方面，

需要学习者掌握电路原理知识，能够根据心形灯的工作要求，如发光二极管的点亮方式、控制逻辑

等，选择合适的元件并正确连接。同时，要熟练运用 Altium Designer 20 的原理图绘制工具，合理布

局元件，使原理图清晰易读。将原理图转换到 PCB 设计时，需要准确导入元件信息，确保元件和网

络连接正确无误。绘制心形 PCB 板子形状时，要灵活运用软件的绘图功能，精确绘制出符合要求的

外形。布局布线环节是重点也是难点，需要综合考虑多种因素，如信号干扰、电流大小、布线空间

等，合理设置布线规则，选择合适的布线方式（手动或自动），确保布线的合理性和正确性。放置

泪滴和覆铜操作则需要掌握相关的操作技巧，以增强 PCB 的稳定性和抗干扰能力。在整个过程中，

可能会遇到元件不匹配、布线冲突、电气性能不达标等问题，需要学习者具备较强的问题分析和解

决能力。

相关知识



任务导入

如果你手中拿着一个小巧精致的心形灯，它在黑暗中闪烁着温暖的光芒。这个小小的心形灯背

后，凝聚着电子电路设计的智慧。从最初的电路原理构思，到一步步将其转化为实际的 PCB 板，每

一个环节都充满挑战与惊喜。现在，你将亲身体验这个创造过程，运用 Altium Designer 20 软件，把

脑海中的创意变成现实。通过完成心形灯原理图和 PCB 的制作，你不仅能掌握电子电路设计的核心

技能，还能为自己的创意作品打下坚实基础。无论是为了制作个性化的礼物，还是探索电子电路设

计的奥秘，这个任务都将带你开启一段充满乐趣与收获的旅程。

任务规划

1. 复习心形灯电路原理知识，确定电路的大致框架和所需元件。打开 Altium Designer 20 软件，

新建工程文件，并在工程中新建原理图文件。

2. 在原理图文件中放置所需元件，如发光二极管、电阻、控制芯片（若有）等，根据电路功

能进行初步布局。使用连线工具连接元件，绘制完整的原理图，过程中注意电气规则，避免出现错

误连接。

3. 对绘制好的原理图进行电气规则检查（ERC），根据检查结果修改错误和警告信息。确认原

理图无误后，将其导入到 PCB 设计环境中。在 PCB 文件中，利用软件的绘图工具，在禁止布线层绘

制心形的板子形状，确定板子的边界和尺寸。

4. 对导入的元件进行布局。首先确定关键元件的位置，如发光二极管的布局要符合心形的形

状，同时考虑散热和信号传输需求。然后调整其他元件的位置，使布局更加紧凑合理。布局完成后，

设置布线规则，包括线宽、间距、过孔大小等参数，根据电路的电流和信号特性进行合理设置。

5. 进行布线操作，可以先尝试自动布线，然后对自动布线的结果进行检查和手动调整，确保

布线符合设计要求。完成布线后，对 PCB 进行放置泪滴和覆铜操作，增强 PCB 的性能。最后，对整

个心形灯原理图和 PCB 设计进行全面检查，确保无误后保存文件。

任务实施

任务验证

完成心形灯原理图和 PCB 制作后，进行验证。

进行电气规则检查，确保原理图和 PCB 中没有电气连接错误。使用软件的 DRC（设计规则检查）

功能，检查 PCB 的布线是否符合之前设置的规则，如线宽、间距、过孔等是否达标。

任务小结



通过完成心形灯原理图和 PCB 的制作任务，成功地将理论设计转化为实际的电路产品。在这个

过程中，熟练掌握了 Altium Designer 20 软件在原理图绘制和 PCB 设计方面的操作技能。

从原理图设计的元件选择、布局和连接，到 PCB 设计的形状绘制、布局布线以及后期处理，每

一个环节都需要严谨对待。学会了如何根据电路功能需求设计合理的原理图，如何在 PCB 设计中综

合考虑电气性能、散热、美观等多方面因素，以及在制作和调试过程中如何排查和解决出现的问题。

项目总结

通过本项目对心形灯电路的设计与制作，学习者在多个方面取得了显著的收获。在知识层

面，深入理解了心形灯电路的工作原理，熟练掌握了 Altium Designer 20 软件的操作技巧，包括元件

制作、原理图绘制、PCB 设计等功能模块，同时也学习了电子元件知识和 PCB 制作工艺知识，构建

了较为完整的电子电路设计知识体系。

在能力方面，学习者具备了独立完成电路设计与制作的能力，从电路原理设计到 PCB 制作

再到电路调试，能够熟练运用所学知识和技能解决实际问题。在项目实践过程中，遇到了如元件封

装不匹配、布线错误、电路调试故障等问题，通过查阅资料、分析原因和不断尝试，最终成功解决

问题，有效提升了问题解决能力和实践操作能力。同时，在设计过程中，鼓励创新思维，部分学习

者尝试了不同的点亮模式和电路优化方案，培养了创新能力。

在素质培养上，通过项目实践，学习者养成了严谨认真、注重细节的工作态度。在电路设

计和制作过程中，每一个细节都至关重要，一个小的失误可能导致整个项目失败，从而让学习者深

刻认识到严谨细致的重要性。同时，在团队协作（若有）过程中，学习者学会了与他人沟通协作，

提高了团队协作能力和沟通能力。通过思政案例的学习，树立了精益求精的工匠精神和正确的职业

道德观，增强了责任意识。

项目实施过程中可能存在一些不足之处。部分学习者在软件操作的熟练度上还有待提高，

特别是在处理复杂的 PCB 设计时，对一些高级功能的运用不够灵活。在电路调试阶段，部分学习者

的故障排查能力还有提升空间，需要进一步加强对电路原理的理解和测试工具的使用。在未来的学

习和实践中，学习者应针对这些不足，加强练习，不断提升自己的专业素养和综合能力，为在电子

设计领域的深入发展打下更坚实的基础。

项目练习

题目 1：在心形灯电路中，如果发现部分发光二极管亮度明显低于其他二极管，可能是什么原

因导致的？应如何排查和解决？

题目 2：在 Altium Designer 20 软件中，如何将原理图中的元件布局快速应用到 PCB 设计中？

项目 6 交通信号灯的设计与制作



项目描述

本项目围绕交通信号灯的设计与制作展开，旨在运用 Altium Designer 20 软件，从电路原理设

计到实际印制电路板（PCB）制作，完成一套完整的交通信号灯控制系统设计。在电路原理设计方面，

需深入分析交通信号灯的工作逻辑，确定所需电子元件及其连接方式，精心绘制出准确且清晰的原

理图。对于 PCB 制作，要依据原理图进行布局规划，合理安排元件位置，确保信号传输稳定且互不

干扰；同时设置合适的布线规则，运用自动布线与手动布线相结合的方式，完成 PCB 的布线工作，

并进行泪滴添加和覆铜操作，以增强电路板的电气性能和稳定性。

通过本项目，不仅能够全面掌握 Altium Designer 20 在电路设计和 PCB 制作中的各项功能应用，

还能培养将理论知识转化为实际产品的能力。在实际操作过程中，需要不断优化设计，解决可能出

现的各种问题，如元件布局不合理导致的空间浪费、布线冲突引发的信号干扰等。这将有助于提高

对电子电路设计和制作流程的理解与掌控能力，为今后从事更复杂的电子设计项目奠定坚实基础，

同时也能提升解决实际工程问题的综合素质，使学习者更好地适应电子行业的发展需求。

项目学习目标

知识目标

深入理解交通信号灯电路的工作原理，掌握信号灯控制逻辑与相关电子元件（如微控制器、信

号灯、电阻、电容等）的功能及特性。

全面熟悉 Altium Designer 20 软件中原理图绘制和 PCB 设计的各项功能，包括元件库的管理与

使用、原理图的绘制规范、PCB 布局布线规则等知识要点。

学习 PCB 制作过程中的关键技术，如泪滴添加、覆铜操作的作用及原理，以及这些操作对电路

板电气性能和稳定性的影响。

能力目标

能够独立完成交通信号灯电路原理图的设计，准确选择和放置元件，正确连接线路，并进行电

气规则检查和优化，确保原理图的准确性和可靠性。

熟练运用 Altium Designer 20 软件进行 PCB 设计，根据原理图合理规划 PCB 布局，设置合适

的布线规则，完成自动布线和手动布线，提高 PCB 设计的效率和质量。

具备在设计过程中分析和解决问题的能力，针对原理图绘制和 PCB 设计中出现的错误和不合理

之处，能够运用所学知识进行排查和优化，确保项目顺利推进。

素质目标

培养严谨认真、注重细节的工作态度。在交通信号灯设计与制作过程中，任何一个小的失误都

可能导致整个系统无法正常工作，因此需要学习者养成仔细检查、反复核对的习惯，对待每一个设

计环节都要一丝不苟。

提升创新思维和解决实际问题的能力。交通信号灯的设计并非一成不变，学习者可以在满足基

本功能的基础上，尝试优化设计方案，如提高系统的稳定性、降低成本等，培养创新意识和实践能

力。

增强团队协作和沟通能力。如果项目以团队形式开展，学习者需要与团队成员密切配合，共同

完成设计任务。在这个过程中，学会倾听他人意见，分享自己的想法，提高团队协作和沟通效率。

项目分析



技术难点

电路原理设计：交通信号灯电路的设计需要精准把握其工作逻辑，这涉及到信号灯的时序控制、

微控制器的编程以及各元件之间的电气连接关系。例如，要确定不同颜色信号灯的点亮时长，以及

它们之间的切换逻辑，这需要对交通信号灯的工作流程有深入理解。同时，选择合适的微控制器和

其他电子元件，并确保它们之间的兼容性和协同工作，也是一个挑战。不同型号的微控制器在功能

和性能上存在差异，需要根据项目需求进行合理选择。

PCB 设计：在使用 Altium Designer 20 进行 PCB 设计时，布局布线是关键环节。合理的元件布

局要考虑到信号流向、散热、电磁干扰等多方面因素。例如，高频元件应尽量远离低频元件，以减

少电磁干扰；发热量大的元件要布局在利于散热的位置。布线规则的设置也需要谨慎，包括线宽、

间距、过孔大小等参数的选择，这些参数会直接影响电路板的电气性能和可靠性。如果线宽过细，

可能会导致电流承载能力不足，引起线路发热甚至烧毁；间距过小则容易出现短路故障。

项目复杂性

多学科知识融合：本项目融合了电子电路、自动化控制、计算机编程等多个学科的知识。学习

者不仅要掌握电子元件的特性和电路设计原理，还要了解自动化控制的逻辑和方法，以及微控制器

编程的基本知识。例如，通过编程实现交通信号灯的时序控制，需要学习者具备一定的编程能力和

逻辑思维能力。

设计流程繁琐：从电路原理图的设计到 PCB 的制作，整个流程包含多个环节，每个环节都相互

关联，任何一个环节出现问题都可能影响最终的设计结果。在原理图设计阶段，如果元件选择不当

或连接错误，会导致 PCB 设计无法正常进行；在 PCB 设计阶段，如果布局布线不合理，可能会导

致信号干扰、散热不良等问题，进而影响整个交通信号灯系统的性能。

潜在问题及解决方法

元件短缺或不兼容：在实际设计过程中，可能会遇到某些元件短缺或与其他元件不兼容的情况。

解决方法是在设计前充分调研市场上的元件供应情况，选择通用性强、易于获取的元件。同时，在

设计过程中，要对元件的参数进行仔细核对，确保它们之间的兼容性。如果遇到不兼容的问题，可

以尝试寻找替代元件或调整设计方案。

软件操作问题：Altium Designer 20 软件功能强大，但操作也较为复杂，学习者可能会在使用过

程中遇到各种软件操作问题。解决方法是加强对软件的学习和练习，查阅相关的软件文档和教程，

同时积极向老师和同学请教。此外，在项目进行过程中，要养成定期保存项目文件的习惯，防止因

软件故障导致数据丢失。

思政案例：精益求精，打造安全可靠的交通信号灯系统

案例标题

精益求精，打造安全可靠的交通信号灯系统

案例背景

在城市交通日益繁忙的今天，交通信号灯作为交通指挥的重要设施，其设计和制作的质量

直接关系到交通安全和效率。曾经有一个城市，由于交通信号灯的设计存在缺陷，导致信号灯在切

换过程中出现短暂的混乱，引发了多起交通事故，给人们的生命和财产带来了损失。这一事件引起

了广泛关注，也凸显了交通信号灯设计制作中严谨和精益求精的重要性。

案例内容

在交通信号灯的设计制作过程中，有一个团队负责一个重要路口的信号灯升级项目。起初，

团队成员在设计原理图时，对部分元件的参数选择不够严谨，只是参考了以往的经验，没有进行详

细的计算和验证。在 PCB 设计阶段，由于时间紧迫，布局布线也没有经过充分的优化，导致电路板

在测试过程中出现了信号干扰的问题。



随着项目的推进，团队意识到了问题的严重性。他们重新审视设计方案，对原理图中的元

件参数进行了精确计算和选型，确保每个元件都能在最佳状态下工作。在 PCB 设计方面，他们花费

了更多的时间进行布局布线优化，充分考虑了信号流向、电磁干扰等因素，对布线规则进行了严格

设置。在制作过程中，对每一个环节都进行了严格的质量把控，从元件的焊接到电路板的组装，都

做到了精益求精。最终，经过团队的努力，新的交通信号灯系统成功投入使用，该路口的交通秩序

得到了明显改善，交通事故发生率大幅降低。

教育启示

培养严谨的科学态度：在交通信号灯的设计制作过程中，每一个参数、每一个步骤都至关

重要。这启示在学习和工作中，要养成严谨认真的态度，对待知识和任务不能敷衍了事，要追求精

确和完美。

强化责任意识：交通信号灯关系到公共安全，设计制作团队肩负着重大的责任。这让明白，

在任何工作岗位上，都要清楚自己的职责，对自己的工作成果负责，不能因为一时的疏忽而给他人

带来危害。

树立团队合作精神：在解决交通信号灯设计制作问题的过程中，团队成员需要密切配合，

共同攻克难关。这告诉，团队合作是取得成功的关键，只有大家齐心协力，发挥各自的优势，才能

更好地完成任务。

培养创新和进取精神：团队在面对问题时，没有局限于传统的设计思路，而是积极探索和

改进。这鼓励在学习和工作中，要勇于创新，不断进取，以更好地满足社会发展的需求。

项目规划

1.前期准备阶段

收集交通信号灯相关资料，包括国家标准、设计规范以及类似项目的案例，深入了解交通信号

灯的工作原理和功能需求。

学习 Altium Designer 20 软件中与交通信号灯设计相关的功能模块，如元件库管理、原理图绘

制工具、PCB 布局布线规则等。

准备项目所需的硬件设备和材料，如电子元件（微控制器、信号灯、电阻、电容等）、PCB 板

材、焊接工具等。

2.电路原理设计阶段

根据交通信号灯的工作逻辑，设计电路原理图。确定所需元件的型号和参数，如微控制器的选

型要考虑其性能、资源和成本等因素；信号灯的选择要符合亮度、颜色和寿命等要求。

在 Altium Designer 20 软件中绘制原理图，仔细放置元件，正确连接线路，并进行电气规则检

查，确保原理图的准确性和完整性。

对原理图进行优化，如调整元件布局，使信号流向更加清晰，便于后续的 PCB 设计和维护。

3.PCB 设计阶段

将原理图导入到 Altium Designer 20 的 PCB 设计环境中，对元件进行布局规划。考虑信号流向、

散热、电磁干扰等因素，合理安排元件位置，确保电路板的性能和可靠性。

设置 PCB 布线规则，包括线宽、间距、过孔大小等参数。根据电路的电流大小和信号频率等因

素，确定合适的线宽和间距，以保证信号传输的质量和电路板的安全性。

先进行自动布线，然后对自动布线的结果进行检查和优化，对于不合理的布线部分，采用手动

布线进行调整，确保布线的合理性和美观性。

完成布线后，进行泪滴添加和覆铜操作，增强电路板的电气性能和稳定性。



4.项目总结与优化阶段

对整个项目过程进行总结，分析设计和制作过程中遇到的问题及解决方法，积累经验。

根据测试结果和实际使用情况，对交通信号灯的设计进行优化，如调整元件参数、改进布局布

线等，以提高系统的性能和可靠性。

任务 1 交通信号灯电路原理图和 PCB 简介

任务描述

本任务主要是让学习者全面了解交通信号灯电路和 PCB 的基本情况。交通信号灯作为交通管理

的关键设备，其电路原理决定了信号灯的工作逻辑，而 PCB 则是实现电路功能的物理载体。学习者

需要深入理解交通信号灯电路的组成结构，包括微控制器、信号灯、电阻、电容等元件的连接方式

和各自功能，以及它们如何协同工作来实现信号灯的有序切换。同时，要熟悉交通信号灯 PCB 的布

局特点、布线要求以及各层的功能，如信号层用于连接元件引脚实现电气连接，电源层为整个电路

提供稳定的电源供应，地层则起到屏蔽和接地的作用。通过本任务的学习，学习者将为后续的原理

图设计和 PCB 制作奠定坚实的理论基础。

任务分析

本任务看似简单，实则涉及到多个学科领域的知识，对学习者的综合能力要求较高。首先，在

理解交通信号灯电路原理方面，需要具备一定的电子电路基础知识，了解微控制器的编程原理、信

号灯的驱动方式以及电阻、电容等元件在电路中的作用。不同类型的微控制器具有不同的指令集和

资源配置，学习者需要根据交通信号灯的功能需求选择合适的微控制器，并理解其如何通过编程来

控制信号灯的点亮和熄灭。

其次，熟悉交通信号灯 PCB 的布局和布线要求，需要掌握 PCB 设计的相关知识和技能。布局

的合理性直接影响到电路板的性能和可靠性，例如元件的摆放位置不当可能会导致信号干扰、散热

不良等问题。布线规则的设置也至关重要，线宽、间距、过孔等参数的选择会影响信号的传输质量

和电路板的安全性。学习者需要了解这些规则的制定原则，并能够根据实际情况进行合理调整。

此外，本任务还需要学习者具备一定的资料查阅和分析能力。由于交通信号灯电路和 PCB 设计

涉及到众多的标准和规范，学习者需要通过查阅相关资料，了解行业标准和设计要求，并将其应用

到实际的学习和设计中。

相关知识



任务导入

在现代城市交通中，交通信号灯是维护交通秩序、保障交通安全的重要设施。当你走在繁忙的

十字路口，看到那红、黄、绿三色信号灯有规律地交替闪烁，引导着车辆和行人有序通行。你是否

想过，这些看似简单的信号灯背后，隐藏着怎样复杂的电路原理和设计呢？

随着科技的不断发展，交通信号灯的功能也越来越多样化。除了基本的信号灯切换功能外，还

可能具备倒计时显示、紧急情况处理等功能。这些功能的实现，离不开精确的电路设计和合理的 PCB
布局。那么，如何设计出一个高效、稳定的交通信号灯电路和 PCB 呢？这就是本次任务要探索的内

容。

通过本任务的学习，你将揭开交通信号灯背后的神秘面纱，了解其电路原理和 PCB 设计的基本

知识。你将能够独立分析交通信号灯电路的组成结构，理解各元件的作用和连接方式；掌握交通信

号灯 PCB 的布局和布线规则，为后续的实际设计和制作打下坚实的基础。

任务规划

1.资料收集阶段

收集交通信号灯电路的相关资料，包括电路图、设计手册、行业标准等。可以通过互联网、图

书馆、专业论坛等渠道进行资料收集。

收集 Altium Designer 20 软件中关于 PCB 设计的教程和文档，了解软件的基本功能和操作方法。

2.理论学习阶段

学习交通信号灯电路的工作原理，重点掌握微控制器的编程逻辑和信号灯的驱动方式。可以通

过阅读教材、观看教学视频等方式进行学习。

学习 PCB 设计的基础知识，包括 PCB 的层结构、布局原则、布线规则等。结合收集到的资料

和教程，深入理解 PCB 设计的要点。

3.案例分析阶段

分析实际的交通信号灯电路原理图和 PCB 设计案例，了解其设计思路和方法。可以选择一些经

典的设计案例进行分析，对比不同案例的优缺点，从中吸取经验教训。

在分析案例的过程中，注意总结交通信号灯电路和 PCB 设计的特点和规律，为自己的设计提供

参考。

4.总结与交流阶段

对本任务的学习内容进行总结，梳理交通信号灯电路和 PCB 设计的知识点和关键要点。

与同学和老师进行交流和讨论，分享自己的学习心得和体会，解答遇到的问题。通过交流和讨

论，进一步加深对本任务的理解和掌握。

任务实施

任务验证

在完成本任务的学习后，需要对学习者的学习成果进行验证。验证方式可以包括以下几个方面：



理论知识测试：通过笔试或在线测试的方式，考查学习者对交通信号灯电路原理和 PCB 设计基

础知识的掌握程度。测试内容可以包括交通信号灯电路的组成结构、微控制器的编程逻辑、PCB 的

层结构和布线规则等。

案例分析报告：要求学习者提交一份交通信号灯电路原理图和 PCB 设计案例的分析报告，分析

案例的设计思路、优缺点以及可借鉴之处。通过案例分析报告，考查学习者的分析能力和知识应用

能力。

口头汇报：组织学习者进行口头汇报，让他们介绍自己对交通信号灯电路和 PCB 设计的理解和

认识，分享学习过程中的收获和体会。通过口头汇报，考查学习者的表达能力和总结归纳能力。

通过以上验证方式，可以全面了解学习者对本任务的学习情况，发现存在的问题和不足之处，

并及时进行改进和完善。同时，也可以激励学习者更加努力地学习，提高自己的专业素养和综合能

力。

任务小结

通过本任务的学习，学习者对交通信号灯电路和 PCB 有了一个全面的了解。在学习过程中，学

习者不仅掌握了交通信号灯电路的工作原理和 PCB 设计的基础知识，还培养了自己的资料查阅、分

析和总结能力。同时，通过案例分析和交流讨论，学习者拓宽了自己的视野，学习到了不同的设计

思路和方法。

本任务的学习只是一个开始，交通信号灯电路和 PCB 设计是一个复杂的领域，需要不断地学习

和实践。在后续的任务中，学习者将进一步深入学习交通信号灯电路原理图的设计和 PCB 的制作，

将理论知识应用到实际设计中，提高自己的设计能力和实践能力。同时，学习者也应该注重培养自

己的创新意识和团队协作精神，为今后从事电子设计相关工作打下坚实的基础。

任务 2 交通信号灯的原理图元件和封装元件制作

任务描述

本任务聚焦于运用 Altium Designer 20.1 软件，完成交通信号灯电路所需的原理图元件和封装元

件的制作。交通信号灯系统通常包含多种特殊功能的元件，这些元件不仅是实现信号灯控制逻辑的

基础，其准确的封装更是确保在 PCB 上正确布局和焊接的关键。在原理图元件制作方面，需根据元

件的电气特性和功能要求，精确绘制元件的图形符号，合理设置引脚属性，保证在原理图设计时能

准确表示元件的连接关系和功能。对于封装元件制作，要依据元件的实际尺寸、引脚间距等物理参

数，在 Altium Designer 20.1 的 PCB 封装库中创建相应的封装模型，确保元件在 PCB 上的布局合理、

焊接可靠，为后续的原理图设计和 PCB 制作提供坚实的基础。通过完成本任务，学习者能够熟练掌

握特殊元件的设计方法，加深对电子元件电气与物理特性关系的理解，提升在 Altium Designer 20.1
环境下元件设计的实践能力。

任务分析

制作交通信号灯的原理图元件和封装元件，需要学习者综合运用多方面的知识和技能。在原理

图元件制作环节，要充分了解每个元件的功能、引脚定义及电气特性，绘制出准确规范的图形符号。



例如，对于交通信号灯专用的控制器芯片，其引脚众多且功能复杂，需仔细查阅芯片手册，明确各

引脚的功能，才能正确绘制图形符号并设置引脚属性。若对引脚定义理解有误，可能导致在原理图

设计时连接错误，影响整个电路功能。

在封装元件制作方面，准确获取元件的物理参数至关重要。需通过元件的数据手册、实际测量

等方式，获取元件的尺寸、引脚间距、引脚形状等参数。实际测量时，要注意测量工具的精度和测

量方法的正确性，以确保获取的数据准确可靠。根据这些参数在 Altium Designer 20.1 中创建封装模

型时，要严格按照软件的操作规范进行，如设置合适的层、线宽、孔径等参数。同时，还要考虑元

件在 PCB 上的布局要求，如散热、信号干扰等因素，合理设计封装的形状和尺寸。此外，制作过程

中可能会遇到软件操作不熟练、参数设置不合理等问题，需要学习者具备一定的问题解决能力，能

够通过查阅资料、参考教程或向他人请教等方式，及时解决问题，保证任务顺利进行。

相关知识

任务导入

在完成交通信号灯电路原理图和 PCB 的初步了解后，已经知道了交通信号灯系统是由多个不同

功能的元件协同工作来实现其功能的。这些元件在原理图中需要用特定的图形符号表示，在 PCB 上

则需要有与之对应的封装来确定其安装位置和方式。想象一下，如果没有准确的原理图元件和封装

元件，就如同建造房屋没有合适的图纸和零件，整个交通信号灯系统的设计和制作将无法顺利进行。

在实际的电子设计工作中，常常会遇到一些特殊的元件，它们在市场上可能没有现成的库文件

可供使用，或者现有的库文件不符合项目的特定需求。这就需要自己动手制作原理图元件和封装元

件。对于交通信号灯来说，其使用的一些专用芯片、特殊规格的信号灯等元件，很可能就需要进行

定制。通过本任务的学习和实践，将掌握这种定制元件的技能，不仅能够满足交通信号灯设计的需

求，还能为今后处理其他电子设计项目中的类似问题积累宝贵经验。现在，就让开启交通信号灯原

理图元件和封装元件的制作之旅吧！

任务规划

1.资料收集阶段：收集交通信号灯所需元件的详细资料，包括元件的数据手册、规格书等，获

取元件的电气特性、引脚定义、物理尺寸、引脚间距等关键信息。同时，收集一些优秀的元件制作

案例，学习其设计思路和技巧。

2.原理图元件制作阶段：根据收集到的资料，在 Altium Designer 20.1 中创建原理图元件库。按

照元件的功能和引脚定义，使用软件的绘图工具绘制元件的图形符号，设置引脚的编号、名称、电

气类型等属性。完成绘制后，进行自查和校验，确保元件的准确性。

3.封装元件制作阶段：依据元件的物理参数，在 Altium Designer 20.1 的 PCB 封装库中创建相

应的封装模型。使用软件的封装绘制工具，绘制封装的外形、焊盘等部分，设置焊盘的大小、孔径、

间距等参数。制作完成后，再次核对封装尺寸与实际元件是否相符。

4.整理与优化阶段：对制作好的原理图元件和封装元件进行整理，检查元件库和封装库的命名

规范、元件属性设置等是否统一、合理。对制作过程中发现的问题或不满意的地方进行优化和改进，



确保元件的质量和可用性。

任务实施

任务验证

完成交通信号灯的原理图元件和封装元件制作后，需要对制作成果进行多方面验证，以确保元

件的准确性和可用性。

元件属性检查：仔细核对原理图元件的引脚编号、名称、电气类型等属性是否与元件的数据手

册一致。例如，检查微控制器元件的引脚功能定义是否正确，信号灯元件的阳极、阴极引脚标识是

否准确。若存在错误，会导致在原理图绘制时连接出错，影响电路功能。同时，检查封装元件的焊

盘数量、大小、孔径、间距等参数是否与元件的实际物理尺寸相符。如电阻、电容等元件的封装，

焊盘间距应与实际元件引脚间距一致，否则在 PCB 制作时可能出现焊接困难或虚焊等问题。

电气规则检查（ERC）：在 Altium Designer 20.1 中，利用软件自带的电气规则检查功能，对原

理图元件进行检查。ERC 能够检测出元件引脚连接是否正确、是否存在未连接的引脚等电气错误。

如果发现错误，软件会给出相应的提示信息，根据提示修改元件的连接关系或引脚属性，直至通过

ERC 检查。

3D 模型预览与实物对比（如有条件）：若软件支持 3D 模型预览功能，将制作好的封装元件

转换为 3D 模型进行查看。观察封装的外形、焊盘位置等是否与实际元件相符。如果有实际元件，

可以将 3D 模型与实物进行对比，进一步确认封装的准确性。这一步骤有助于在实际制作 PCB 之

前，发现可能存在的问题，避免因封装错误导致的 PCB 制作失败。

实际应用测试（可选）：在条件允许的情况下，将制作的原理图元件和封装元件应用到一个简

单的测试电路中，进行实际的电路搭建和测试。观察电路是否能够正常工作，元件的功能是否符合

预期。通过实际应用测试，可以更全面地验证元件的性能和可用性，及时发现潜在的问题并进行改

进。

任务小结

在本次交通信号灯原理图元件和封装元件制作任务中，通过收集资料、绘制图形、设置属性等

一系列操作，成功完成了多种元件的制作。在这个过程中，深入了解了交通信号灯系统中各元件的

电气和物理特性，掌握了在 Altium Designer 20.1 软件中制作原理图元件和封装元件的方法和技巧。

遇到问题时，如引脚属性设置错误、封装尺寸偏差等，通过查阅资料、参考案例以及反复核对

参数等方式，及时解决了问题，这不仅提升了的实践能力，还培养了严谨的工作态度。同时，也认

识到准确制作元件对于整个电路设计和制作的重要性，一个小的失误都可能在后续的工作中引发严

重问题。

在今后的学习和实践中，要继续加强对元件特性的研究，提高制作元件的精度和效率。对于复

杂的元件，要更加仔细地处理每一个细节，确保元件的质量。此外，还应注重积累不同类型元件的

制作经验，以便在面对各种电子设计项目时，都能快速、准确地制作出所需的元件。



任务 3 交通信号灯原理图和 PCB 的制作

任务描述

本任务要求学习者基于 Altium Designer 20.1 软件，完成交通信号灯的原理图绘制以及 PCB 设

计与制作。在原理图绘制方面，需依据交通信号灯的控制逻辑和功能需求，将之前制作的原理图元

件合理布局并正确连接，构建出完整且准确的电路原理图。这不仅要确保各元件之间的电气连接正

确无误，还要考虑信号流向、电路可读性等因素，以便于后续的电路分析和调试。

在 PCB 设计环节，首先要根据原理图生成 PCB 文件，接着对元件进行合理布局。考虑到交通

信号灯系统的特点，布局时需重点关注信号干扰、散热以及安装要求等因素。例如，将发热量大的

元件放置在利于散热的位置，把易受干扰的元件与干扰源隔离开来。布局完成后，设置合适的布线

规则，包括线宽、间距、过孔大小等参数，运用自动布线和手动布线相结合的方式完成 PCB 布线工

作。最后，进行泪滴添加和覆铜操作，增强 PCB 的电气性能和稳定性，从而完成一个完整的交通信

号灯 PCB 设计与制作流程，实现从电路原理到实际物理电路板的转化。

任务分析

完成交通信号灯原理图和 PCB 的制作，需要学习者具备多方面的知识和技能，并且要对每个环

节进行细致处理。在原理图绘制过程中，理解交通信号灯的控制逻辑是关键。交通信号灯的控制涉

及到多种信号的时序变化，如红灯、黄灯、绿灯的交替点亮，以及倒计时显示等功能，这要求学习

者能够将这些逻辑转化为具体的电路连接。同时，合理布局元件也十分重要，若元件布局不合理，

会导致连线复杂、信号交叉，增加电路出错的概率，也不利于后续的调试和维护。

在 PCB 设计阶段，元件布局需要综合考虑多个因素。信号干扰是一个重要问题，例如，微控制

器的时钟信号可能会对其他弱电信号产生干扰，因此要将微控制器与敏感元件保持一定距离，并采

取相应的屏蔽措施。散热方面，对于功率较大的信号灯元件，要确保其周围有足够的空间散热，或

者设计专门的散热通道。安装要求也不容忽视，要预留出合适的安装孔位，确保 PCB 能够正确安装

到交通信号灯设备中。

布线规则的设置直接影响 PCB 的电气性能。线宽的选择要根据电路中的电流大小来确定，电流

较大的线路需要较宽的线宽，以避免线路发热甚至烧毁。间距的设置要满足电气安全要求，防止线

路之间出现短路现象。过孔大小则要根据电路板的层数、电流承载能力等因素来确定。自动布线虽

然方便快捷，但可能无法完全满足设计要求，因此需要结合手动布线进行优化，确保布线的合理性

和可靠性。泪滴添加和覆铜操作也需要掌握正确的方法和参数设置，以达到增强电气性能和稳定性

的目的。

相关知识

任务导入



在完成交通信号灯的原理图元件和封装元件制作后，已经为交通信号灯系统的设计搭建好了

“零件库”。接下来，就如同将各个零件组装成一台完整的机器一样，要把这些元件组合起来，绘制

出交通信号灯的原理图，并进一步设计和制作出实际的 PCB。
交通信号灯的原理图就像是一份详细的施工蓝图，它清晰地展示了各个元件之间的连接关系和

信号流向，是实现交通信号灯功能的基础。而 PCB 则是承载这些元件的物理载体，它的设计质量直

接影响到交通信号灯系统的性能和可靠性。想象一下，一个布局合理、布线规范的 PCB，能够使交

通信号灯系统稳定运行，准确地指挥交通；反之，一个设计糟糕的 PCB 可能会导致信号灯闪烁异常、

控制逻辑错误，给交通安全带来严重隐患。

通过本任务的学习和实践，将学会如何将抽象的电路原理转化为实际的物理电路板。这不仅能

够让深入理解电子电路设计的流程和方法，还能培养解决实际问题的能力。现在，就让运用所学知

识，开始绘制交通信号灯的原理图，并设计和制作出高质量的 PCB 吧！

任务规划

1.原理图绘制阶段：打开 Altium Designer 20.1 软件，创建一个新的原理图文件，并将之前制作

的原理图元件添加到原理图中。根据交通信号灯的控制逻辑，合理布局元件，使信号流向清晰、电

路结构紧凑。使用导线和网络标号等工具，正确连接各元件的引脚，完成电路原理图的初步绘制。

绘制完成后，仔细检查电路连接是否正确，进行电气规则检查（ERC），根据检查结果修改错误，确

保原理图的准确性。

2.PCB 文件生成与布局阶段：在原理图设计完成并通过检查后，使用 Altium Designer 20.1 的

“Design” 菜单中的 “Update PCB Document” 命令，将原理图信息导入到 PCB 文件中。在 PCB 文件

中，根据交通信号灯系统的特点和设计要求，对元件进行布局。先将主要元件（如微控制器、信号

灯驱动芯片等）放置在合适的位置，再逐步安排其他辅助元件。布局过程中，充分考虑信号干扰、

散热和安装要求等因素，调整元件位置，确保布局合理。布局完成后，对元件的布局进行检查和优

化，确保元件之间的间距合适，便于后续的布线工作。

布线规则设置与布线阶段：根据交通信号灯电路的电气特性和性能要求，设置 PCB 的布线规则。

在 “Design” 菜单中选择 “Rules” 命令，打开 “PCB Rules and Constraints Editor” 对话框，设置线宽、

间距、过孔大小等参数。对于电源线路，设置较宽的线宽以满足电流承载要求；对于信号线，根据

信号的频率和抗干扰要求，设置合适的线宽和间距。设置完成后，先进行自动布线操作，使用软件

的自动布线功能快速生成初步的布线结果。自动布线完成后，检查布线情况，对于不合理的布线（如

过长的导线、过多的过孔、信号交叉等），使用手动布线工具进行调整和优化，确保布线的合理性

和可靠性。

3.泪滴添加和覆铜阶段：布线完成后，对 PCB 进行泪滴添加操作。在 Altium Designer 20.1 中，

选择 “Tools” 菜单中的 “Teardrops” 命令，打开 “Teardrop Options” 对话框，设置泪滴的形状、大

小等参数，然后点击 “OK” 按钮添加泪滴。泪滴添加完成后，进行覆铜操作。选择 “Place” 菜单中

的 “Polygon Pour” 命令，打开 “Polygon Pour” 对话框，设置覆铜的网络、层、间距等参数，然后在

PCB 上绘制覆铜区域，完成覆铜操作。覆铜完成后，检查泪滴和覆铜的效果，确保其符合设计要求。

任务实施



任务验证

完成交通信号灯原理图和 PCB 的制作后，需要对制作成果进行全面验证，以确保交通信号灯系

统能够正常工作。

1.电气规则检查（ERC）复查：在完成 PCB 设计后，再次进行电气规则检查（ERC），确保 PCB
的电气连接符合设计要求。ERC 会检查是否存在未连接的引脚、短路、开路等电气错误。如果发现

错误，根据软件提示进行修改，直到通过 ERC 检查。这一步骤能够有效避免因电气连接错误导致的

电路故障。

2.DRC 检查：利用 Altium Designer 20.1 的设计规则检查（DRC）功能，对 PCB 进行全面检查。

DRC 会检查 PCB 的布局、布线是否符合之前设置的规则，如线宽是否满足要求、间距是否符合标

准、过孔大小是否合适等。若存在违反规则的情况，软件会给出详细的错误信息，根据这些信息对 PCB
进行调整和优化，确保 PCB 的设计质量。

3.3D 预览检查：使用软件的 3D 预览功能，查看 PCB 的三维模型。通过 3D 预览，可以直观

地检查元件布局是否合理，是否存在元件相互干涉的情况。同时，还可以检查安装孔的位置是否正

确，PCB 的整体结构是否符合实际安装要求。如果发现问题，及时返回 2D 设计界面进行修改。

任务小结

通过本次交通信号灯原理图和 PCB 制作任务，经历了从电路原理设计到实际 PCB 制作的

完整流程，收获颇丰。在原理图绘制过程中，深入理解了交通信号灯的控制逻辑，并将其转化为准

确的电路连接，同时学会了合理布局元件，提高了原理图的可读性和可维护性。

在 PCB 设计环节，综合考虑了信号干扰、散热、安装要求等多方面因素，完成了元件布局

和布线工作。通过不断调整和优化，掌握了布线规则的设置和手动布线技巧，提高了 PCB 的电气性

能和可靠性。泪滴添加和覆铜操作进一步增强了 PCB 的稳定性，让对 PCB 制作工艺有了更深入的

认识。

在任务过程中，也遇到了不少问题，如电气规则检查不通过、布线不合理等。但通过查阅资

料，成功解决了这些问题，锻炼了自己解决实际问题的能力。同时，也认识到团队协作和沟通的重

要性，在讨论和交流中，能够获取更多的思路和方法，提高工作效率。

项目总结

在本次交通信号灯的设计与制作项目中，全面运用了 Altium Designer 20 软件，完成了从

电路原理设计到 PCB 制作的全过程。通过这个项目，不仅掌握了交通信号灯的工作原理和设计方法，

还深入学习了 Altium Designer 20 软件的使用技巧，提升了电子电路设计和制作的能力。

在项目实施过程中，遇到了诸多挑战。在电路原理设计方面，对微控制器编程和信号灯时

序控制的理解不够深入，导致原理图设计初期出现了逻辑错误。经过查阅资料和请教老师，重新梳

理了设计思路，对原理图进行了多次修改和优化，最终确保了电路原理的正确性。在 PCB 设计阶段，

元件布局和布线规则的设置是一个难点。由于对信号流向和电磁干扰的考虑不够周全，初次布局布

线后，电路板在测试过程中出现了信号干扰问题。重新调整了元件布局，优化了布线规则，增加了



屏蔽措施，成功解决了信号干扰问题。

通过解决这些问题，深刻认识到严谨的设计态度和扎实的专业知识的重要性。在今后的学

习和工作中，要注重细节，对每一个设计环节都要进行充分的论证和测试，确保设计的准确性和可

靠性。同时，也要不断学习和掌握新的知识和技能，提高自己解决实际问题的能力。

本项目还培养了的团队协作精神和沟通能力。在项目进行过程中，团队成员之间密切配合，

共同攻克了一个又一个难关。通过交流和讨论，分享了各自的想法和经验，提高了团队的整体设计

水平。

项目练习

题目 1：在交通信号灯电路中，如果红灯和绿灯同时亮起，可能是什么原因导致的？

题目 2：在 Altium Designer 20 中，如何设置 PCB 布线的最小线宽和间距？

题目 3：简述交通信号灯 PCB 覆铜的作用。

项目 7 层次电路图及四层电路板的设计与

制作 （高速电路板设计）

项目描述

本项目基于 Altium Designer 20 平台，完成层次电路图及四层电路板的设计与制作。涵盖方块

电路总图绘制、原理图元件与 PCB 封装制作、原理图总图与子图设计、PCB 布局布线、电源加宽设

计及四层板板层管理。通过本项目，实现从电路原理设计到物理电路板规划的完整流程，培养综合

运用 EDA 工具解决实际工程问题的能力。

项目学习目标

知识目标

掌握 Altium Designer 20 软件的操作界面与基本功能，理解层次电路图的设计理念与结构，熟

悉四层电路板的板层功能（信号层、电源层、地层、机械层等），掌握原理图元件制作、PCB 封装

制作的规范与技巧，学习电源加宽设计的电气原理。

能力目标

能独立完成层次电路图的方块总图、子图绘制，熟练制作符合标准的原理图元件与 PCB 封装，

掌握四层板的板层添加与管理，完成 PCB 布局布线及电源加宽设计，具备电路设计错误排查与优化

能力。
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素质目标

培养严谨的工程思维与细致的工作态度，强化团队协作意识（如多人分工设计子图），提升创

新意识（如优化布线拓扑），树立质量意识（严格遵循电气规则）。

项目分析

层次电路图设计将复杂电路模块化，便于分工协作与维护。四层板设计通过电源层和地层减少

干扰，提升信号完整性。

任务关联性：原理图元件制作是绘制原理图的基础，PCB 封装制作影响后期布局，层次原理图

总图与子图的正确性决定 PCB 网络表导入质量，布局布线与电源加宽设计直接影响电路板性能，板

层管理确保四层板结构合理。

技术难点：层次电路图信号交互的正确性、四层板电源层分割（若涉及多电源）、高密度布线

时的信号完整性优化。需严格遵循电气规则检查（ERC）与设计规则检查（DRC）。

思政案例：工匠精神之黄伟强的电路板人生

案例标题

《精益求精：电路板上的匠人匠心》

案例背景

黄伟强，一位专注电路板设计 20 年的工程师，曾参与航天设备电路板研发，面对高可靠性、

高密度布线挑战，以极致耐心与专业素养攻克难题。

案例内容

某次航天项目中，四层板设计需在极小空间内实现多路信号零干扰。黄伟强反复优化布局，对

每根走线进行阻抗计算，甚至为一个电源过孔调整十数次。他说：“电路板上每毫米都是责任，容不

得半点马虎。” 最终，电路板通过严苛测试，保障项目成功。

教育启示

倡导精益求精的工匠精神，培养学生对细节的极致追求与责任感。在电路设计中，一个微小错

误可能导致系统故障，需以匠人之心对待每个元件、每根走线，传承严谨务实的工程态度。

项目规划

1.完成项目资料收集，熟悉 Altium Designer 20 界面

2.绘制层次电路图方块总图，制作原理图元件

3.制作 PCB 元件封装，完成层次原理图总图与子图

4.PCB 布局布线、电源加宽设计，四层板板层管理

5.设计验证、优化，整理文档

任务分解，每一个项目规划下面加上这几个字
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任务 1：层次电路图方块电路总图绘制

任务描述

使用 Altium Designer 20 创建项目工程，绘制层次电路图方块总图，定义各模块功能与信号交

互端口。

任务分析

需明确系统功能模块划分，规划方块电路数量与端口类型（输入 / 输出 / 双向）。例如，在

电源管理系统中，划分输入滤波、DC-DC 转换、输出稳压模块，每个模块用方块电路表示，端口定

义电压、控制信号等。

相关知识

一、层次电路图设计理念

层次电路图将复杂系统划分为多个功能模块（方块电路），每个模块对应一个子图。通过

方块电路的输入 / 输出端口实现模块间信号交互，便于团队分工与原理图维护。例如，在工控主板

设计中，可划分为 CPU 模块、电源模块、通信模块等，每个模块由专人设计子图。

二、四层电路板板层功能

四层电路板一般包含以下层次，但有时会定义两个信号层

信号层（Top Layer、Bottom Layer）：放置元件与走线，承载主要电信号。

电源层（Power Layer）：整层覆铜连接电源（如 + 5V），减少电源走线阻抗。

地层（Ground Layer）：提供信号参考地，降低电磁干扰。

机械层（Mechanical Layer）：定义电路板尺寸、安装孔位置等物理属性。

任务导入

展示典型层次电路图案例，分析方块电路如何简化复杂系统设计，引入本任务的设计目标。

任务规划

1.新建工程与原理图文件。

2.设置图纸参数（尺寸、网格等）。

3.绘制方块电路，定义名称与类型。



4.添加输入 / 输出端口，标注信号名。

任务实施

1.打开 Altium Designer 20，点击 “File”→“New”→“Project”→“PCB Project”，保存工程为

“Hierarchical_Design.PrjPCB”。此处项目名称是示例，可以命名为其他名字。

2.右键工程名，选择 “Add New to Project”→“Schematic”，保存为 “Block_Diagram.SchDoc”。
点击 “Design”→“Document Options”，设置图纸尺寸为 b，网格线间距 10mil。
如图 7-1 所示。

图 7-1 设置图纸尺寸

3.点击工具栏 “放置”→“页面符”，绘制方块电路。如图 7-2 所示，双击方块，放置后图为 7-3 所

示，设置 “Name” 为 “CAN”，“File Name” 为 “CAN.SchDoc”，如图 7-4 所示。



图 7-2 放置页面符

图 7-3 放置方块



图 7-4 设置名字

4.点击 “放置”→“添加图纸入口”，如图 7-5 所示，在方块边缘添加端口。双击端口，设置 “Name”
为 “AGND”，“I/O Type” 为 “Input”，如图 7-6 所示。重复操作，完成所有模块方块与端口绘制。如

图 7-7 所示。



图 7-5 放置添加图纸入口

图 7-6 设置入口名字



图 7-7 放置完成的方块电路

5.从方块电路切换到原理图，单击方块电路，如图 7-8 所示，再单击“设计”｜“从页面符创建

图纸”，如图 7-9 所示。

图 7-8 选择方块电路



图 7-9 从页面符创建图纸

6.再单击一下方块电路，可以跳转到子图，如图 7-10 所示。

图 7-10 显示子图

任务验证

检查方块电路名称与对应子图文件名是否一致，端口信号名是否唯一，通过 “Project”→“Compile
PCB Project” 进行电气规则检查，确保无错误警告。

任务评价



评价内容 评价标准 配分 得分

方块电路绘制 尺寸规范、名称正确 30

端口设置 信号名唯一、I/O 类型正确 40

图纸布局 整齐美观、便于阅读 30

任务小结

掌握层次电路图方块总图的绘制流程，理解模块划分与端口定义的重要性，为后续子图设计奠

定基础。

任务 2：层次电路图的原理图元件制作

任务描述

在 Altium Designer 20 中创建原理图元件库，依据元件 datasheet 绘制如芯片、电阻、电容等

原理图元件，包括外形轮廓、引脚定义、电气属性设置等，确保元件符号准确反映其功能与引脚特

性，为层次电路图绘制提供基础元件库。

任务分析

原理图元件是电路设计的基础单元，其准确性直接影响原理图的可读性与正确性。需根据元件

实际引脚功能（如电源引脚、信号输入输出引脚、接地引脚等）绘制符号，注意引脚编号、名称与

datasheet 一致，外形轮廓简洁规范。例如，绘制一个 DIP 封装的单片机元件，需明确每个引脚的

功能，如时钟引脚、数据总线引脚等。

相关知识

一、建立原理图元件库

以下只是示例，具体原理图元件请参考任务实施部分。

打开 Altium Designer 20，在 “Hierarchical_Design.PrjPCB” 工程中，右键选择 “Add New to
Project”→“Schematic Library”，保存为 “My_SchLib.SchLib”。
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二、设置图纸大小

点击 “Tools”→“Document Options”，设置图纸尺寸为默认，网格线捕捉间距 10mil。
三、纸制矩形

以绘制一个简单的双列直插式（DIP）集成电路为例，点击 “Place”→“Rectangle”，绘制一个

矩形作为元件外形。

四、放置引脚及设置引脚属性

点击 “Place”→“Pin” 放置引脚。双击引脚，在 “Properties” 面板中设置：

“Designator”：引脚编号（如 1、2 等），确保与 datasheet 一致。

“Name”：引脚名称（如 VCC、GND、IN、OUT 等）。

“Electrical Type”：根据功能选择（如 Power、Ground、Input、Output 等）。

调整引脚长度，确保电气端点（带有 “×” 的一端）朝外。

重复放置引脚，完成所有引脚绘制。点击 “Tools”→“Rename Component”，命名为 “DIP_IC”。
若需制作其他元件（如电阻、电容），重复上述步骤。电阻可绘制为矩形加两个引脚，电

容根据类型（如电解电容、瓷片电容）绘制相应符号并设置引脚。

任务导入

展示一个包含多种元件的层次电路图，提问 “这些元件符号如何创建？”，引出原理图元件制作

任务，强调元件库管理对项目复用的重要性。

任务规划

1.新建原理图元件库文件。

2.设置元件库图纸参数。

3.绘制元件外形轮廓。

4.放置引脚并设置属性（编号、名称、电气类型等）。

5.保存元件，完善元件库。

任务实施

下面介绍四层电路板原理图元件的制作，注意看引脚及编号。

1.6N137，如图 7-11 所示。
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图 7-11 6N137
2.74LS139，如图 7-12 所示。

图 7-12 74LS139
3.74LS245，如图 7-13 所示。



图 7-13 74LS245
4.CAP，如图 7-14 所示。



图 7-14 CAP
所有 CAP 的元件图一样

5.CON3，如图 7-15 所示。



图 7-15 CON3
6.CON4，如图 7-16 所示。



图 7-16 CON4
7.CON10，如图 7-17 所示。



图 7-17 CON10
8.ELECTRO,如图 7-18 所示。



图 7-18 ELECTRO

9.EPM7031AE，如图 7-19 所示。



图 7-19 EPM7031AE

10.JTAG_PORT，如图 7-20 所示。



图 7-20 JTAG_PORT

11.LA_28NP，如图 7-21 所示。



图 7-21 LA_28NP
12.LED，如图 7-22 所示。

图 7-22 LED
13.LM2901，如图 7-23 所示。



图 7-23 LM2901
14.LM2902，如图 7-24 所示。

图 7-24 LM2902
15.MC79L15CP,如图 7-25 所示。



图 7-25 MC79L15CP
16.MC7805，如图 7-26 所示。

图 7-26 MC7805

17.MC7815T,如图 7-27 所示。



图 7-27 MC7815T

18.OSC，如图 7-28 所示。

图 7-28 OSC
19.RES，如图 7-29 所示。



图 7-29 RES
20.SLOT96，如图 7-30 所示。

图 7-30 SLOT96
21.SN65HVD25，如图 7-31 所示。



图 7-31 SN65HVD25
22.SW DIP-4，如图 7-32 所示。

图 7-32 SW DIP-4
23.TCM809，如图 7-33 所示。



图 7-33TCM809
24.TL374，如图 7-34 所示。



图 7-34 TL374
25.TMS2407A,如图 7-35 所示。



图 7-35 TMS2407A
26.TPS77833，如图 7-36 所示。

图 7-36 TPS77833
27.TRANS1，如图 7-37 所示。



图 7-37 TRANS1

28.TVS，如图 7-38 所示。



图 7-38 TVS
29.DIDEO,如图 7-39 所示。



图 7-39 DIDEO

任务验证

检查元件引脚编号是否连续且无重复，名称与 datasheet 是否一致。

检查每一个元件是否有错误提示，如引脚电气类型冲突等。

在原理图中调用制作的元件，检查引脚连接是否正常。

任务评价

评价内容 评价标准 配分 得分

元件外形绘制 轮廓规范、符合元件特征 30

引脚设置 编号正确、名称与电气类型准确 40

元件库管理 元件命名规范、保存路径正确 30

任务小结

掌握原理图元件制作流程，理解元件符号与实际元件引脚功能的对应关系，学会通过元件库管

理提高设计效率与复用性，为层次电路图绘制提供准确的元件基础。

任务 3：层次电路图 PCB 元件封装制作

任务描述

根据元件实物尺寸（如封装类型、引脚间距、元件轮廓尺寸等），在 Altium Designer 20 中创

建 PCB 元件封装库，制作如 SMD、DIP 等类型的封装，定义焊盘尺寸、位置、编号等，确保封装

与实际元件匹配，为 PCB 布局布线做准备。



任务分析

PCB 封装是元件在电路板上的物理映射，尺寸不匹配会导致元件无法焊接或安装。需精确测量

或查阅 datasheet 获取封装参数，如 DIP 封装的引脚间距（100mil）、焊盘直径（如 60mil）、孔

径（如 32mil），SMD 封装的焊盘长度、宽度、元件轮廓丝印尺寸等。

相关知识

一、新建 PCB 封装库

在 “Hierarchical_Design.PrjPCB” 工程中，右键选择 “Add New to Project”→“PCB Library”，保存为

“My_PcbLib.PcbLib”。
二、设置图纸参数及格点

点击 “Tools”→“Library Options”，设置 “Measurement Unit” 为 “Imperial (mil)”， “Grids” 中

“Electrical Grid” 为 10mil，“Visible Grid 1” 为 10mil。
三、创建封装元件

以创建 DIP16 封装为例，点击 “Tools”→“New Component”，打开 “Component Wizard”（元件封

装向导）。

选择 “Dual in-line Package (DIP)”，点击 “Next”。
设置焊盘尺寸：“X-Size” 为 60mil，“Y-Size” 为 60mil，“Hole Size” 为 32mil，点击 “Next”。
设置焊盘间距：“Horizontal” 为 100mil，“Vertical” 为 300mil，点击 “Next”。
设置排数为 2，点击 “Next”。
设置引脚数量为 16，点击 “Next”。
设置封装名称为 “DIP16”，点击 “Finish”。
四、手动绘制 SMD 封装（如 0805 电阻）

点击 “Place”→“Rectangle” 绘制焊盘，设置第一个焊盘 “Designator” 为 1，“X-Size” 为 50mil，
“Y-Size” 为 80mil，“Shape” 为 “Rectangle”。

复制第一个焊盘，粘贴并调整间距为 200mil，设置 “Designator” 为 2。
点击 “Place”→“Line” 绘制元件轮廓丝印，尺寸为 80mil×50mil。
保存封装，重复操作创建其他封装（如 SOP8、TO-220 等）。

任务导入

展示一块实际电路板，指出元件封装的重要性（如元件安装是否合适），提问 “如何创建这些

封装？”，引入 PCB 封装制作任务。



任务规划

1.新建 PCB 封装库文件。

2.设置封装库参数（单位、网格等）。

3.选择封装类型（如向导创建或手动绘制）。

4.绘制焊盘、轮廓丝印，设置编号与尺寸。

5.保存封装，完善封装库。

任务实施

下面具体介绍四层板中的元件封装。

1.0805，如图 7-40 所示。

图 7-40 0805
2.1206AD,如图 7-41 所示。



图 7-41 1206AD
3.1210，如图 7-42 所示。

图 7-42 1210
4.AXIAL0.5，如图 7-43 所示。

图 7-43 AXIAL0.5



5.CON4，如图 7-44 所示。

图 7-45 CON4
6.DIDEO0.4,如图 7-45 所示。



图 7-45DIDEO0.4
7.HT96ML，如图 7-46 所示。

图 7-46 HT96ML
8.IDC10，如图 7-47 所示。



图 7-47 IDC10
9.IDC14,如图 7-48 所示。

图 7-48 IDC14
10.L_RAD0.2,如图 7-49 所示。



图 7-49 L_RAD0.2
11.LA28-NP，如图 7-50 所示。



图 7-50 LA28-NP
12.LED，如图 7-51 所示。



图 7-51 LA28-NP
13.OSC1，如图 7-52 所示。



图 7-52 OSC1
14.PLCC44，如图 7-53 所示。



图 7-53 PLCC44
15.QFP144,如图 7-54 所示。



图 7-54 QFP144
16.RAD0.1，如图 7-55 所示。

图 7-55 RAD01



17.RB.1/.2,如图 7-56 所示。

图 7-56 RB.1/.2
18.SIP3,如图 7-57 所示。

图 7-57 SIP3

19.SO-14,如图 7-58 所示。



图 7-58 SO-14
20.SO-16,如图 7-59 所示。



图 7-59 SO-16
21.SO20W,如图 7-60 所示。



图 7-60 SO 20W
22.SO-8,如图 7-61 所示。



图 7-61 SO-8
23.SOT-23，如图 7-62 所示



图 7-62 SOT-23
24.SW DIP-4,如图 7-63 所示。

图 7-63 SW DIP-4
25.TO-220H，如图 7-64 所示。



图 7-64 TO-220H
26.TRANS1,如图 7-65 所示。



图 7-65TRANS1

任务验证

1.检查焊盘尺寸、间距是否与 datasheet 一致，编号是否正确。

2.在 PCB 文件中调用封装，检查元件是否能正常放置，焊盘是否对齐。

3.检查每一个的封装，检查封装是否有错误（如重叠焊盘、未定义编号等）。

任务评价



评价内容 评价标准 配分 得分

封装尺寸 与 datasheet 匹配，焊盘、轮廓准确 40

编号设置 焊盘编号连续、正确 30

封装库管理 命名规范、保存路径正确 30

任务小结

掌握 PCB 元件封装制作方法，理解封装与实际元件的物理对应关系，学会利用向导或手动绘制

创建不同类型封装，确保封装库的准确性与完整性，为 PCB 设计奠定基础。

任务 4：层次电路原理图总图和子图绘制

任务描述

在 Altium Designer 20 中，依据方块电路总图，分别绘制各子图（如电源子图、信号处理子图

等），通过端口实现总图与子图、子图与子图间的信号连接，完成层次电路原理图的完整设计，确

保电气连接正确、信号流向清晰。

任务分析

层次电路原理图设计需保证总图与子图的信号一致性，子图内部电路逻辑正确。注意端口类型

（如 Input、Output、Bidirectional）与总图对应，子图中元件布局合理，连线规范，便于阅读与维护。

例如，电源子图中，需包含滤波、稳压电路，通过端口与总图的电源输入输出连接。

相关知识

一、由总图生成子图

这个只是示例，具体可以参考录制的微课视频。

在 “Block_Diagram.SchDoc” 中，点击 “Design”→“Create Sheet From Symbol”，点击方块电路

“Power_Input”，生成 “Power_Input.SchDoc” 子图，自动添加与总图对应的端口。

二、子图中的操作

在子图中，点击 “Place”→“Component”，从 “ My_SchLib.SchLib” 中调用元件（如电容、电阻、



芯片等），布局元件。例如，电源输入子图中，放置滤波电容、保险丝等元件。

点击 “Place”→“Wire” 进行连线，确保电路逻辑正确。点击 “Place”→“Port”，设置端口与总图对

应（名称、类型一致）。

重复上述步骤，完成所有子图绘制（如 “Power_Conversion.SchDoc”、“Output_Regulation.SchDoc”）。
三、检查错误

返回总图，检查方块电路端口与子图端口连接是否正确。点击 “Project”→“Compile PCB Project”，
执行 ERC，根据提示修正错误（如未连接的引脚、不匹配的端口类型）。

任务导入

回顾方块电路总图，提问 “如何将总图的模块细化为具体电路？”，引出层次电路原理图总图与

子图绘制任务，强调信号交互的重要性。

任务规划

1.根据方块电路创建子图（由总图生成或手动新建）。

2.绘制子图内部电路，放置元件、连线、端口。

3.检查总图与子图端口连接，确保信号一致。

4.执行电气规则检查（ERC），修正错误。

任务实施

下面给出所有原理图文件，由于纸张大小的原因，可能图片不清楚，可以参考源文件。

1.DSP&CPLD.SCHDOC，如图 7-66 所示
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图 7-66 DSP&CPLD.SCHDOC

2.CAN.SCHDOC，如图 7-67 所示。

图 7-67 CAN.SCHDOC
3.POWER.SCHDOC，如图 7-68 所示。

图 7-68POWER.SCHDOC

4.Interface.schdoc，如图 7-69 所示。



图 7-69 Interface.schdoc

5.Analog.schdoc，如图 7-70 所示。

图 7-70 Analog.schdoc

6.DSP.schdoc，这个图片太大，请参考源文件。



任务验证

1.检查总图与子图端口名称、类型是否一致，信号流向是否合理。

2.查看 ERC 报告，确保无电气错误（如红色报错标记）。

3.手动检查子图电路逻辑（如电源路径、信号处理流程）是否正确。

任务评价

评价内容 评价标准 配分 得分

子图绘制 元件布局合理、连线规范、逻辑正确 40

端口连接 与总图端口一致，信号交互正确 30

ERC 检查 无电气错误，警告合理处理 30

任务小结

掌握层次电路原理图总图与子图的绘制方法，理解通过端口实现信号交互的机制，学会利用 ERC
检查确保设计正确性，完成从模块划分到具体电路实现的过程。

任务 5：层次电路 PCB 板布局布线及电源加宽设计

任务描述

在 Altium Designer 20 中，将层次电路原理图导入 PCB 文件，进行元件布局（如按功能模块布

局、考虑散热与 EMC），然后布线（遵循电气规则，如线宽、间距、走线路径），最后对电源网络

进行加宽设计，提高电源传输能力与可靠性。

任务分析



布局需综合考虑信号流向、电磁兼容性（EMC）、散热（如功率元件靠近散热孔）。布线时，

关键信号（如时钟信号）需优先布线，控制走线长度与阻抗。电源加宽设计通过增大电源网络线宽

（如将 10mil 改为 30mil 或更宽），降低线路电阻，减少发热与电压降。

相关知识

一、在工程中建立 PCB 文件

这个只是示例，具体请看源文件和微课视频。

在 “Hierarchical_Design.PrjPCB” 工程中，右键选择 “Add New to Project”→“PCB”，保存为

“Hierarchical_PCB.PcbDoc”。
点击 “Design”→“Import Changes From [Hierarchical_Design.PrjPCB]”，执行更改，将元件与网络表

导入 PCB。
二、元件布局

1. 按功能模块拖动元件（如电源模块集中放置，信号处理模块靠近对应接口）。

2.调整元件方向，确保丝印清晰，便于焊接与调试。

3.对散热要求高的元件（如功率晶体管），放置在靠近电路板边缘或散热区域。

4.设置布线规则：点击 “Design”→“Rules”。
“Electrical”→“Clearance”：设置安全间距为 10mil。
“Routing”→“Width”：默认线宽 10mil，新建 “Power_Width” 规则，选择电源网络（如 VCC、

GND），设置线宽 30mil。
“Routing”→“Via Style”：设置过孔直径 60mil，孔径 32mil。
三、布线

点击 “Auto Route”→“All” 进行自动布线，或点击 “Place”→“Interactive Routing” 手动布线。

优先布时钟、高速信号等关键线路，确保走线短直，避免直角。

对未布通的线路，检查是否有布局不合理或规则冲突。

电源加宽：点击 “Place”→“Interactive Routing”，选择电源网络（如 VCC），重新走线，线宽自

动应用 30mil 规则。或使用 “Edit”→“Select”→“Net” 选中电源网络，点击 “Tools”→“Outline Selected
Objects” 加粗显示。

任务导入

展示一个布局布线不合理的 PCB（如信号干扰、电源走线过细发热），提问 “如何优化？”，引

入布局布线及电源加宽设计任务，强调其对电路板性能的影响。

任务规划
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1.新建 PCB 文件，导入网络表与元件封装。

2.元件布局（手动或自动，以手动优化为主）。

3.设置布线规则（线宽、间距、过孔等）。

4.自动或手动布线，优先布关键信号。

5.选择电源网络，加宽走线。

任务实施

具体步骤介绍如下：

1.原理图更新到 PCB，如图 7-71 所示。

图 7-71 原理图更新到 PCB
2.PCB 文件中已经导入了元件，并以及飞线显示，如图 7-72 所示。



图 7-72 元件已导入了 PCB
3.对 PCB 元件进行布局，最好是手动布局，因为自动布局效果不太好，如图 7-73 所示。



图 7-73 手动布局的效果

4.保持默认的布线规则，进行自动布线，如图 7-74 所示。

图 7-74 自动布线



5.手动调整线宽，选择红色，蓝色的线，如图 7-75 所示。

图 7-75 手动选择线

6.双击该线设置线宽为 50mil，如图 7-76 所示。

图 7-76 手动设置线宽

7.补充讲解 PCB 类及规则修改，选择“设计”｜“类”如图 7-77 所示。



图 7-77 选择类

8.增加一个类，并添加成员，如图 7-78 所示。



图 7-78 增加类成员

9.修改类的设计规则，主要是线宽，如图 7-79 所示。



图 7-79 增加线宽规则

任务验证

1.检查元件布局是否符合功能分区，散热、EMC 要求。

2.执行 “Design”→“Rules Check”（DRC），确保无违反布线规则（如短路、线宽不足）。

3.检查电源网络是否全部加宽，走线是否连续。

任务评价

评价内容 评价标准 配分 得分



评价内容 评价标准 配分 得分

布局 功能分区明确、符合 EMC 与散热要求 30

布线 遵循规则，关键信号优先，无违规 40

电源加宽 电源网络全部加宽，走线合理 30

任务小结

掌握 PCB 布局布线及电源加宽设计方法，理解布局对电路性能的影响，学会设置与应用布线规

则，确保电路板电气性能与可靠性，完成从原理图到物理电路板的关键转换。

任务 6：层次电路 PCB 四层板的板层添加与管理

任务描述

在 Altium Designer 20 中，将 PCB 从双面板转换为四层板，添加电源层与地层，设置各层属性

（如网络分配、显示颜色），管理层叠结构（厚度、 dielectric 常数等），确保四层板设计符合电

气特性与生产要求。

任务分析

四层板通过电源层（如 +5V）和地层（GND）提供稳定电源供应与信号参考平面，减少干扰。

需正确分配网络到相应层（如将 GND 网络分配到地层），设置层叠厚度（如信号层与电源层间距

10mil），考虑生产工艺（如压合顺序）。

相关知识

一、进入板层管理

1.在 “Hierarchical_PCB.PcbDoc” 中，点击 “Design”→“Layer Stack Manager”。
添加层：右键点击 “Top Layer”，选择 “Insert Internal Plane”，添加一个电源层（默认名称为

“Internal Plane 1”）。再次右键点击 “Internal Plane 1”，选择 “Insert Internal Plane”，添加地层（可重



命名为 “GND_Layer”）。

2.分配网络：双击 “Internal Plane 1”，在 “Properties” 面板中，设置 “Net Name” 为 “VCC”。双

击 “GND_Layer”，设置 “Net Name” 为 “GND”。
二、设置层叠参数

点击 “Layer Stack Manager” 中的 “Properties” 按钮，设置各层厚度。例如，“Top Layer” 厚度

1mil，“Internal Plane 1”（VCC）厚度 1mil，“GND_Layer” 厚度 1mil，“Bottom Layer” 厚度 1mil，层

间 dielectric 常数按默认（或根据板材参数设置）。

三、管理层显示

1.点击 “Design”→“Board Layers & Colors”，勾选 “Internal Plane 1”、“GND_Layer” 的 “Show” 选

项，设置不同颜色以便区分（如 VCC 层设为红色，GND 层设为蓝色）。

2.在布线时，电源网络（VCC）可直接在 “Internal Plane 1” 层覆铜，GND 网络在 “GND_Layer” 层

覆铜，信号层（Top、Bottom）走信号线。

任务导入

对比双面板与四层板的性能（如抗干扰能力、电源完整性），提问 “如何设计四层板？”，引入

板层添加与管理任务，强调其对高速、复杂电路的重要性。

任务规划

1.打开 PCB 文件，进入层叠管理。

2.添加电源层与地层。

3.分配网络到对应层（如 GND 到地层，VCC 到电源层）。

4.设置层叠参数（厚度、 dielectric 常数）。

5.管理各层显示与颜色。

任务实施

具体步骤如下：

1.选择“设计”｜“层叠管理器”，如图 7-80 所示。



图 7-80

2.在顶层上单击鼠标右键，选择插入 plane，如图 7-81 所示。

图 7-81 选择增加 plane

3.增加层后的效果如图 7-82 所示。



图 7-82 增加层后的效果

4.修改层的名称，将光标移动到层后，修改名字，如图 7-83 所示

图 7-83 修改层名

5.修改和增加层次后的 PCB，如图 7-84 所示。



图 7-84 增加的 PCB 板层

6.在四个层次中放置填充，如图 7-85 所示。

图 7-85 选择放置填充

7.设置填充的网络，选择 NO NET,并进行层次选择，如图 7-86、7-87 所示。



图 7-86 选择 GND

图 7-87 选择 POWER
8.给 PCB 板手动添加分隔区域，手动绘制导线，如图 7-88 所示。



图 7-88 手动添加分隔区域

9.绘制 PCB 的另一个四层板，PCB 电源板，如图 7-89 所示。

图 7-89 PCB 电源板



任务验证

1.检查电源层与地层是否正确分配网络（如 VCC 网络是否在 “Internal Plane 1” 层显示）。

2.查看层叠参数是否符合设计要求（厚度、 dielectric 常数）。

3.执行 DRC，确保无层相关错误（如错误的网络分配）。

任务评价

评价内容 评价标准 配分 得分

板层添加 正确添加电源层与地层 30

网络分配 电源、地网络分配正确 40

层叠管理 参数设置合理，显示正常 30

任务小结

掌握四层板板层添加与管理方法，理解电源层、地层对电路性能的提升作用，学会分配网络与

设置层叠参数，完成从双面板到四层板的转换，满足复杂电路设计需求。

任务 7：导出四层板制板文件

任务描述

在完成四层板的设计后，需要将设计文件导出为制板文件，以便交给制造商进行电路板制作。

本任务旨在使用 Altium Designer 20 软件，导出包含所有必要信息的制板文件，确保制造商能够精

确制作出符合设计要求的四层电路板。



任务分析

导出制板文件前，要确保设计完成且通过设计规则检查（DRC），避免因错误导致制板失败。导

出过程涉及设置单位、格式、选择导出层等操作，不同设置会影响制板文件的准确性和完整性，需

严格按照要求操作。

相关知识

一、Gerber 文件

是将设计转换为制造文件的关键，它并非单一文件，而是一系列二进制文件，每个文件代表 PCB
的特定层，包含电路板制作所需的线路、焊盘、过孔等信息。

二、NC Drill 文件

包含钻孔信息，用于指导制造商在电路板上钻出正确位置和尺寸的孔，确保元件能够正确安装。

三、导出制板文件时，如何确保文件的准确性和完整性？

导出制板文件时，确保文件准确性和完整性需从设计检查、导出参数设置、文件生成与检查等

多方面着手。在设计阶段，需全面检查；导出时，要精准设置参数；生成后，还得仔细检查并验证。

1.设计检查

电气规则检查（ERC）：在导出制板文件前，执行 “Project”→“Compile PCB Project” 进行电气规

则检查。这能检查出如未连接的引脚、不匹配的端口类型等错误，保证原理图电气连接正确。若存

在错误，会影响制板文件的准确性，导致电路板制作后出现功能故障。

2.设计规则检查（DRC）：点击 “Design”→“Rules Check” 执行 DRC 检查，确保布线符合规则，

如无短路、线宽不足等问题。违反布线规则会使制板文件包含错误信息，致使电路板制作不符合设

计要求。

3.导出参数设置

文件类型选择：了解不同文件类型的用途，如 Gerber 文件用于定义电路板的线路、焊盘等信

息，NC Drill 文件包含钻孔信息。根据制板需求准确选择文件类型，确保制板文件完整。

单位和格式设置：在导出 Gerber 文件时，“Gerber Setup” 对话框的 “常规” 选项卡中，选择合

适的单位（如 “英寸”）和格式（如 “2:5”）。错误的单位和格式设置可能导致制造商读取文件时出

现尺寸偏差等问题，影响制板准确性。

层设置：在 “Layers” 选项卡中，勾选 “Plot Layers” 的 “选择使用过的” 选项，并根据实际情况

取消不需要导出的层。确保 “包含未连接中间层焊盘” 选项被选中，保证制板文件包含所有必要的

层信息，避免因层缺失导致电路板制作错误。

4.文件生成与检查

生成文件：确认导出参数设置无误后，点击 “Generate” 生成制板文件。生成过程中，软件会根

据设置将设计信息转换为相应文件格式，若设置错误，生成的文件可能存在错误或不完整。

文件预览检查：导出完成后，对生成的文件进行预览。仔细检查所有线路、元件和孔位是否正

确无误，如发现问题，需返回相应步骤修改设置后重新生成文件，确保制板文件的准确性和完整性。

四、如何检查导出的制板文件与设计是否一致？

检查导出的制板文件与设计是否一致，可通过软件自带的验证工具、第三方 Gerber 查看器进

行比对，并进行钻孔文件验证，必要时生成报告辅助检查。以下是具体步骤和方法：

1.使用软件自带的验证工具

Gerber 文件预览：在 Altium Designer 中导出 Gerber 文件后，可通过软件内置的 Gerber 查看



器打开生成的 Gerber 文件，逐一检查各层（顶层、底层、内层、丝印层等）的线路、焊盘、过孔

等是否与设计一致。

与设计文件对比：在 Gerber 查看器中，可以同时打开设计文件和导出的 Gerber 文件，通过切

换显示进行直观对比。检查是否有线路缺失、焊盘尺寸不符、过孔位置偏移等问题。

2.使用第三方 Gerber 查看器

导入 Gerber 文件：将导出的 Gerber 文件和 NC Drill 文件导入到第三方 Gerber 查看器（如

GerberView、CAM350 等）中。

层叠显示检查：在第三方查看器中，设置正确的层叠顺序（如顶层→内层 1→内层 2→底层），

检查各层之间的对准精度和电气连接是否正确。

测量工具验证：使用查看器的测量工具，验证关键尺寸（如线宽、间距、焊盘直径等）是否符

合设计要求。例如，测量走线宽度是否与设计规则中设置的一致。

3.钻孔文件验证

检查钻孔位置：在 Gerber 查看器中打开 NC Drill 文件，确认所有钻孔的位置和尺寸是否与设

计一致。特别注意过孔和安装孔的位置，避免因钻孔偏差导致元件无法正确安装。

验证钻孔尺寸：检查钻孔文件中的孔径是否与设计中的过孔、焊盘尺寸匹配。例如，设计中设

置的过孔内径为 0.3mm，对应的钻孔文件中孔径应与此一致。

4.生成报告辅助检查

Gerber 报告：部分 PCB 设计软件或 Gerber 查看器支持生成 Gerber 报告，列出文件中的所有

对象（线路、焊盘、过孔等）及其属性。通过对比设计文件和 Gerber 报告，可发现潜在的不一致

问题。

差异分析报告：一些高级工具可以生成设计文件与导出文件之间的差异分析报告，直观显示哪

些部分存在不一致，便于快速定位和修正问题。

5.与制造商沟通确认

提供设计文件：将原始设计文件（PCB 文件、原理图等）与导出的制板文件一起发送给制造商，

请求制造商在生产前进行文件审核。

审核反馈：根据制造商的反馈，进一步检查和修正可能存在的问题。例如，制造商可能会指出

某些层的线路间距过小，不符合生产工艺要求。

6.常见问题及解决方法

问题类型 可能原因 解决方法

线 路 缺 失

或不完整

导出时未勾选

所有使用的层

重新导出 Gerber 文件，确保在 “Layers” 选项

卡中勾选所有必要的层

焊 盘 尺 寸

不一致

单位或格式设

置错误

检查导出参数中的单位和格式设置，确保与设

计一致（如英寸 / 毫米、2:5 格式等）

过 孔 位 置

偏移

钻孔文件导出

设置不正确

重新导出 NC Drill 文件，确认钻孔参数（如孔

径、孔间距等）与设计一致



问题类型 可能原因 解决方法

层 叠 顺 序

错误

未正确设置层

的显示顺序

在 Gerber 查看器中调整层叠顺序，确保与设计

的层结构一致

通过以上步骤和方法，可以有效检查导出的制板文件与设计是否一致，确保电路板制造的准确

性和可靠性。

五、生成报告的步骤详细说明

生成制板文件报告可帮助验证设计与导出文件的一致性，以下是使用 Altium Designer 20 生成

报告的详细步骤：

1. Gerber 文件报告生成

步骤 1：导出 Gerber 文件

（1）在 Altium Designer 中，点击菜单文件→输出制造文件→Gerber 文件。

（2）在弹出的 Gerber Setup对话框中：

设置单位为英寸，格式为 2:5。
（3）在 Layers选项卡勾选 Plot Layers的选择使用过的，确保包含所有信号层、电源层、丝印层

等。

（4）勾选包含未连接中间层焊盘，取消不必要的机械层（如仅用于尺寸标注的层）。

点击 Generate生成 Gerber 文件。

步骤 2：生成 Gerber 报告

（1）打开 Gerber 文件：

（2）点击菜单文件→打开，选择导出的 Gerber 文件（扩展名为 .GBR、.GTL、.GBL等）。

生成报告：

（3）在 Gerber 文件打开后，点击菜单 Reports → Gerber Report。
设置报告选项：

（4）在弹出的对话框中，选择需要生成报告的 Gerber 文件（可多选）。

（5）勾选需要包含的信息，如：

Coordinates（坐标信息）

Objects（对象类型，如线、圆、多边形）

Net Names（网络名称，若 Gerber 文件中包含）

（6）点击 OK生成报告。

查看报告内容：

报告将显示 Gerber 文件中的所有对象及其属性，例如：

Gerber File: TOP.GTL
Units: Inches
Format: 2:5

Objects:
- Line: Start(0.50000, 1.00000), End(1.50000, 1.00000), Width=0.01000
- Circle: Center(2.00000, 2.00000), Diameter=0.05000
- Pad: X=3.00000, Y=3.00000, Shape=Rectangular, Size=0.08000 x 0.10000



2. NC Drill 文件报告生成

步骤 1：导出 NC Drill 文件

（1）在 Altium Designer 中，点击菜单文件→输出制造文件→NC Drill Files。
（2）在弹出的 NC Drill Setup对话框中：

设置单位为英寸，格式为 2:5。
（3）选择 Drill File Format为 Excellon。
（4）勾选生成钻孔图和生成钻孔报告。

（5）点击 Generate生成 NC Drill 文件和报告。

步骤 2：查看钻孔报告

生成的钻孔报告（扩展名为 .DRL或 .TXT）将包含以下信息：

NC Drill Report for PCB1.PcbDoc
Tool Table:
T1 - 0.012" (0.305mm)
T2 - 0.020" (0.508mm)
T3 - 0.031" (0.787mm)

Drill Hits:
T1: 123 holes
T2: 45 holes
T3: 8 holes

Total Holes: 176

3. 设计规则检查（DRC）报告

步骤 1：执行 DRC 检查

（1）点击菜单工具→设计规则检查，或按快捷键 D+R。
在 Design Rule Check对话框中：

（2）确保勾选所有需要检查的规则（如间距、线宽、过孔等）。

（3）点击 Run Design Rule Check。

步骤 2：生成 DRC 报告

（1）检查完成后，在Messages面板中右键点击任意错误或警告，选择 Generate Report。
（2）报告将显示所有违反设计规则的位置和详细信息，例如：

DRC Report for PCB1.PcbDoc

Violations Found: 3
（1）Clearance Constraint (10mil):

- Net GND to VCC: Distance=8mil at (X=1.2345, Y=2.3456)
（2）Minimum Width Constraint (12mil):

- Track Width=10mil at (X=3.4567, Y=4.5678)
（3）Hole Size Constraint (0.3mm min):



- Via Hole Diameter=0.25mm at (X=5.6789, Y=6.7890)
4. 差异分析报告（设计与 Gerber 对比）

步骤 1：导入 Gerber 文件到项目

点击菜单文件→导入→Gerber Files。
选择之前导出的 Gerber 文件和 NC Drill 文件，按向导完成导入。

步骤 2：运行差异分析

点击菜单工具→ Compare Documents。
在弹出的对话框中：

Original Document：选择原始 PCB 设计文件（.PcbDoc）。

Compare To：选择导入的 Gerber 文件集合（.CamOutputs）。

点击 Compare生成差异报告。

步骤 3：查看差异报告

报告将高亮显示设计与 Gerber 文件之间的不一致之处，例如：

Differences Found: 2
（1）Missing Track:

- Design: Track from Pad1 to Pad2 (Net=SIGNAL1)
- Gerber: No corresponding track found

（2） Size Mismatch:
- Design: Pad Size=0.050" x 0.070"
- Gerber: Pad Size=0.048" x 0.068" (Difference=0.002")

5. 报告验证与修正

（1）核对关键参数：检查报告中的线宽、间距、孔径、层数等是否与设计规则一致。

（2）定位问题：根据报告中的坐标信息，在 PCB 设计或 Gerber 查看器中定位问题点。

修正错误：

（1）若 Gerber 文件有误，调整导出参数后重新生成。

（2）若设计本身存在问题（如 DRC 违规），修改 PCB 设计并重新导出制板文件。

（3）重新生成报告：重复上述步骤，直至报告显示无差异或违规。

任务规划

1.打开 PCB 设计文件，进行设计规则检查，确保无错误。

2.选择合适的文件输出类型，进入相应设置对话框。

3.设置导出参数，包括单位、格式、导出层等。



4.生成 Gerber 和 NC Drill 文件，并进行预览检查。

5.将生成的文件打包发送给制造商。

任务实施

1.检查设计：打开在 Altium Designer 20 中完成设计的四层板 PCB 文件，点击 “Design”→“Rules
Check” 执行 DRC 检查，根据检查结果修正错误，直至无违反布线规则等错误提示。

2.导出 Gerber 文件：通过软件菜单选择 “文件”→“输出制造文件”→“Gerber 文件”，进入

“Gerber Setup” 对话框。在 “常规” 选项卡，选择单位为 “英寸”，格式为 “2:5” 以保证尺寸精度。

在 “Layers” 选项卡，勾选 “Plot Layers” 的 “选择使用过的” 选项，确保 “包含未连接中间层焊盘”
也被选中，取消不需要导出的层（如仅用作尺寸辅助线的 Mechanical4 层）。不选择 “Mirror” 镜像

选项，也不添加机械层到所有绘图中。

3.设置钻孔文件：选择 “NCDrillFiles” 对话框，设置钻孔文件的格式和选项。通常需导出包含所

有钻孔信息的 X - T Drill File 和钻孔位置图，以便制造商定位孔位。

4.生成文件：确认所有设置无误后，点击 “Generate” 生成 Gerber 和 NC 钻孔文件。文件会被

保存在项目文件夹下的 ProjectOutputsforPRJNAME 子目录中，此目录首次需要时会自动生成。

5.预览检查：导出完成后，对生成的文件进行预览，检查所有线路、元件和孔位是否正确无误，

如有问题返回相应步骤修改设置后重新生成。

6.打包发送：将整个 ProjectOutputsforPRJNAME 目录打包，发送给制造商进行电路板制作。

任务验证

与制造商沟通确认其是否能正确读取和使用导出的制板文件。若制造商反馈文件存在问题，如

某些层缺失、钻孔信息错误等，需重新检查导出设置并再次导出文件。

任务评价

评分项

目
评分标准

配

分
得分

文件完

整性

Gerber 文件包含信号层/电源层/地层等必要信

息，NC Drill 文件具备完整钻孔数据

部分层缺失扣 10-20 分，钻孔信息不全扣 5-15

分

40

分

参数设

置准确

性

单位制式（公制/英制）、文件格式

（RS-274X/ODB++）符合制造规范

单位错误扣 15 分，格式错误扣 10 分，复合错误

扣 20 分

30

分

文件可 文件无逻辑错误，层次分明，制造商可直接用于 30 文件解析错误扣 15 分，图层



读性 生产 分 混淆扣 10 分，元件缺失扣 5

分

任务小结

掌握在 Altium Designer 20 中导出四层板制板文件的方法，理解导出过程中各参数设置的意义，

通过严格按照步骤操作和仔细检查，确保导出的制板文件准确完整，为电路板的制作提供可靠保障。

项目总结

通过本项目，系统学习了层次电路图与四层板设计流程，掌握 Altium Designer 20 的核心功

能。从元件制作到 PCB 布线，每个环节都需严谨细致，如原理图元件引脚编号错误会导致 PCB 网

络表出错，四层板电源层设置不当会引发干扰。未来可拓展高速电路设计、阻抗匹配等进阶内容，

进一步提升工程实践能力。

项目练习

题目 1：层次电路图中，若子图修改后，总图未更新，如何处理？

题目 2：四层板设计中，电源层无法敷铜，可能原因？
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